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Safety

This chapter contains:

NOICES AN SAFOLY .. et 12
ELECEMICAL SAFOLY ..ot 13
OPEIALIONAL SAFELY ..ottt 16
MAINEENANCE SAFELY ... e e 18
Environmental, Health, and Safety Contact Information.............oooiiiii e 19

Your printer and the recommended supplies have been designed and tested to meet strict safety requirements.
Attention to the following information ensures the continued safe operation of your Xerox printer.
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Safety

Notices and Safety

Read the following instructions carefully before operating your printer. Refer to these instructions to ensure the
continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These include safety
agency evaluation and certification, and compliance with electromagnetic regulations and established
environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox® materials
only.

j’ Note: Unauthorized alterations, which can include the addition of new functions or connection of external
devices, can affect the product certification. For more information, contact your Xerox representative.
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Safety

Electrical Safety

GENERAL GUIDELINES

& Warning:

e Do not push objects into slots or openings on the printer. Touching a voltage point or shorting out a
part could result in fire or electric shock.

e Do not remove the covers or guards that are fastened with screws unless you are installing optional
equipment and are instructed to do so. Power off the printer when performing these installations.
Disconnect the power cord when removing covers and guards for installing optional equipment. Except
for user-installable options, there are no parts that you can maintain or service behind these covers.

The following are hazards to your safety:

e The power cord is damaged or frayed.

e Liquid is spilled into the printer.

e The printer is exposed to water.

e The printer emits smoke, or the surface is unusually hot.

e The printer emits unusual noise or odors.

e The printer causes a circuit breaker, fuse, or other safety device to activate.
If any of these conditions occur, do the following:

1. Power off the printer immediately.

2. Disconnect the power cord from the electrical outlet.

3. Call an authorized service representative.

POWER CORD SAFETY INFORMATION

Before operating your printer, read the following instructions carefully. For details, contact your Xerox representative.

A\ Warning:

e The electrical supply for the device must meet the requirements stated on the data plate on the rear
of the device. If you are not sure that your electrical supply meets the requirements, consult your local
electricity provider or a licensed electrician.

e Do not use an extension cord.

e Do not remove or modify the power cord.

Refer to these instructions to ensure the continued and safe operation of your printer.
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Safety

e Use the power cord that is supplied with your printer.

e Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the cord is
connected securely. If you do not know if an outlet is grounded, ask an electrician to verify that the outlet is
grounded.

e Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a ground
connection terminal.

Warning: To avoid the potential of an electrical shock, ensure that the printer is grounded properly.
Electrical products can be hazardous if misused.

e Verify that the printer is plugged into an outlet that provides the correct voltage and power. Review the
electrical specification of the printer with an electrician, if necessary.

e Do not place the printer in an area where people can step on the power cord.

e Do not place objects on the power cord.

e If the power cord becomes frayed or worn, replace the power cord.

e Do not unplug or plug in the power cord while the printer is powered on.

e To avoid an electrical shock and damage to the cord, grasp the plug when you unplug the power cord.
e The electrical outlet must be near the printer and must be easily accessible.

The power cord is attached to the printer as a plug-in device on the back cover of the printer. If it is necessary to
disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. For details, refer
to the User Guide.

BATTERY SAFETY INFORMATION
e The Printed Wire Board Assembly Electronic Switching System (PWBA ESS) in this printer uses a lithium battery.

e Do not attempt to repair or replace the lithium battery. If there is a problem with the battery, contact an
authorized service representative to correct the problem.

A\ Warning:

e If the battery for the PWBA ESS is installed incorrectly, there is a risk of explosion.

e The lithium battery in this printer contains Perchlorate Material. For information about the special
handling procedures associated with Perchlorate Material, refer to www.dtsc.ca.gov/hazardouswaste/
perchlorate.

EMERGENCY POWER OFF

If any of the following conditions occur, power off the printer immediately and disconnect the power cord from the
electrical outlet. Contact an authorized Xerox service representative to correct the problem if:

e The equipment emits unusual odors or makes unusual noises.
e The power cable is damaged or frayed.

e Awall panel circuit breaker, fuse, or other safety device has been tripped.
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Safety

e Liquid is spilled into the printer.
e The printer is exposed to water.

e Any part of the printer is damaged.

TELEPHONE LINE CORD

& Warning: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger
telecommunication line cord.
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Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include safety agency
examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your printer.

OPERATIONAL GUIDELINES

e Do not remove any paper trays while the printer is printing.

e Do not open the doors when the printer is printing.

e Do not move the printer when it is printing.

e Keep hands, hair, neckties, and so on, away from the exit and feed rollers.

e Protective covers, which require tools for the removal, protect the hazard areas within the printer. Do not remove
the protective covers.

e Do not override any electrical or mechanical interlock devices.

e Do not attempt to remove paper that is jammed deeply inside the printer. Power off the printer promptly, then
contact your local Xerox representative.

e Ensure that the rear right cover is attached. To connect an interface cable, open the rear right cover.

OZONE RELEASE

This printer produces ozone during normal operation. The amount of ozone produced is dependent on copy volume.
Ozone is heavier than air and is not produced in amounts large enough to harm anyone. Install the printer in a well-
ventilated room.

For more information in the United States and Canada, go to www.xerox.com/environment. In other markets,
please contact your local Xerox representative or go to www.xerox.com/environment_europe.

PRINTER LOCATION

o Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. To find the
weight for your printer configuration, refer to the Specifications chapter of the User Guide.

e Do not block or cover the slots or openings on the printer. These openings are provided for ventilation and to
prevent overheating of the printer.

e Place the printer in an area where there is an adequate space for operation and servicing.

e Place the printer in a dust-free area.

e Do not store or operate the printer in hot, cold, or humid environments.

¢ Do not place the printer near a heat source.

» To avoid exposure of light-sensitive components, do not place the printer in the direct sunlight.

o Do not place the printer where it is exposed to the cold air flow from an air-conditioning system.

e Do not place the printer in locations that are susceptible to vibrations.
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Safety

For optimum performance, use the printer at the elevations that are specified in the User Guide.

PRINTER SUPPLIES

Use the supplies designed for your printer. The use of unsuitable materials can cause poor performance and a
possible safety hazard.

Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.
Store all consumables in accordance with the instructions given on the package or container.

Keep all consumables away from the reach of children.

Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame.

When handling cartridges, for example toner cartridges, avoid skin and eye contact. Eye contact with toner can
cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase the risk of
skin or eye contact.

(D Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty or Service Agreement do
not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or
the use of Xerox supplies not specified for this printer.
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Maintenance Safety

Do not attempt any maintenance procedure that is not specifically described in the documentation supplied with
your printer.

e Clean the device with a dry lint-free cloth only.

e Do not burn any consumables or routine maintenance items. For information on Xerox® supplies recycling
programs, go to www.xerox.com/gwa

& Warning: Do not use aerosol cleaners. Aerosol cleaners can be explosive or flammable when used on
electromechanical equipment.

When installing the device in a hallway or similar restricted area, additional space requirements can apply. Ensure
that you comply with all workspace safety regulations, building codes, and fire codes for your area.
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Safety

Environmental, Health, and Safety Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, contact:
e United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)

e FEurope: EHS-Europe@xerox.com

For product safety information in the United States and Canada, go to www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/msds.
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Parts of the Printer

FRONT VIEW

22
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Document Cover 8.
Document Glass 9.
Power/Wake Button 10.
Near Field Communication (NFC) Area 11.
Center Output Tray 12.
Center Bottom Tray 13.
Main Power Switch behind front door 14.
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Locking Casters

Leveler Foot

Tray 5 - Bypass Tray
Smart Proximity Sensor
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Duplex Automatic Document Feeder

—_

Confirmation Indicator

Left Cover

Top Cover

Document Guides

Document Feeder Tray
Document Output Tray

Lint Free Cloth Compartment

Second-Side Scanning Lens Assembly

© % N o W N

Constant Velocity Transport (CVT) Glass

Duplex Automatic Document Feeder Guidelines
The duplex automatic document feeder accommodates the following paper sizes and weights:
e B8145/B8155:

—  Original document weights: 38128 g/m?

—  Original document sizes: 85 x 125 mm-297 x 432 mm (3.3 x 4.9-11.7 x 17 in.)

—  Original document quantity: 130 sheets of 80-g/m? paper
e B8170:

—  Original document weights: 38-200 g/m?

—  Original document sizes: 84 x 140-297 x 432 mm (3.3 x 5-11.7 x 17 in.)

—  Original document quantity: 250 sheets of 80-g/m? paper
Follow these guidelines when you load original documents into the duplex automatic document feeder:
e Load original documents face up so that the top of the document enters the feeder first.

e Place only loose sheets of undamaged paper in the duplex automatic document feeder.
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e Adjust the paper guides so that they fit against the original documents.
e Insert paper in the duplex automatic document feeder only when ink on the paper is dry.

e Do not load original documents above the MAX fill line.

Document Glass Guidelines

Lift the document feeder cover and place the first page face down in the upper-left corner of the document glass.
Align the original documents to the matching paper size printed on the edge of the glass.

e The document glass accepts paper sizes up to 297 x 432mm (11.7 x 17in.).
e The document glass automatically detects standard paper sizes.

Use the document glass rather than the duplex automatic document feeder to copy or scan the following types of
original documents:

e Paper with paper clips or staples attached

e Paper with wrinkles, curls, folds, tears, or notches

e Coated or carbonless paper or items other than paper, such as cloth or metal
e Envelopes

e Books

INTERNAL PARTS

i &~ W =

1. Toner Cartridge

Main Power Switch

Waste Container

Waste Toner Transport Assembly
Waste Toner Transport Release Switch

2nd Bias Transfer Roll

N o v W N

Fuser Assembly
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Drum Cartridge

Transfer Belt Cleaner

REAR VIEW

o N o U & W N

[}
f

Bypass Tray
Door B

Leveler Foot
Circuit Breaker
Rear Right Cover
USB Port, Type B
USB Port, Type A

Ethernet Port

CONTROL PANEL

The control panel consists of a touch screen and buttons that you press to control the functions that are available
on the printer. The control panel has the following functions:

Displays the current operating status of the printer.

Provides access to print, copy, and scan features.

Provides access to reference materials.

Provides access to the Tools and Setup menus.

Prompts you to load paper, replace supplies, and clear paper jams.
Displays errors and warnings.

Provides the Power/Wake button that is used to power on or off the printer. This button supports the power-
saver modes, and the button indicator pulses to indicate the power status of the printer.
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ITEM
1

NAME
NFC Area

DESCRIPTION

Near Field Communication (NFC) is a technology that enables
devices to communicate when they are within the network range of
each other. Use the NFC area to obtain a network interface, to add
the printer to your mobile device, or to establish a TCP/IP connection
between your device and the printer.

Touch Screen Display

The screen displays information and provides access to printer
functions.

Home Button

This button provides access to the Home menu for access to printer
features, such as copy, scan, and fax.

Power/Wake Button

This button serves several power-related functions:

e When the printer is powered off, pressing this button powers on
the printer.

e When the printer is powered on, pressing this button displays a
menu on the control panel. From this menu, you can choose to
enter Sleep Mode, restart the printer, or power off the printer.

e When the printer is powered on, but in Sleep Mode, pressing this
button wakes the printer.

The button indicator pulses to indicate the power status of the
printer:

e When the light pulses slowly, the printer is in Sleep Mode.

e When the light pulses rapidly, the printer is powering off or
waking up.

Status Indicator

This light pulses blue or amber to indicate the printer status.

Blue:

26
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ITEM NAME DESCRIPTION

feature.

Amber:

e Pulses blue once for access-card authentication when there is a
delay in response from a remote server.

j’ Note: Some card readers are not compatible with this

e Pulses blue twice slowly to indicate that a job has completed.

e Pulses blue rapidly while the printer is powering on, or to signal
detection of an Identify Printer function from AirPrint.

Pulses amber to indicate an error condition or warning that requires
your attention or the attention of your system administrator. For
example, this color can indicate an out-of-toner condition, a paper
jam, or that the printer is out of paper for the current job.

Getting Started

6 Language Button Pressing the Language button allows you to set the language that
appears on the control panel touch screen.

f Note: Sometimes this option is hidden from view. For details,
see the System Administrator Guide at www.xerox.com/
office/ALB8 1XXdocs.

7 Reset Use the Reset button to reset all the apps to the default settings.

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide
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CONFIGURATIONS AND OPTIONS

1. Tray 6 - High Capacity Feeder
Work Surface

Convenience Stapler

5 wWoN

RFID (Radio Frequency Identification) Card Reader Kit

FINISHING OPTIONS

Integrated Office Finisher
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1. Finisher Tray

Finisher Tray Extension
Integrated Office Finisher
Staple Cartridge

Finisher Front Cover

o v & W N

Finisher Top Cover

Office Finisher with Optional Booklet Maker

—_

Booklet Maker (optional)

Booklet Maker Side Cover (optional)
Right Tray

Booklet Maker Staple Cartridge (optional)
Finisher Top Cover

Creaser Unit (optional)

Staple Cartridge

Finisher Front Cover

o 0 N o U & W N

Office Finisher
10. Hole Punch Waste Container (optional)
11. Hole Punch Unit (optional)

12. Center Tray

Xerox® Altalink® B8145/B8155/B8170 Series Multifunction Printer User Guide
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Business Ready Finisher with Optional Booklet Maker

30

v & W N

Horizontal Transport Unit

Center Tray

Right Top Tray
Right Middle Tray
Staple Cartridge

Booklet Staple Unit
Booklet Maker Tray
Booklet Maker Unit

O ©® N o

Finisher Front Cover
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Business Ready Finisher with Optional Tri-Fold Module
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1. Folder Front Cover 3. Folder Bin

2. Folder Bin Release Button
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PAPER TRAY OPTIONS

Configuring Dedicated Paper Trays

The system administrator can set trays to Fully Adjustable mode or Dedicated mode. When a paper tray is set to
Fully Adjustable mode, you can change paper settings each time that you load the tray. When a paper tray is set to
Dedicated mode, the control panel prompts you to load a specific paper size, type, and color.

Your printer can have three high-capacity paper trays installed, depending on the configuration.

High-capacity trays are configured as Fully Adjustable trays.

Trays 3 and 4 in the Tandem Module, and High-Capacity Tray 6 hold A4-size (210 x 297 mm), Letter-size (8.5 x
11in.), JIS B5-size (182 x 257 mm), or Executive-size (7.25 x 10.5 in.) paper.

High-capacity trays are designed to hold larger amounts of paper for fewer printing interruptions.

Note: To configure tray settings, refer to the System Administrator Guide at www.xerox.com/office/
ALB81XXdocs.

Paper Size Confirmation

The system administrator can configure the device response that appears on the control panel touch screen when
paper of the same size is loaded in a tray. For standard adjustable paper trays, select an option:

Always Show: This option shows the paper confirmation prompt on the control panel touch screen until the
user dismisses it.

Delayed Confirmation: This option shows the paper confirmation prompt for a specified time. At the end of
the specified time, the prompt closes, which confirms the paper that is loaded. While the prompt appears on the
control panel touch screen, you can confirm any change to the paper type, color, and size.

Auto Confirmation: This option confirms the paper type, color, and size automatically without showing a
confirmation prompt on the control panel touch screen.

f Note: Xerox does not recommend using the Auto Confirmation option unless you always load the tray

with paper of the exact same type, color, and size.

j’ Note: To configure the Automatic Tray Confirmation Prompt, refer to Required Paper Policies in the System
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Power Options

POWER SAVER

To reduce standby power consumption, you can use Sleep Timeout to set the time that the printer spends idle in
Ready mode before the printer transitions to Sleep mode.

SMART PROXIMITY SENSOR

The Smart Proximity Sensor detects when a user approaches or leaves the device, using a reflective sensor. This
feature provides convenience for users, and can reduce power consumption. You can enable the device to wake up
and sleep based on the detection of a user. To configure the Smart Proximity Sensor, refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

POWERING ON THE PRINTER, OR EXITING SLEEP MODE

The printer has two power switches. The main power switch, located behind the front door, controls the main power
to the printer. The secondary power switch is the Power/Wake button on the control panel. The Power/Wake button
controls power to the printer electronic components, and when powered off, initiates a software-controlled
shutdown procedure. The preferred method to power on and off the printer is to use the Power/Wake button.

e To power on the printer, open the front door, then power on the main power switch. On the control panel, press
the Power/Wake button.

e To enter or exit Sleep mode, press the Power/Wake button.

fo Note:

e When the printer receives data from a connected device, the printer exits Sleep mode automatically.

e When the printer receives data from a network print job, to reduce power consumption, only necessary
electronic components exit Sleep mode automatically. The control panel and the document scanner do
not exit Sleep Mode.

e When the printer is in Sleep mode, the touch screen is powered off and unresponsive. To wake the printer
manually, press the Power/Wake button, or move into the Smart Proximity Sensor detection zone.

e If Auto Power Off is enabled, the printer powers off automatically after the specified conditions are met.
To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.
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® Caution: Do not plug or unplug the power cord while the printer is powered on.

RESTARTING, PLACING IN SLEEP MODE, OR POWERING OFF THE PRINTER
To restart the printer, place the printer in Sleep Mode, or power off the printer:

1. At the printer control panel, press the Power/Wake button.

3

Y o

2. Select an option:
e Torestart the printer, touch Restart.
e To place the printer in Sleep Mode, touch Sleep.
In Sleep Mode, the touch screen goes dark and the Power/Wake button pulses.
e To power off the printer, touch Power Off. A P1ease Wait message appears as the printer powers off.

3. If you want to power off the printer for an extended period, open the printer front door, then power off the
main power switch.

@ Caution: Do not unplug the power cord while the printer powers down.
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Accessing the Printer

AUTHENTICATION

Authentication is the process of confirming your identity. When the system administrator enables authentication,
the printer compares the information that you provide to another source of information, such as an LDAP directory.
The information can be a user name and password, or the information stored on a magnetic, proximity, radio
frequency identification (RFID), or smart card. If the information is valid, you are considered an authenticated user.

There are several ways to authenticate a user:

e User Name/Password - Validate on the Device: This option enables local authentication. Users prove their
identity by typing a user name and password at the control panel or in the Embedded Web Server. The printer
compares the user credentials to the information stored in the user database. If there are a limited number of
users, or you do not have access to an authentication server, use this authentication method.

e User Name/Password - Validate on the Network: This option enables network authentication. Users prove
their identity by typing a user name and password at the control panel or in the Embedded Web Server. The
printer compares the user credentials to the information stored on an authentication server.

o Convenience Authentication: If this option is enabled, a card with a magnetic strip or RFID is used. A
convenience authentication card is different from a smart card, which uses an embedded chip and typically
requires a login and password. If the optional integrated RFID reader is installed, for authentication, users place
a pre-programmed card over the RFID reader at the control panel.

e Xerox Workplace Cloud: This option enables cloud-based authentication. The printer connects directly to the
Xerox® Workplace Cloud solution. This method provides multiple options for authentication. To prove their
identity, users can use mobile authentication methods such as NFC or QR Codes, use an identification card, or
type a user name and password.

e Xerox Secure Access - Unified ID System: This option enables authentication for the Xerox Secure Access
Unified ID System. Users present a pre-programmed identification card to a card reader at the control panel.
The printer compares the user credentials to the information stored on the Xerox® Secure Access server.

o Identity Provider (IdP) - Validate on Cloud: This option enables cloud-based authentication through an
identity provider (IdP). The device establishes a secure connection with the IdP, then passes the user credentials
to the IdP for authentication.

o Smart Cards: This option enables authentication for a smart card reader. Users insert a pre-programmed
identification card in a card reader at the control panel.

e Custom Authentication: To use this authentication method, a feature installation key is required. After
entering the feature installation key, the customized authentication methods provided by Xerox are available for
configuration.

f Note: The system administrator can allow you to type your user name and password when Convenience
Authentication or Smart Cards is set as the primary authentication method. If the administrator configures
an alternative authentication method, and you misplace your card, you can still access the printer.

For information about configuring Authentication settings, refer to the System Administrator Guide at www.xerox.
com/office/ALB81XXdocs.
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AUTHORIZATION

Authorization is the function of specifying the features that users are allowed to access, and the process of
approving or disapproving access. You can configure the printer to allow users to access the printer, but restrict
access to certain features, tools, and apps. For example, you can allow users to access copying but restrict access to
scanning. You can also control access to features at specific times of the day. For example, you can restrict a group
of users from printing during peak business hours.

There are two types of authorization:
e Local Authorization verifies user information on the printer to approve access.

e Network Authorization verifies user information stored externally in a network database, such as an LDAP
directory, to approve access.

For information about configuring Authorization settings, refer to the System Administrator Guide at www.xerox.
com/office/ALB81XXdocs.

PERSONALIZATION

Personalization is the process of customizing and configuring the device information and settings for a logged-in
user. When a user logs in to the device, the device searches for the required configuration information for the user
account from an LDAP directory.

Personalization allows logged-in users to create a personalized user experience at the local user interface.
Personalization for logged-in users is enabled by default.

Personalization allows a logged-in user to configure the following settings:

e Personalized walk-up screen: When a user logs in, the device launches their preferred app instead of the default
walk-up screen.

e Personalized home screen: A user can select their preferred apps to display in a preferred order on the home
screen.

e Personalized default settings for the Copy, Email, Fax, Scan To, and ID Card Copy Apps.
e Personalized 1-Touch Apps.

e Personalized app to launch when originals are detected: At the home screen, when a logged-in user loads
original documents in the automatic document feeder, the device launches their preferred app.

e Personalized auto start settings for the Copy, Email, Fax, Scan To, and 1-Touch Apps.

e Personalized Adaptive Learning suggestions: Adaptive Learning personalization offers workflow-automation
suggestions to help logged-in users streamline their workflow. Personalized app workflow suggestions include:

—  Creation of personalized 1-Touch Apps for repetitive tasks

—  Creation of personalized 1-Touch Apps for complex tasks

— Reordering of app feature settings according to frequency of use
— Language preference settings

For a logged-in user, all personalized settings override the device defaults.

j’ Note: The options available are defined by the administrator. For example, if the administrator has chosen
to limit permissions for the use of an app, the individual user cannot override those permissions.
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For more information about all the Personalization options, see Personalize.

j’ Note: To allow the logged-in user to personalize their local user interface experience, the System
Administrator is required to configure the device personalization policy. For information on configuring the
device policy to enable user personalization, refer to the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

ACCOUNTING

Accounting is used to track and record the numbers of Copy, Print, Scanning, Server Fax, and Fax jobs that the
device produces for each user. The system administrator is required to create user accounts and enable the
accounting feature. After Accounting is enabled, provide Accounting IDs at the printer to access restricted apps. If
Authentication is enabled, you are required to log in first. Before you print documents from a computer, provide
your account details in the print driver.

The system administrator can set limits to restrict the total number of jobs by type that a user can send to the
printer. The administrator can generate reports that list usage data for individual users and groups.

For details, refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

LOGGING IN

Logging in is the process by which you identify yourself to the printer for authentication. If authentication is set, to
access printer features, you log in with your user credentials.

Logging In at the Control Panel

f Note:
e Before logging in for the first time at the Xerox device control panel, log in to the Embedded Web Server,
then update your password. For details, refer to Logging In Using the Embedded Web Server.
e If you do not know your user name or password, contact your system administrator.
1. At the printer control panel, press the Home button.
Touch Log In.

For User Name, use the keypad and enter your name, then touch Next.

&w N

If prompted, enter the password, then touch Done.

j’ Note: To access each app that is password-protected, repeat steps 3 and 4.
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Apps, Features, and Functions

INTRODUCTION TO APPS

Xerox Apps are a gateway to the features and functions of your device. Standard Apps are installed already on the
device and appear on the Home screen. Some Apps are installed as standard, but are hidden the first time you use
the device.

When you log in, the Apps configured for your personal account appear on the control panel.

You can download more Apps for your device from the Xerox® App Gallery. For more information, refer to Xerox®
App Gallery.

TOUCHLESS WORKFLOWS

There are two features that you can configure for the device to perform specific actions when originals are detected
in the automatic document feeder:

e Default Screen When Originals Are Detected: This feature sets the default app to launch when original
documents are loaded in the automatic document feeder. The setting applies when the device control panel
displays the Home screen only.

e Auto Start When Originals Are Detected: This option enables the Auto Start feature. The Auto Start feature
allows the device to start a job automatically within an app. For example, the device can be configured to
launch the Copy app automatically when media is detected in the automatic document feeder. The Auto Start
feature applies to Copy, Email, Fax, Scan To, and 1-Touch Apps. Auto Start can be enabled for individual apps, or
for all supported apps.

When both the Auto Start When Originals Are Detected feature and the Default Screen When Originals Are
Detected feature are enabled for an app, you can create touchless workflows. The following example describes this
scenario for a 1-Touch App, based on the Copy App. If the 1-Touch App is selected as the default app when
originals are detected, and Auto Start is enabled for the 1-Touch App. The control panel displays the Home screen.
When a user places original documents in the automatic document feeder, the device launches the 1-Touch App
automatically. The copy is initiated within 7 seconds, unless the user cancels the automatic operation.

When Personalization is enabled, a logged-in user can personalize their default app for when originals are detected.
The personalized setting for the default app when originals are detected applies to a logged-in user when the
control panel displays the Home screen. The preferred app opens when the user places documents in the automatic
document feeder.

For more information about creating and using 1-Touch Apps, refer to Personalize.

For detailed instructions on how to configure Entry Screen Defaults and the Auto Start feature, refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

ADAPTIVE LEARNING

Adaptive Learning offers workflow-automation and suggestions to help users to streamline their workflows. When
Adaptive Learning is enabled, the following features are provided:

e Automatically Set Device Defaults: This feature is enabled by the administrator and provides customization of
default settings based on device usage by walk-up users. Options include the default walk-up screen, the default
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screen when original documents are detected, and default settings for the Email and Scan To Apps. After this
feature is enabled, the device gathers usage data, then changes the default settings automatically to streamline
tasks.

e Suggest Personalized App Workflows: This feature provides personalized workflow suggestions for a logged-in
user based on their use of certain applications. An individual user can choose the types of suggestions that they
receive. Personalized suggestions apply to the Copy, Email, and Scan To Apps only.

For more information about personalized workflow suggestions, refer to Personalize.
j’ Note: The Adaptive Learning personalization feature is available to logged-in users only.

For detailed instructions on how to configure Adaptive Learning, refer to the System Administrator Guide at www.
xerox.com/office/ALB8 1XXdocs.
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Information Pages

Your printer has a set of information pages that you can print. These pages include configuration and font
information, getting started pages, and more.

The following Information Pages are available:

NAME DESCRIPTION

Basic Configuration Report The Basic Configuration Report provides printer
information, including the serial number, installed
options, network settings, port setup, tray information,
and more.

Detailed Configuration Report The Detailed Configuration Report provides
information about all of the printer settings, including
extensible services setup, security and authentication
server configuration, connectivity settings, and more.

Billing Summary The Billing Summary Report provides information
about the device and a detailed listing of the billing
meters and sheet counts.

Getting Started The Getting Started guide provides an overview of the
key features of the printer.

Troubleshooting Print Quality Page The Troubleshooting Print Quality Page provides a list
of common print-quality problems and tips to help
solve them.

Supplies Usage Page The Supplies Usage Page provides coverage
information and part numbers for reordering supplies.

Graphics Demo Page Print this page to check the quality of graphics.

PCL Font List The PCL Font List provides a printout of all PCL fonts

that are available on the printer.

PostScript Font List The PostScript Font List provides a printout of all
PostScript fonts that are available on the printer.

PRINTING INFORMATION PAGES

1. At the printer control panel, press the Home button.

2. Touch Device > Information Pages.

3. To print an information page, touch the needed page, then touch Print.
The printer prints the selected information page.

4. To return to the Home screen, press the Home button.
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CONFIGURATION REPORTS

There are two configuration reports available, a Basic Configuration Report, and a Detailed Configuration
Report. The configuration reports provide product information, including installed options, network settings, port
setup, tray information, and more.

Printing a Configuration Report

1. At the printer control panel, press the Home button.

2. Touch Device > Information Pages.

3. Touch Basic Configuration Report or Detailed Configuration Report, then touch Print.
The printer prints the chosen configuration report.

4. To return to the Home screen, press the Home button.
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The Embedded Web Server

The Embedded Web Server is the administration and configuration software that is installed in the printer. It allows
System Administrators to modify network and system settings on the printer remotely using a Web browser.

You can check the status of the printer, monitor paper and supply levels, and submit and track print jobs. All these
functions can be accessed from the convenience of your computer.

The Embedded Web Server requires:
e ATCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux environments.
e TCP/IP and HTTP enabled in the printer.

e A network-connected computer with a Web browser that supports JavaScript.

FINDING THE IP ADDRESS OF YOUR PRINTER

You need the IP address of your printer to do the following:

o Toinstall the print driver for a network-connected printer.

e To access the settings of your printer through the Embedded Web Server.

You can view the IP address of your printer on the control panel or on a configuration report.

j’ Note: To view the TCP/IP address on the control panel, wait until the printer has been on for 2 minutes. If
the TCP/IP address is 0.0.0.0, or begins with 169, it indicates that there is a network connectivity issue.

Viewing the IP Printer Address on the Control Panel
To view the IP address of the printer on the control panel:
1. At the printer control panel, press the Home button.
2. Touch Device > About.

The IP address appears in the Network section of the About screen for Wired IPv4 Address or Wired IPv6
Address.

3. Record the IP address from the display.

4. To return to the Home screen, press the Home button.

Obtaining the Printer IP Address from a Configuration Report

To obtain the printer IP address from a configuration report:

1. At the printer control panel, press the Home button.

2. Touch Device > Information Pages.

3. Touch Basic Configuration Report or Detailed Configuration Report, then touch Print.

The printer prints the chosen configuration report. The IP address appears in the Common User Data section of
the configuration report.

4. To return to the Home screen, press the Home button.
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ACCESSING THE EMBEDDED WEB SERVER

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or
Return.

To use the Embedded Web Server, click the page required:

» Home: This page provides a description of the printer and current notifications, the status of the paper trays,
and supplies and billing information. There is a Quick Links area at the bottom of the page that provides direct
access to key functions and pages.

e Jobs: The Jobs page enables you to manage active jobs on the printer, view, print, and delete saved jobs, and
create and manage saved job folders.

e Print: This page enables you to submit print-ready files to the printer for printing. You can select options for
print jobs using this page. Only print-ready files can be submitted, for example PDF, PS, PCL, and XPS file
formats.

e Scan: The Scan page enables you to create distribution workflows and mailboxes for scanned documents.

e Address Book: Use the Address Book page to create a Device Address Book containing contacts for use with
the fax, email, and scanning apps. You can configure the printer to use a Network Address book that looks up
addresses from an LDAP directory. The printer can also be configured to use a Network Address Book, which
looks up addresses from an LDAP directory. If both the Address Book and Device Address Book are configured,
users are presented with a choice when they use a compatible app.

e Properties: You can use the Properties tab to access and configure settings for your device. System
administrator login credentials are required to change most settings.

o Support: This page provides access to general support information and telephone numbers. You can use the
Support page to access the Remote Control Panel and send diagnostic information to Xerox.

The Embedded Web Server has a Help option that provides information about all available device features and
functions. To access Help, click the Help link displayed at the bottom of each page. Navigate to the topic required,
or use the Search function to find specific information.

For detailed instructions on how to use the Embedded Web Server to configure printer settings, refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

LOGGING IN USING THE EMBEDDED WEB SERVER

To access certain features, tools, and apps, log in to the Embedded Web Server for your device.

j’ Note: Access to some restricted functions requires administrator rights. For more information, refer to the
System Administrator Guide atwww.xerox.com/office/ALB81XXdocs.

To log in to the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

2. Inthe top right area of the page, click Login.
3. Enter your User ID and password, then click Login.
4. If you are logging in for the first time, set up a password.

a. Type the old password.
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b. Type anew password. To verify the password, retype it.

j’ Note: The new password must adhere to all minimum password requirements. For details, contact your
system administrator, or refer to the System Administrator Guide atwww.xerox.com/office/ALB81XXdocs.

c. Click Save. The new password is stored.

CERTIFICATES FOR THE EMBEDDED WEB SERVER

Your device includes an HTTPS certificate. The device generates the certificate automatically during device
installation. The HTTPS certificate is used to encrypt communications between your computer and the Xerox device.

j’ Note:

e The Embedded Web Server page for your Xerox device can display an error message that the security
certificate is not trusted. This configuration does not lessen the security of the communications between
your computer and the Xerox device.

e To eliminate the connection warning in your Web browser, you can replace the certificate with a signed
certificate from a Certificate Authority. For information on obtaining a certificate from a Certificate
Authority, contact your Internet Service Provider.

e To eliminate the connection warning in your Web browser, you can download the Xerox Root CA
certificate from the device Embedded Web Server, then install the certificate on your client.

For information on obtaining, installing, and enabling certificates, refer to the System Administrator Guide at www.
xerox.com/office/ALB81XXdocs.

DOWNLOADING THE CONFIGURATION REPORT FROM THE EMBEDDED WEB SERVER

From the Embedded Web Server, you can download and save a copy of the Configuration Report to your computer
hard drive. Use configuration reports from multiple devices to compare software versions, configurations, and
compliance information.

To download a copy of the Configuration Report from the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

f Note: For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your
Printer.

2. To download the Configuration Report, scroll to the bottom of the page. In the Quick Links section, click
Download Configuration Page.

j’ Note: If the Download Configuration Page option does not appear, log in as a system administrator.

The document is saved automatically as an XML file in the default download location on your computer hard
drive. To open the Configuration Report, use an XML viewer.
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USING THE REMOTE CONTROL PANEL FEATURE

The Remote Control Panel feature in the Embedded Web Server allows you to access the printer control panel
remotely from a Web browser.

j’ Note: To access the Remote Control Panel, first enable the feature. For details, contact your system
administrator or refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

To access the Remote Control Panel feature:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

f Note: For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your
Printer.

2. Inthe Quick Links areaq, click Remote Control Panel.

f Note: If the Remote Control Panel option is not displayed or fails to load, contact your system administrator.

3. To restrict other users from accessing the device control panel when you are connected remotely to the device,
click Block device control panel (local user can only observe).

j’ Note: If a local user attempts to access the control panel while the device control panel is locked, the control
panel does not respond. A message appears on the control panel, confirming that the control panel is locked
and the device is being controlled remotely.

4. To enable remote access to the device control panel, click Start Remote Session. The remote control panel
sends a request to the local control panel.

e If the local control panel is inactive, the remote control panel session is activated automatically.

e Ifalocal user is active on the device, a Remote Session Request message appears on the local control
panel. The local user chooses to accept or deny the request. If the request is accepted, the remote control
panel session is activated. If the request is denied, a Request Denied message appears in the
Embedded Web Server.

f Note: If the system administrator requests a remote session, if the request is denied, an option to override
the local session is displayed.

DOWNLOADING THE PRINT AND SCAN DRIVERS FROM THE EMBEDDED WEB SERVER

You can download the Print and Scan Drivers for your device from the Embedded Web Server.

1. In your computer Web browser, open the Embedded Web Server by typing the IP address of the printer.
2. Click Support > General.

3. To download the Print and Scan Drivers, at Assistance Links, click Install Print/Scan Drivers.

The Smart Start installer file is downloaded to your computer.

USING XEROX® WORKPLACE CLOUD TO MANAGE YOUR DEVICE

Xerox® Workplace Cloud is a cloud-based print solution that can remotely manage many aspects of your device.
Xerox® Workplace Cloud provides authentication, print management, cost control, and mobility workflows.
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Features such as Pull Printing allow you to submit your jobs to a secure single queue from any computer or mobile
device. After you have authenticated with the networked device of your choice, you can view, modify, print, or
delete your job as needed.

Flexible authentication options enable you to release your pull print jobs securely, and access your printer apps.
Single Sign-on (SSO) authentication is provided allowing you to access all of your SSO-enabled apps without having
to perform any additional login steps.

Xerox® Workplace Cloud is easy to set up and use, and because it is hosted in the cloud, Xerox manage all updates
and patches.

For more information about enabling Xerox® Workplace Cloud for your device, contact your system administrator or
refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.
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Installation and Setup
For reference:
e Installation Guide packaged with your printer

e Online Support Assistant at www.xerox.com/office/ALB81XXdocs

INSTALLATION AND SETUP OVERVIEW

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected. Configure
the initial settings of the printer, then install the print driver software and utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect to a network using an Ethernet
cable or wireless connection. Hardware and cabling requirements vary for the different connection methods.
Routers, network hubs and switches, modems, Ethernet cables, and USB cables are not included with your printer
and must be purchased separately. Xerox recommends an Ethernet connection because it is typically faster than a
USB connection, and it provides access to the Embedded Web Server.

For more information, refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

SELECTING A LOCATION FOR THE PRINTER

& Warning: To avoid personal injury and damage to the printer, professional installation of the printer is
required.

1. Select a dust-free area with temperatures from 10°-32° C (50°-90° F), and relative humidity of 15-85 percent.

j’ Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can cause
condensation inside the printer, which directly interferes with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight of the
printer. Ensure that the printer is horizontal and that all four feet are in solid contact with the surface.
To find the weight for your printer configuration, refer to Physical Specifications.

3. Select a location with adequate clearance to access supplies and to provide proper ventilation.
To find the clearance requirements for your printer, refer to Clearance Requirements.

4. After you position the printer, you are ready to connect it to the power source and computer or network.

UPDATING THE PRINTER SYSTEM SOFTWARE

Before installing print driver, verify that the printer has the latest version of system software loaded. When Xerox
releases a new version of printer system software or firmware, you can update your device. To ensure a successful
software update, follow the steps provided with the software files. Printer system software is downloaded from
www.xerox.com/office/ALB8 1XXsupport.

Before you download and install new software, determine the current software version installed on your device.
Print a configuration report to compare the system software version with the version available for download. For
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instructions about printing a configuration report, refer to Printing a Configuration Report.

Follow the instructions provided with the software to download the files and upgrade your device. You can configure
the device to connect routinely to an FTP directory on your network to update device software automatically. You
can also update the device software manually. For more information about updating system operating software,
refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.
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Connecting the Printer

SELECTING A CONNECTION METHOD

You can connect the printer to your computer using a USB cable, Ethernet cable, or wireless connection. The
method that you select depends on how your computer is connected to the network. A USB connection is a direct
connection and is the easiest to set up. An Ethernet connection is used to connect to a network. If you are using a
network connection, it is important to understand how your computer is connected to the network.

j’ Note: Hardware and cabling requirements vary for the different connection methods. Routers, network hubs,
network switches, modems, Ethernet cables, and USB cables are not included with your printer and require a
separate purchase.

USB
If you connect the printer to one computer and do not have a network, use a USB connection. A USB
connection offers fast data speeds, but typically is not as fast as a network connection.

Network

If your computer is connected to an office network or home network, use an Ethernet cable to connect the
printer to the network. You cannot connect the printer directly to the computer. A connection through a router
or network switch is required. An Ethernet network can be used for one or more computers and supports many
printers and systems simultaneously. An Ethernet connection is typically faster than USB and allows you direct
access to the settings of the printer using the Embedded Web Server.

j’ Note: To access the Embedded Web Server, a network connection is required.

Wireless Network

If your environment includes a wireless router or wireless access point, you can connect the printer to the
network with a wireless connection. A wireless network connection provides the same access and services as a
wired connection. A wireless network connection is typically faster than USB and allows direct access to the
settings of the printer using the Embedded Web Server.

CONNECTING TO A COMPUTER USING A USB CABLE
To connect the printer to a computer using a USB cable, you need one of these operating systems:

e Windows 7, Windows 8, Windows 8.1, Windows 10, Windows 11, Windows Server 2008 R2, Windows 10,
Windows Server 2008 R2, Windows Server 2012, Windows Server 2016, Windows Server 2019, and Windows
Server 2022.

e Macintosh OS version 10.13 and later.

e UNIX and Linux: Your printer supports connection to various UNIX platforms through the network interface.
To connect the printer to a computer using a USB cable:

1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the printer.
2. Connect the A end of the USB cable to the USB port on the computer.

3. If the Windows Found New Hardware Wizard appears, click cancel.
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4. Install the print driver.

For more information, refer to Installing the Software.

CONNECTING TO A WIRED NETWORK

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is used for
one or more computers and supports many printers and systems simultaneously. An Ethernet connection provides
direct access to printer settings using the Embedded Web Server.

To connect the printer:
1. Connect the power cord to the printer, then plug the cord into an electrical outlet.

2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the back of the printer.
Connect the other end of the cable to a correctly-configured network port.

3. Power on the printer.

For details on configuring connection settings, refer to the System Administrator Guide at www.xerox.com/office/
ALB81XXdocs.

WIRELESS NETWORK ADAPTER

The Xerox® Wireless Network Adapter enables you to use the Wireless Wizard to connect to a wireless network. The
compatibility of the Wireless Adapter is dependent on the device model and software version.

The Xerox® Wireless Network Adapter supports the following:
e Wi-Fi Bands: Dual Band 2.4 GHz and 5 GHz
e Network Standards:
- 802.11ac
- 802.11n
- 802.11b/a/g
e Wi-Fi Direct

For more information on the Wireless Network Adapter, refer to the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

Connecting to a Wireless Network

If you have purchased the Xerox® Wireless Network Adapter, you can use the Wireless Wizard to connect the device
to a wireless network. If the device is connected to a wired network, you can configure wireless settings using the
Embedded Web Server or at the control panel touch screen using the Wireless Install Wizard.
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j’ Note:

e Not all Xerox® Wireless Network Adapters are compatible with all Xerox® printers. Ensure that you
purchase the correct Xerox® Wireless Network Adapter kit for your device. For more information, contact
your Xerox representative.

e For more information about installing the wireless network adapter, refer to the Xerox® Wireless Network
Adapter Kit Hardware Install and Setup instructions that are included with the kit.

e The device uses either the wireless or the wired network connection. Activating one network connection
deactivates the other network connection.

e When you switch from a wired connection to a wireless connection, the IP address of the printer
changes. For more information on IP address or host name, refer to System Administrator Guide.

For details on configuring wireless network settings, refer to the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

CONNECTING WITH WI-FI DIRECT

You can connect to your printer from any Wi-Fi-enabled mobile device, such as a tablet, computer, or smart phone,
using Wi-Fi Direct or Soft AP features. The Wi-Fi Direct feature is disabled by default on the Xerox device.

j’ Note: The Wi-Fi Direct feature is available only on printers with the optional Wireless Network Adapter
installed. After you install the Wireless Network Adapter, the Wi-Fi Direct feature is enabled by default.

Wi-Fi Direct Overview

The Wi-Fi Direct feature allows you to print from a mobile device to your printer, using one of the following
methods.

e WPS push button, for Wi-Fi Direct-enabled Android devices with the Mopria print plug-in installed.
e Soft Access Point (AP), for Apple iPhones and other mobile devices that do not support the Wi-Fi Direct function.

For information about using the Wi-Fi Direct feature on your mobile device, or connecting to the printer using the
Soft AP feature, refer the mobile device documentation from the manufacturer.

For information about configuring the Wi-Fi Direct feature on your printer, refer to the System Administrator Guide
at www.xerox.com/office/ALB81XXdocs.

Using Wi-Fi Direct on Your Mobile Device

The Wi-Fi Direct WPS Push Button feature requires the Mopria Print Service App installed on your mobile device. The
printer does not require a wireless connection.

Installing Mopria Print Service
1. On your mobile device, go to the Google Play Store, then search for Mopria Print Service.
Install the Mopria Print Service App.

Go to Settings, then touch Printing.

- W N

Go to the notification area, then touch Mopria Print Service.
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5. To enable Mopria Print Service, touch On.
6. Exit Settings.

Your mobile device searches for Wi-Fi Direct-enabled printers that are in range of the mobile device.

Using Wi-Fi Direct on your Printer

Wi-Fi Direct is a direct wireless connection from your mobile device to the printer. The Wi-Fi Direct feature is
enabled by default when the Wi-Fi hardware is installed.

Using the Wi-Fi Direct feature does not require a wireless network connection to a printer. Contact your System
Administrator to connect your printer to a wired or wireless network.

Printing Using Wi-Fi Direct

To print a document from a Wi-Fi-enabled mobile device:

1. On the mobile device, open the document that you want to print.

In the device application, select the Print button.

If there is more than one printer in the area with Wi-Fi Direct enabled, select the required printer from the list.

Select the print settings required for the job.

v W N

Submit the job for printing.
A message appears on the mobile device.

6. Select Connect.

When the connection is made, a message appears on the printer.
7. At the printer control panel, touch OK.

The job prints.
CONNECTING WITH NEAR FIELD COMMUNICATION (NFC)

NFC Overview

f Near field communication (NFC) is a technology that enables devices to communicate

@ when they are in close range. NFC allows you to add a printer to your Android mobile
device easily. After you add the printer, there is no need to use NFC on that printer. The
NFC feature requires installation of the Xerox Print Service app on the mobile device.

Printers can communicate using NFC when they are within your mobile device range.

j’ Note: The range can vary depending on the device manufacturer. For information about the required
settings for individual mobile devices, refer the documentation supplied by the manufacturer of your mobile
device.

For details about configuring NFC on your printer, refer to the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.
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Using NFC on your Mobile Device
The NFC feature requires installation of the Xerox Print Service app on the mobile device.

Your mobile device must use the same Wi-Fi network environment as the printer. The printer does not need to have
a wireless connection.

f Note: NFC supports Android 4.4 or greater devices.

Installing the Xerox Print Service Plugin

1. On your mobile device, go to the Google Play Store, then search for Xerox Print Service Plugin.
Install the Xerox Print Service Plugin app.

Go to Settings, then touch Printing.

Go to the notification pull-down bar, then touch Xerox Print Service.

To enable Xerox Print Service, touch On.

o v &~ W N

Exit Settings.

Enabling NFC on the Mobile Device

Most mobile devices have NFC disabled by default.
To enable NFC:

1. Go to Settings.

2. Go to the NFC setting, then touch On.

3. Exit Settings.

Using NFC on your Printer

The NFC chip is on the bottom right of the control panel. When NFC is enabled, the NFC icon is lighted, and you
can use the NFC function.

H

7

Refer to your mobile device user documentation for the mobile device NFC chip location.

j’ Note: The NFC function must be enabled before use. For NFC enable instructions, refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

Mapping the Printer to your Mobile Device

1. Open the Xerox Print Service Plugin.

2. At the top right side of the screen, touch the selection button, then select Add Printer.
3. Touch the NFC option.
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4. Hold the mobile device over the NFC icon on the control panel.

The mobile device and the printer communicate with each other. The mobile device searches the network for the
printer. When the printer is located, it is added to the list as a mapped printer.

You can submit print jobs from your mobile device to the printer.

Printing using Xerox® Print Services

1. Open the document that you want to print. For example, a PDF or Word document.
At the top of the screen, select the Print button.

If there is more than one printer mapped for use with NFC, select the printer required.

Select the print settings required for the job.

v &~ W N

Submit the job for printing.

CONFIGURING AIRPRINT

AirPrint is a software feature that allows you to print documents from Apple iOS-based mobile devices and MacOS-
based devices without a print driver. AirPrint-enabled printers that use a wired or wireless connection allow you to
print or fax directly from a Mac, an iPhone, iPad, or iPod Touch. Additionally, you can use AirPrint to scan from a
wired or wireless printer to supported Apple devices.

For information about AirPrint configuration settings, refer to the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs. Alternatively, use a desktop computer to access the Embedded Web Server for your device,
then click the Help link that appears at the bottom of each page. For details, refer to Accessing the Embedded Web
Server.

CONFIGURING A DEVICE FOR UNIVERSAL PRINT

Universal Print is a cloud-based print protocol that provides a simple and secure print solution for Microsoft® 365
users. Universal Print allows administrators to manage printers without the need for on-premises print servers.
Universal Print enables users to access cloud printers without the need for print drivers.

e When Universal Print is enabled, the configuration settings appear. The Universal Print area displays the
registration status of your device.

e When Universal Print is disabled, the configuration settings are hidden. The Universal Print area shows the status
Of f. This status is the default.

For information about configuring a device for Universal Print, refer to the System Administrator Guide at www.
xerox.com/office/ALB8 1XXdocs.
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CONNECTING TO A TELEPHONE LINE
If an optional fax kit is installed, connect the telephone line to enable and configure the fax settings.

j’ Note: One-line or two-line fax kits are available. To enable fax functions, install the fax card provided with the
kit, using the installation instructions provided.

& Warning: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger
telecommunication line cord.

1. Ensure that the printer is powered off.

2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger to the Line port on the back of
the printer.

3. Connect the other end of the RJ11 cable to an operating telephone line.
4. Power on the printer.

5. Enable and configure the Fax functions.
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Initial Printer Setup

Before installing the printer software, verify that the printer is set up correctly. Setup includes enabling the optional
features and assigning an IP address for the Ethernet network connection. Printer settings can be configured at the
printer control panel or by using the Embedded Web Server. To configure settings at the printer control panel, the
Installation wizard starts the first time that you power on the printer. The wizard prompts you with a series of
questions to help configure basic printer settings.

The System Administrator can configure the following settings:
e Llanguage

e Network Connection

e Proxy Server Setup

e Date and Time

e Measurements

o LDAP Settings

e Apps Setup

e Security Settings

For more information on configuring the printer settings at the control panel or using the Embedded Web Server,
refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

CONFIGURATION WATCHDOG

Configuration Watchdog is a security feature that monitors feature settings to ensure that the device stays in the
appropriate configuration throughout day-to-day operations. The feature ensures that values remain compliant
without external device monitoring. When a watched setting changes, Configuration Watchdog detects the change
on the next manual or scheduled check. After a change is detected, Configuration Watchdog remediates the
feature to the required settings.

After remediation occurs, administrators can view the list of remediated items on the Configuration Watchdog
page.

For more information about Configuration Watchdog, contact your system administrator, or refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

FLEET ORCHESTRATOR

The Fleet Orchestrator feature allows you to configure many devices in similar ways, automatically. After you
configure one device, you can distribute any of the configuration settings to other devices, as needed. You can set
up schedules to share configuration settings regularly and automatically.

The Fleet Orchestrator feature enables you to share the following types of configuration files:
e Clone files
e Software upgrade files

e 1-Touch Add-On files
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For more information about Fleet Orchestrator, contact your system administrator, or refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

XEROX® EASY ASSIST APPLICATION

Xerox Easy Assist application can assist you with the initial setup procedure for a new printer. You can access and
configure the printer from your smartphone through the Xerox Easy Assist (XEA) app. To access the printer from
your smartphone, download and install the Xerox Easy Assist app on your mobile device. By installing the Xerox Easy
Assist app on your smartphone, you can setup your new printer easily, manage its configuration, view alerts
indicating supply requirements and order them, and get live troubleshooting support for your printer.

The Xerox Easy Assist App has instructions and video links that help you to unpack the printer from its shipping box.
To install the Xerox Easy Assist app on your smartphone, you need to scan a QR Code. You can find this QR Code on
the packaging box or the Installation Guide that comes with the printer. To install the Xerox Easy Assist app for the

first time, scan the QR Code with your smartphone camera.

For more information, refer to Xerox® Easy Assist (XEA) App.
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Installing the Software

Before you install the print driver software, verify that the printer is plugged in, powered on, connected correctly,
and has a valid IP address. The IP address usually appears in the center of the control panel. If you cannot find the
IP address of your printer, refer to Finding the IP Address of Your Printer.

f Note: If the Software and Documentation disc is not available, download the latest drivers from www.xerox.
com/office/ALB81XXdrivers.

After you install the print driver software, you can configure printing preferences and default settings for the print
driver. For more information, refer to Printing.

Printing settings for the device, such as banner pages and Page Description Language options, are configured using
the Embedded Web Server. To configure printing settings, contact your System Administrator or refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

OPERATING SYSTEM REQUIREMENTS

e Windows 7, Windows 8, Windows 8.1, Windows 10, Windows 11, Windows Server 2008 R2, Windows 10,
Windows Server 2008 R2, Windows Server 2012, Windows Server 2016, Windows Server 2019, and Windows
Server 2022.

e Macintosh OS version 10.13 and later.

e UNIX and Linux: Your printer supports connection to various UNIX platforms through the network interface.

INSTALLING THE PRINT DRIVERS FOR A WINDOWS NETWORK PRINTER

1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the installer does
not start automatically, navigate to the drive, then double-click the Setup.exe installer file.

j’ Note: If you do not have the Software and Documentation disc, download the Smart Start installer file from
www.xerox.com or the Embedded Web Server of your printer. For more information, refer to Downloading
the Print and Scan Drivers from the Embedded Web Server.

2. Click Xerox Smart Start — Driver Installer (Recommended).
3. At the License Agreement, click Agree.

4. From the list of discovered printers, select your printer.

j’ Note: When you install print drivers for a network printer, if your printer does not appear in the list, click
Don’t See Your Printer?, then enter the IP address for your printer. To install the recommended print driver,
click Continue, then select Install.

5. Click Quick Install.
A message appears that confirms that the installation is successful.

6. To complete the installation and close the Installer window, click Done.
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INSTALLING THE WINDOWS PRINT DRIVER .ZIP FILE

You can download print drivers from Xerox.com in a .zip file, then use the Windows Add Printer Wizard to install the
print drivers on your computer.

To install the print driver from the .zip file:

1.
2.
3.

o o N oo

11.
12.

13.
14.

Download, then extract the required .zip file to a local directory on your computer.
At your computer, open the Control Panel, then select Devices and Printers > Add a Printer.

Click The printer that I want isn’t listed, then click Add a local printer or network printer with manual
settings.

To use a previously established port, select Use an existing port, then from the list, select a Standard TCP/IP
Port.

To create a Standard TCP/IP port:

a. Select Create a New Port.

b. For Type of port, select Standard TCP/IP Port, then click Next.

¢.  Inthe Hostname or IP address field, type the printer IP address or host name.

d. To disable the feature, clear the check box for Query the printer and automatically select the driver to
use, then click Next.

Click Have Disk.
Click Browse. Browse to, then select the driver.inf file for your printer. Click Open.
Select your printer model, then click Next.

If a prompt appears because the print driver was installed previously, click Use the driver that is currently
installed (recommended).

In the Printer name field, type a name for your printer.
To install the print driver, click Next.

If needed, set the printer as the default printer.

f Note: Before you select Share Printer, contact your system administrator.

To send a test page to the printer, click Print a test page.

Click Finish.

INSTALLING THE PRINT DRIVERS FOR A WINDOWS USB PRINTER

1.
2.
3.

Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the printer.
Connect the A end of the USB cable to the USB port on the computer.

If the Windows Found New Hardware Wizard appears, click cancel.
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4. Insert the Software and Documentation disc into the appropriate drive on your computer. If the installer does
not start automatically, navigate to the drive, then double-click the Setup.exe installer file.

j’ Note: If you do not have the Software and Documentation disc, download the Smart Start installer file from
www.xerox.com or the Embedded Web Server of your printer. For more information, refer to Downloading
the Print and Scan Drivers from the Embedded Web Server.

5. Click Xerox Smart Start — Driver Installer (Recommended).

6. At the License Agreement, click Agree.

7. From the list of discovered printers, select your printer, then click Quick Install.
A message appears that confirms that the installation is successful.
8. To complete the installation and close the Installer window, click Done.

INSTALLING THE PRINTER AS A WEB SERVICE ON DEVICES

Web Services on Devices (WSD) allows a client to discover and access a remote device and its associated services
across a network. WSD supports device discovery, control, and use.

Installing a WSD Printer Using the Add Device Wizard
1. At your computer, click Start, then select Printers and Scanners.
2. To add the required printer, click Add a Printer or Scanner.

3. Inthe list of available devices, select the device that you want to use, then click Next.

j’ Note: If the printer that you want to use does not appear in the list, click Cancel. To add the printer
manually, use the IP address of the printer. For details, refer to Installing the Windows Print Driver zip File.

4. Click Close.

INSTALLING THE DRIVERS AND UTILITIES FOR MACOS

1. Download the latest print driver from www.xerox.com/office/ALB81XXsupport.

Open the Xerox® Print Drivers 5.xx.x.dmg or .pkg as needed for your printer.

To run Xerox® Print Drivers 5.xx.x.dmg or .pkg, double-click the appropriate file name.
When prompted, click Continue.

To accept the license agreement, click I Agree.

o v &~ W N

To accept the current installation location, click Install, or select another location for the installation files, then
click Install.

7. If prompted, enter your password, then click OK.
8. From the list of discovered printers, select your printer, then click Next.
9. If your printer does not appear in the list of discovered printers:

a. Click the Network Printer Icon.

b. Type the IP address of your printer, then click Continue.
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c.  Select your printer in the list of discovered printers, then click Continue.

10. If your printer was not detected, verify that the printer is powered on and that the Ethernet or USB cable is
connected properly.

11.  To accept the print queue message, click OK.
12.  Select or clear the Set Printer as Default and Print a Test Page check boxes.

13. Click Continue, then click Close.

Adding the Printer for MacOS

For networking, set up your printer using Bonjour® (mDNS), or for an LPD, LPR connection, connect using the IP
address of your printer. For a non-network printer, create a desktop USB connection.

For more information, go to the Online Support Assistant at: www.xerox.com/office/ALB8 1XXsupport.

Adding the Printer Using Bonjour
To add the printer using Bonjour®:
1. From the computer Applications folder or from the dock, open System Preferences.
2. Click Printers & Scanners.
The list of printers appears on the left of the window.
3. For the list of printers, click the Plus icon (+).
4. At the top of the window, click the Default icon.

5. Select your printer from the list, then click Add.

j’ Note: If your printer is not detected, verify that the printer is powered on and that the Ethernet cable is
connected properly.

Adding the Printer by Specifying the IP Address

To add the printer by specifying the IP address:

1. From the computer Applications folder or from the dock, open System Preferences.
2. Click Printers & Scanners.

The list of printers appears on the left of the window.

In the list of printers, click the Plus (+) icon.

Click IP.

From the Protocol list, select the protocol.

In the Address field, enter the IP address of the printer.

In the Name field, enter a name for the printer.

From the Use list, choose Select a driver to use.

From the printer software list, select the print driver for your printer model.

Click Add.
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INSTALLING PRINT DRIVERS AND UTILITIES FOR UNIX AND LINUX

For more information on installing print drivers and utilities for UNIX and Linux, refer to www xerox.com/office/
ALB81XXdrivers.
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More Information

Getting Started

You can obtain more information about your printer from these sources:

RESOURCE LOCATION

Installation Guide

Packaged with the printer.

Getting Started guide

Print from the control panel. For details, refer to
Information Pages.

Other documentation for your printer

www.xerox.com/office/ALB81XXdocs

Recommended Media List

United States: www.xerox.com/rmlna

European Union: www.xerox.com/rmleu

Technical support information for your printer,
including online technical support, Online Support
Assistant, and print driver downloads.

www.xerox.com/office/ALB81XXsupport

Information Pages

Print from the control panel. For details, refer to
Information Pages.

Embedded Web Server information

In the Embedded Web Server, click Help.

Order supplies for your printer

www.xerox.com/office/supplies

A resource for tools and information, including
interactive tutorials, printing templates, helpful tips,

and customized features to meet your individual needs.

www.xerox.com/office/businessresourcecenter

Local sales and Technical Customer Support

www.xerox.com/office/worldcontacts

Printer registration

www.xerox.com/register

Xerox® Direct online store

www.direct.xerox.com/

LOCATING THE SERIAL NUMBER

When you order supplies or contact Xerox for assistance, you need the serial number of your device. You can obtain
the serial number in several ways. To locate the serial number, print a configuration report, or view the serial number

on the control panel or on the Embedded Web Server home page. The serial number is printed on a label that is

affixed to the printer. To view the label, open the left side door.

For details on how to print a configuration report, refer to Information Pages.

To view the serial number on the control panel:

1. At the printer control panel, press the Home button.

2. Touch Device > About.

The model, serial number, and software version is displayed.

3. Toreturn to the Home screen, press the Home button.
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Personalize Overview

This chapter provides information on how to personalize your device user interface to meet the specific demands of
your workflows.

Personalization enables individual logged-in users to work more productively, and ensures that the features and
functions displayed meet individual user needs. Personalization allows you to configure apps, and hide, show, and
rearrange apps on the Home screen to suit your job priorities.

The device uses the Adaptive Learning functionality to analyse the apps and features used when you are logged in
to the device. The device provides personalized workflow suggestions based on your activity. As an individual user,
you can choose the types of Adaptive Learning suggestions that you receive. You can enable or disable your
suggestion options at the device control panel.

You can create private 1-Touch Apps to save and simplify lengthy or frequent workflows. After you create your 1-
Touch Apps, they appear on the logged-in users Home screen. For each app, you can hide or show individual
features and personalize default settings to meet your needs, and save job settings for repeated use.

System administrators can use the Customization feature to configure settings for all users. Customization allows
the system administrator to do the following:

e Hide, show, and rearrange apps on the Home screen
e Create and edit 1-Touch Apps

e Hide or show app features

e Configure and save the default settings

For details, contact your system administrator, or refer to the System Administrator Guide at www.xerox.com/office/
ALB81XXdocs.

f Note: Personalization settings configured by individual users override any equivalent Customization settings
configured by the system administrator.
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Personalization by the User

PERSONALIZING THE HOME SCREEN

Using the personalization options, you can show, hide, or change the display order of apps for the Home screen.

Displaying or Hiding an App on the Home screen
To display or hide an app on the Home screen for the logged-in user:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Personalize.
4. Touch Personalize Home.
5. Todisplay an installed, but hidden app:
a. Touch the Plus (+) icon.
b. Touch the app that you want to appear on the control panel.
6. To hide an installed app:
a. For the required app, touch X.
b. Touch Hide.
7. Touch Done.

8. Verify that only the required apps appear on the Home screen.

Rearranging Apps on the Home screen
To rearrange apps on the Home screen for the logged-in user:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

Scroll to the bottom, then touch Personalize.
Touch Personalize Home.
Touch and hold the required app, then drag the app to the new location. Release the app.

Touch Done.
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Verify that the apps appear in the correct location on the Home screen.

Deleting an App from the Home Screen
To delete an app from the Home screen for the logged-in user:

1. At the printer control panel, press the Home button.
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2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Personalize.
4. Touch Personalize Home.
5. To delete an installed app:
a. For the required app, touch X.
b. At the prompt, touch Delete.
6. Touch Done.

7. Verify that only the required apps appear on the Home screen.

Removing Personalization From the Home Screen
To remove personalization from the Home screen for the logged-in user:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Personalize.
4, Select an option:

e Remove Home Personalization: This option removes all personalization from the Home screen.

(D Caution: The Remove Home Personalization option removes personalization from the Home screen, and
other personalized device settings.

e Remove All Personalization: This option removes all personalization for the logged-in user, including
personalized 1-Touch apps.

j’ Note: Any customizations configured by the system administrator, including 1-Touch, EIP, Single Touch, and
Weblet apps, are not affected.

5. At the prompt, touch Remove.

Apps appear in the default location on the Home screen.

6. Touch Done.

PERSONALIZING ENTRY SCREEN DEFAULTS

Use the Entry Screen Defaults option to set the screen defaults or actions when a user logs in to the device for the
first time. You can personalize the following options:

o Device Default App: The Device Default App is the initial app that appears to a logged-in user, or when the
device is reset to default settings.

o Originals Detected: This feature sets the default app to launch when original documents are loaded in the
automatic document feeder. The setting applies when the device control panel displays the Home screen only.
The setting does not apply when a different app is open at the control panel.
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If a selected app is no longer available, a notification displays and the entry screen defaults return to the factory
default settings.

When both the Auto Start When Originals Are Detected feature and the Originals Detected feature are
enabled for an app, you can create touchless workflows. For more information, refer to Creating Personalized
Touchless Workflows.

Setting the Device Default App
To set the device default app for the logged-in user:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

Touch Personalize.

Touch Entry Screen Defaults.

Touch Device Default App.

Touch the required app or 1-Touch App.
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Touch OK.

Setting the Originals Detected Option
To set the default screen when original documents are detected:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

Touch Personalize.

Touch Entry Screen Defaults.

Touch Originals Detected.

Touch the required app or 1-Touch App.
Touch OK.
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PERSONALIZING THE APPS

The app personalization options enable you to modify the features available, save app default settings, or remove
personalized settings applied to an app.

You can personalize the Copy, ID Card Copy, Email, Fax, and Scan To apps for your device.

Personalizing the Feature List
Personalization of Features list is available for Email, Scan To, Embedded Fax, and Copy apps.

To personalize the Features list for an app for the logged-in user:
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1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

Touch the app required.
Scroll to the bottom, then touch Personalize.

Touch Personalize Feature List.
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Touch the required option.

e To hide a feature, for the required feature, touch the Eye icon. To signify that the feature is hidden, the Eye
icon appears with a line across it.

e To show a feature, for the required feature, touch the Eye icon. To signify that a feature is visible, the Eye
icon appears with no line across it.

7. To reorder the menu features, touch and drag the features into the appropriate order. If Adaptive Learning is
enabled for Personalization, to order the feature list according to feature usage, touch the Adaptive Learning
icon.

8. To save the current configuration, touch Done.

Showing all Features in the Features List

To show all the hidden features for an app:

1. At the printer control panel, press the Home button.
Touch the app required.

Select the job settings.
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Scroll to the bottom, then touch Show Additional Features.

The hidden features list appears.

Saving App Default Settings

You can use this feature to save a particular combination of app settings as the default settings. This feature is
available for Email, Scan To, Embedded Fax, Copy, and ID Card Copy apps.

To save the current app settings as default settings for the logged-in user:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

Touch the app required.
Select the job settings that you want to save as the default settings.

Scroll to the bottom of the feature list, then touch Personalize.

o v & W

Touch Save Settings as Default.

70 Xerox® Altalink® B8145/B8155/B8170 Series Multifunction Printer User Guide



7.

Personalize

At the prompt, touch Save.

The new settings override the previous default settings.

Enabling the Auto Start Feature as an App Default Setting

The Auto Start When Originals Are Detected feature allows the device to start a job automatically within an app.
The feature applies when an app is open and Auto Start is enabled for that app. When the device detects original
documents in the automatic document feeder, the job starts automatically.

The Auto Start feature applies to Copy, Email, Fax, Scan To, and 1-Touch Apps.

When both the Auto Start When Originals Are Detected feature and the Originals Detected feature are enabled for
an app, you can create touchless workflows. For more information, refer to Creating Personalized Touchless
Workflows.

To enable the Auto Start feature for selected apps:

\

1.
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At the printer control panel, press the Home button.

Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

Touch the app required.

Select the job settings that you want to save as the default settings.

To enable Auto Start, touch the Auto Start When Originals are Detected toggle button.
Scroll to the bottom of the feature list, then touch Personalize.

Touch Save Settings as Default.

At the prompt, touch Save.

When the logged-in user selects the app and loads original documents in the automatic document feeder, the
job starts automatically.

Removing App Personalization Using the Control Panel

To remove the current app personalization settings:

1.
2.
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At the printer control panel, press the Home button.

Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

Touch the app required.
Scroll to the bottom of the feature list, then touch Personalize.
Touch Remove App Personalization.

At the prompt, touch Remove.

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide 71



Personalize

PERSONALIZING THE LANGUAGE

A logged-in user can personalize the default language settings and the default keyboard layout.
Each time the user logs in to the device, the selected language and keyboard settings are activated.
To personalize the default language and keyboard layout:

1. At the printer control panel, press the Home button.

2. Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

Touch Log In, then touch Personalize Language.
To change the language, touch the language required.

To change the keyboard layout, touch Keyboard Layout, then touch the option required.

o v & W

Touch Done.
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Personalization from Adaptive Learning

Adaptive Learning reacts to everyday usage of the device to streamline tasks for users and administrators. Adaptive
Learning provides personalized workflow suggestions for a logged-in user based on their use of certain applications.
An individual user can choose the types of suggestions that they receive. Individual users can enable and disable
their personalized suggestion options at the device control panel.

Adaptive Learning personalization offers workflow-automation suggestions to help logged-in users streamline their
workflow. Personalized app workflow suggestions include the following:

e Creation of 1-Touch Apps for repetitive tasks

e Creation of 1-Touch Apps for complex tasks

e Reordering of app feature settings according to frequency of use
o Language preference settings

Adaptive Learning personalization is enabled by default. When Adaptive Learning personalization is enabled, all
personalization suggestion options for logged-in users are enabled by default. When Adaptive Learning
personalization is enabled, logged-in users can manage their personalization suggestions at the control panel.

1-TOUCH APP SUGGESTIONS

When Adaptive Learning and Personalization are enabled, the device offers to create a 1-Touch App for repeated or
complex tasks.

If a logged-in user selects identical job programming repeatedly, after 7 days, a repetitive task is identified and the
device suggests creating a 1-Touch App.

If a logged-in user selects six or more features for a job, a complex task is identified, and the device suggests
creating a 1-Touch App for the repeated job.

The 1-Touch App suggestion is offered immediately after job submission. If the offer is accepted, a 1-Touch App is
created. If the offer is declined, the same 1-Touch App suggestion is not offered again for 14 days.

To create a repeated or complex job 1-Touch App from a suggestion screen:

1. After job submission, if a repeated or complex job is identified, the suggestion screen appears. From the
suggestion screen, touch Create 1-Touch App.

2. To enter a name, touch the Enter 1-Touch App Name entry field, then use the alphanumeric keypad. Touch
Next.

3. Do one of the following:
e To create the 1-Touch App with the default settings, touch Create 1-Touch App.
e To modify the 1-Touch App settings, touch Personalize Appearance, then do the following:
1. Touch a color scheme option for your 1-Touch App, then touch Next.
2. Touch an icon that best suits the 1-Touch App that you are creating, then touch Next.

3. To provide instructions that appear at the top of the app screen, touch the entry field, then use the
alphanumeric keypad to enter instructions for users. Touch Done.

The system saves the 1-Touch App, and the app appears on the Home screen for the logged-in user.
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FEATURE LIST ORDER SUGGESTIONS

When Adaptive Learning and Personalization are enabled, the device offers to reorder the features listed in an app
based on the usage history of the logged-in user.

The device collects feature usage data for 30 days. After 10 job submissions during the 30 days, when a user logs in
to the device and selects an app, if the usage order does not match the current order, the device offers to reorder
the feature list.

If the suggestion is accepted, the most frequently used features are moved to the top of the list. Features that have
never been used are hidden and moved to the Show Additional Features area.

Whether the suggestion is accepted or declined, there are no additional offers to reorder the list for 14 days.
To reorder the feature list from a suggestion screen:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

3. Touch the app required. If the device has collected usage data for 30 days or more, a suggestion screen
appears.

4, To accept the offer to reorder features, touch Reorder Features. The features are reordered based on the
usage history of the logged-in user.

5. To modify the feature list manually, touch the required option, then do the following:

e To hide a feature, for the required feature, touch the Eye icon. To signify that the feature is hidden, the Eye
icon appears with a line across it.

e To show a feature, for the required feature, touch the Eye icon. To signify that a feature is visible, the Eye
icon appears with no line across it.

e To reorder the menu features, touch and drag the features into the appropriate order.

6. Touch Done.

PERSONALIZED LANGUAGE SUGGESTIONS

When Adaptive Learning and Personalization are enabled, if a logged-in user selects a different language, the
device offers to change the language immediately after the user changes the current language.

To personalize the language from a suggestion screen:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

3. If the logged-in user changed the language in the previous session, a suggestion screen appears. To accept the
offer to change your default language, touch Make Default.

The default language for the logged-in user is changed.
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MANAGING YOUR PERSONALIZATION SUGGESTIONS

When Adaptive Learning and Personalization are enabled, the device provides suggestions for an improved user
experience at the device.

To manage your personalization suggestions:

1.
2.

At the printer control panel, press the Home button.

Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

Touch Log In, then touch Manage Suggestions.
Alternatively, you can access the Manage Suggestions option from each suggestion screen.

Touch the options required:

e Repetitive 1-Touch App: Use this option to receive a suggestion to create a 1-Touch App for jobs that you
program repeatedly.

e Complex 1-Touch App:: Use this option to receive a suggestion to create a 1-Touch App for jobs with six or
more feature selections.

e Feature Order:: Use this option to receive a suggestion to update the feature list order, to list features that
you use more frequently at the top.

e Language:: Use this option to receive a suggestion to change the language when a different language is
selected.

Touch OK.
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1-Touch Apps

1-Touch Apps are individual apps which are created to allow completion of frequent jobs or tasks. You can create 1-
Touch Apps in Copy, Email, Fax, and Scan To apps.

The following types of 1-Touch Apps are available:

Public 1-Touch Apps: Device administrators and users with customization privileges can create public 1-Touch
Apps, When you create a public 1-Touch App, you can configure the app to allow users to make temporary
changes to the app feature settings. When the app is reset, any temporary changes are discarded. The app can
also be configured to prevent users from viewing or changing the app feature settings. The public 1-Touch App
appears on the device Home screen. Device administrators and users with customization privileges can save an
existing public 1-Touch App as a new public 1-Touch App, then adjust the appearance and default settings for
the new app as needed. If Personalization is enabled, all logged-in users can save a public 1-Touch App as a new
private 1- Touch App, then adjust the appearance and default settings for the new app as needed.

Private 1-Touch Apps: If Personalization is enabled, all logged-in users can create private 1-Touch Apps. Private
1-Touch Apps are available only for the user that created the app, and appear only on the Home screen for the
logged-in user. After you create a private 1-Touch App, you can save the app as a new private 1-Touch App,
then adjust the appearance and default settings for the new app as needed.

j’ Note: All private 1-touch Apps allow for temporary changes. When the app is reset, any temporary
changes are discarded.

All private 1-touch Apps allow for temporary changes. When the app is reset, any temporary changes are
discarded.

For information about configuring public 1-Touch Apps, refer to the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

C

REATING A PRIVATE 1-TOUCH APP

To create a private 1-Touch App for the logged-in user:

1.
2.
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At the printer control panel, press the Home button.

Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

Touch the app required.
Select the job settings for the 1-Touch App, as required.
Scroll to the bottom of the feature list, then touch Create 1-Touch App.

To enter a name, touch the Enter 1-Touch App Name entry field, then use the alphanumeric keypad. Touch
Next.
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7. Do one of the following:
e To create the 1-Touch App with the default settings, touch Create 1-Touch App.
e To modify the 1-Touch App settings, touch Personalize Appearance, then do the following:
1. Touch a color scheme option for your 1-Touch App, then touch Next.
2. Touch an icon that best suits the 1-Touch App that you are creating, then touch Next.

3. To provide instructions that appear at the top of the app screen, touch the entry field, then use the
alphanumeric keypad to enter instructions for users. Touch Done.

The system saves the 1-Touch App, and the app appears on the Home screen for the logged-in user. The 1-
Touch App is hidden from all other users.

CREATING A PRIVATE 1-TOUCH APP FROM A PUBLIC 1-TOUCH APP
To create a private 1-Touch App from an existing public 1-Touch App:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

3. Touch the public 1-Touch App required.
4. Scroll to the bottom of the feature list, then touch Save As New 1-Touch App.

5. To enter a name, touch the Enter 1-Touch App Name entry field, then use the alphanumeric keypad. Touch
Next.

6. Do one of the following:
e To create the 1-Touch App with the default settings, touch Create 1-Touch App.
e To modify the 1-Touch App settings, touch Personalize Appearance, then do the following:
1. Touch a color scheme option for your 1-Touch App, then touch Next.
2. Touch an icon that best suits the 1-Touch App that you are creating, then touch Next.

3. To provide instructions that appear at the top of the app screen, touch the entry field, then use the
alphanumeric keypad to enter instructions for users. Touch Done.

The system saves the 1-Touch App, and the app appears on the Home screen for the logged-in user. The 1-
Touch App is hidden from all other users.

EDITING A 1-TOUCH APP
To delete or hide a 1-Touch App from the Home screen:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the user name using the keypad, then touch Next. Type the password using the keypad,
then touch Done.

3. Touch Personalize.

4. Touch Personalize Home.
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5.

6.

For the required 1-Touch App, touch X, then touch an option.
e Delete: Use this option to delete the 1-Touch App from the printer permanently.

e Hide: Use this option to remove the 1-Touch App from the Home screen. The 1-Touch App is still available,
and you can add the app to the Home screen at any time.

Touch Done.

DELETING OR HIDING A 1-TOUCH APP

To delete or hide a 1-Touch App from the Home screen:

1.
2.

At the printer control panel, press the Home button.

Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

Touch Personalize.

Touch Personalize Home.

For the required 1-Touch App, touch X, then touch an option.

e Delete: Use this option to delete the 1-Touch App from the printer permanently.

e Hide: Use this option to remove the 1-Touch App from the Home screen. The 1-Touch App is still available,
and you can add the app to the Home screen at any time.

Touch Done.

USING AND EDITING A 1-TOUCH APP

To use a 1-Touch App:

1.
2.

78

At the printer control panel, press the Home button.

If required, touch Log In. Type the user name using the keypad, then touch Next. Type the password using the
keypad, then touch Done.

Load the original documents in the automatic document feeder or on the document glass.
Touch the 1-Touch App required.

If editing is enabled, edit the feature settings as required. If editing is restricted, to create a new 1-Touch, select
Save As New 1-Touch, then edit the new 1-Touch App.

Touch Start.

To return to the Home screen, press the Home button.
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Creating Personalized Touchless Workflows

When Personalization is enabled, a logged-in user can use the Entry Screen Defaults settings, with the Auto Start
When Originals Are Detected feature to create a touchless workflow.

Touchless workflows improve productivity by configuring the device to perform automatic operations when original
documents are placed in the automatic document feeder. Touchless workflows save time for repetitive or regular
activities performed on the device.

In this scenario, a user receives multiple sets of high-quality, hard-copy printed documents for scanning and
proofing every day. The user logs in to the device, and creates a private 1-Touch App based on the Scan To App.
The private 1-Touch App has the image quality and destination settings configured, and the Auto Start When
Originals Are Detected feature enabled. To personalize the Entry Screen Defaults, for Device Default App and
Originals Detected, the user chooses the private 1-Touch App. Each day, to run the job, the user logs in to the
device, and places the first set of original documents in the automatic document feeder. The private 1-Touch App
launches automatically, and the job initiates within 7 seconds. The first job completes, then the user continues to
load each set of documents into the automatic document feeder. Each job completes, and the scanned images are
sent to the preprogrammed destination, without any user interaction with the touch screen.

For information about creating and using 1-Touch Apps, refer to 1-Touch Apps.
For instructions on personalizing app default settings, refer to Personalizing the Apps.

For information about setting the Entry Screen Defaults, refer to Personalizing Entry Screen Defaults.
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Removing All Personalizations
To remove all personalizations from the device:
1. At the printer control panel, press the Home button.

2. Touch Log In. Type the User Name using the keypad, then touch Next. Type the Password using the keypad,
then touch Done.

3. Scroll to the bottom, then touch Personalize.

4. Touch Remove All Personalizations.

(D Caution: The Remove Home Personalization option removes personalization from the Home screen, and
other personalized device settings.

5. At the prompt, touch Remove All.
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Xerox ® Apps are a gateway to the features and functions of your device. There are standard Apps already installed
and displayed on the Home screen. Some Apps are installed as standard, but are hidden when you use your device
for the first time. You can show, hide, or reorder Apps on the Home screen using the settings available in the
Embedded Web Server.

For details about displaying, configuring, and customizing the Apps, refer to the System Administrator Guide at
www.xerox.com/office/ALB8 1XXdocs.

A range of Apps is available for download and installation from the Xerox® App Gallery. These apps include Xerox®
Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed apps on compatible printers.

For more information about using the Xerox® App Gallery and downloading Apps, refer to Xerox® App Gallery.
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Xerox® App Gallery

XEROX® APP GALLERY OVERVIEW

i

Use the Xerox® App Gallery to find apps that provide new features or capabilities for
- your device. The Xerox® App Gallery provides direct access to apps that can improve
- your productivity, simplify workflows, and enhance your user experience.

J|

The Xerox® App Gallery enables you to browse and update apps easily. You can browse
the App Gallery without logging in. The moving banner provides an active display of
apps, or you can scroll the full list of apps. To get more details on an app, touch the app
name in the list.

To use the Xerox® App Gallery App, ensure that your device uses either the wireless or the wired network connection.

j’ Note: If your device is configured to access the Internet through a proxy, to allow the Xerox® App Gallery
App to access the Internet, ensure that the proxy is configured correctly.

For more information and instructions on using the Xerox® App Gallery, refer to the Xerox® App Gallery User Guide
available at www.xerox.com/XeroxAppGallery.

If authentication or accounting is enabled on your device, to access features, enter your login details. For details
about Personalization for logged-in users, refer to Personalize.

CREATING A XEROX® APP GALLERY ACCOUNT

With an App Gallery account, you have direct access to all the available Apps for your device. An App Gallery
account allows you to view and acquire Apps, install Apps on your device, and manage your Apps and licenses.

You can set up an App Gallery account using the control panel or the Xerox® App Gallery Web portal. For more
information about the Xerox® App Gallery Web portal, refer to www.xerox.com/XeroxAppGallery.

f Note: If you have an existing Xerox App Gallery Account, refer to Logging in to your Xerox® App Gallery
Account.

To create an App Gallery account using the Control Panel:
1. At the printer control panel, press the Home button.
Touch Xerox App Gallery.

Touch Log In.

&= WN

Touch Create Account.
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Enter the information required into the appropriate fields:

e Email Address

e Confirm Email Address

e Password

e Confirm Password

e First and Last Name

e Company Name

e Country

e Payment Currency

Review and accept the Terms of Service and the Data Administration Terms of Service, then click OK.

After the account is created, a message appears that confirms that completion instructions will be sent to the
email address entered in step 5.

To complete the account creation process, verify your account:

a. Access the inbox for the email address provided in step 5, then open the Welcome to Xerox® App Gallery
email.

b. Click Verify Account.
A webpage opens.

c. To complete the verification process, enter the email address and password entered in step 5, then click
Log In.

A welcome message appears that confirms that the account verification process is complete.

LOGGING IN TO YOUR XEROX® APP GALLERY ACCOUNT

When you are logged in to the App Gallery, you can browse available Apps, and install and update Apps.

To log in to your App Gallery Account:

1.
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At the printer control panel, press the Home button.
Touch Xerox App Gallery, then select Log In.

To enter your email address, use the touch screen keypad.
To enter your password, use the touch screen keypad.

To log in, touch OK or Enter.

INSTALLING OR UPDATING AN APP FROM THE XEROX® APP GALLERY

Xerox® Apps add to, extend, or customize the functionality of your device. You can use the Xerox®App Gallery App
to browse and install Apps at your device control panel.

To install an App from the App Gallery:

1.

At the printer control panel, press the Home button.
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Touch Xerox App Gallery, then select Log In.
To enter your email address, use the touch screen keypad.

2
3
4. To enter your password, use the touch screen keypad.
5. Touch OK or Enter.

6

Touch the App required, then touch Install. The License Agreement screen appears.

j’ Note: If the App was installed previously and a new version is available, the Install option changes to an
Update option.

7. Touch Agree. The installation process begins.
If the App does not successfully install, to attempt the installation process again, touch Install.

8. To exit the Xerox® App Gallery App, press the Home button.

Updating an App from the App Gallery

1. At the printer control panel, press the Home button.
Touch Xerox App Gallery, then select Log In.
To enter your email address, use the touch screen keypad.
To enter your password, use the touch screen keypad.

Touch OK or Enter.

Touch Agree.

2
3
4
5
6. Touch the App required, then touch Update. The License Agreement screen appears.
7
8. When the update is complete, the Update option changes to an Installed status.

9

To exit the Xerox® App Gallery App, press the Home button.
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Device

DEVICE OVERVIEW

The Device App gives you access to information about your printer, including the serial
number and model. You can view the status of the paper trays, billing and supplies
information, and print information pages.

Many Device options can be configured to meet your individual needs. For details about configuring all of the
Device settings, refer to the System Administrator Guide at www xerox.com/office/ALB81XXdocs.

Device Options

The following device options are available:

OPTION DESCRIPTION

o Admin For logged-in users, Personalization Settings provides access to the
Co Personalization Personalized Language and Manage Suggestions options. For
Settings more information about Personalization settings, refer to Personalize.
Language Pressing the Language button allows you to set the language that
@ appears on the control panel touch screen.

f Note: Sometimes this option is hidden from view. For details,
see the System Administrator Guide at www.xerox.com/office/

ALB81XXdocs.
About The About option provides an overview of your device, the device
serial number, and information about current settings.
Information Your printer has a set of information pages that you can print. These
E Pages pages include configuration and font information, demonstration

pages, and more.

Notifications Use the Notifications option to see details of any current alerts or
errors on the device. A Fault History option displays fault codes and
the date that they occurred on the device.

Lo

Paper Trays Use the Paper Trays option to see the paper size, type, and color set
for each paper tray and the tray-capacity status.

Supplies Use the Supplies section to monitor the status of the components you
can replace. The supply level and estimated number of impressions or
days that remain for each unit is displayed.

LD

Billing/Usage Use the Billing/Usage option to view the serial number and the total
number of impressions your device has made.

B
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OPTION DESCRIPTION

Tools Use the Tools option to customize settings such as the power-save
modes, the date and time, and the control panel brightness. You can
configure settings using the device control panel, or by using the
Embedded Web Server.

w2
f Note: For details on configuring the printer settings, see the
System Administrator Guide at www.xerox.com/office/

ALB81XXdocs.
Web-Based Use the Web-Based Configuration (Test Drive) tool to access device
Configuration capabilities and configuration options available on the Embedded
(Test Drive) Web Server, at the device control panel.

f Note: Some Embedded Web Server configuration options and

‘ features are restricted. Examples of restricted options and
features are downloading and installing files, and accessing
links that redirect to external websites.

Remote Services | Use the Remote Services option to send error and usage information
@ to the Xerox support team.

f Note: Your System Administrator is required to enable this
feature using the Embedded Web Server.

Xerox Easy Assist | Use the Xerox Easy Assist app to access and configure the printer
(XEA) App from your smartphone. By installing the Xerox Easy Assist app on your
smartphone, you can setup your new printer easily, manage its

configuration, view alerts indicating supply requirements and order
them, and get live troubleshooting support for your printer.

For more information, refer to Xerox® Easy Assist (XEA) App.

For details on configuring the printer settings, refer to the System Administrator Guide at www.xerox.com/office/
ALB81XXdocs.

ABOUT

The About option provides an overview of your device and its current settings and status. You can view the serial
number, model number, and software version.

INFORMATION PAGES

Your printer has a set of information pages that you can print. These pages include configuration and font
information, getting started pages, and more.

The following Information Pages are available:
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NAME DESCRIPTION

Basic Configuration Report The Basic Configuration Report provides printer
information, including the serial number, installed
options, network settings, port setup, tray information,
and more.

Detailed Configuration Report The Detailed Configuration Report provides
information about all of the printer settings, including
extensible services setup, security and authentication
server configuration, connectivity settings, and more.

Billing Summary The Billing Summary Report provides information
about the device and a detailed listing of the billing
meters and sheet counts.

Getting Started The Getting Started guide provides an overview of the
key features of the printer.

Troubleshooting Print Quality Page The Troubleshooting Print Quality Page provides a list
of common print-quality problems and tips to help
solve them.

Supplies Usage Page The Supplies Usage Page provides coverage
information and part numbers for reordering supplies.

Graphics Demo Page Print this page to check the quality of graphics.

PCL Font List The PCL Font List provides a printout of all PCL fonts

that are available on the printer.

PostScript Font List The PostScript Font List provides a printout of all
PostScript fonts that are available on the printer.

Printing Information Pages

1. At the printer control panel, press the Home button.

2. Touch Device > Information Pages.

3. To print an information page, touch the needed page, then touch Print.
The printer prints the selected information page.

4. To return to the Home screen, press the Home button.

SUPPLY STATUS

You can check the status and percentage of life remaining for your printer supplies at the control panel or from the
Embedded Web Server. When printer supplies near their replacement time, warning alerts appear on the control
panel. You can customize the alerts that appear on the control panel and configure email alert notifications.

To check the supplies status at the control panel:

1. To view status information for the printer supplies, touch Device > Supplies.
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2. To view details about a specific item, including its part number for reordering, touch the required item.
3. Toreturn to the Supplies screen, touch X.
4. To return to the Device screen, touch X.

To check the supplies status and set up alerts, use the Embedded Web Server. For details about configuring all
Device settings, refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

BILLING AND USAGE COUNTERS

The Billing/Usage menu displays the total number of impressions that the printer generated or printed during its
lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper. For example, a sheet of
paper that is printed on two sides counts as two impressions.

To view the Billing and Usage Counters:

1. At the printer control panel, press the Home button.

2. Touch Device > Billing/Usage.

3. To view more details, touch Usage Counters, then select an option.

e Impression Counters: This option provides the number of impressions made by the printer. The number of
impressions cannot equal the number of sheets counted, depending on the printer setup. If your printer is
set up to count large sheets as large impressions or as multiple smaller impressions, the number of
impressions can differ.

e Sheet Counters: This option provides the number of impressions made by the printer. Impressions for 2-
Sided sheets are identified as a separate line from 1-Sided sheets.

¢ Images Sent Counters: This option provides the number of images sent using the Fax, Email, or Scan
features.

e Fax Impressions Counters: This option provides the number of images sent using the Fax features. Each
fax feature is identified on a separate line.

e All Usage Counters: This option provides all printer usage information.

4. After viewing the usage readings, to return to the Home screen, press the Home button.

REMOTE SERVICES

You can use the Remote Services option to send error and usage information to the Xerox support team to help
them resolve problems quickly.

For information about enabling Remote Services and uploading information to Xerox, refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

XEROX® EASY ASSIST (XEA) APP

Xerox Easy Assist app allows you to access and configure the printer from your smartphone. To access the printer
from your smartphone, download and install the Xerox Easy Assist app on your mobile device. By installing the
Xerox Easy Assist app on your smartphone, you can setup your new printer easily, manage its configuration, view
alerts indicating supply requirements and order them, and get live troubleshooting support for your printer.
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To install the Xerox Easy Assist app on your smartphone, you need to scan a QR Code or search the app in the Apple
App Store or Google Play Store. There are two types of XEA QR Codes:

e QR Code to acquire the XEA app: This QR Code is for the first initial installation of the app. To install the Xerox
Easy Assist app for the first time, you are required to scan this QR Code using your smartphone camera. You can
find this QR Code on the packaging box or the Installation Guide that comes with the printer. Check the
following locations for the XEA QR Code:

—  Printer packaging box

— Installation Guide

—  Device Install Wizard

—  Help materials

For more information, refer to Prior to Installing the Printer: Initial Setup with Xerox® Easy Assist (XEA) App.

e QR Code to connect the mobile device to printer: This QR Code is to setup a Wireless network connection
between the smartphone and the printer. For example, connection to Wi-Fi Direct. You can find this QR Code at
the printer control panel or in the device Install Wizard. The QR Code provides all key information to connect
your smartphone and the printer without manually entering any technical information. To connect to the
printer, scan this QR Code within the Xerox Easy Assist app. For more information, refer to After Initial
Installation: Connecting to the Xerox® Easy Assist App from the Control Panel.

Primary features of Xerox Easy Assist app, are:

Set Up a New Printer

If you have the QR Code or IP Address available, you can set up a new Xerox printer with the help of Xerox Easy
Assist app. On My Printers screen in the app, touch the + icon, then touch Set Up a New Printer. Follow the
instructions from the app.

For more information, refer to Adding Multiple Printers to the Xerox Easy Assist App.

Printer Status

The status displays the printer information, such as readiness of the printer, toner level, and paper tray status for
each tray. You can order parts and supplies through the Xerox Easy Assist app. If the toner level appears to be
low, to order a new toner, select the Toner icon, then touch Reorder.

Alerts

The Xerox Easy Assist app can notify you of any errors or problems in the printer. To view the error statement,
touch the Bell icon.

Print

You can perform a print job through the Xerox Easy Assist app. In the app, select your printer, then touch Print.
Select the document that you need to print from your mobile device, confirm the print settings, then touch
Print.

Device Settings

You can view and edit your printer settings from the Device Settings tab. If you have not setup a password
during the initial setup, to view or edit existing printer settings, you need to set up the password.

Support

You can request support and find solutions for printer-related problems through the Xerox Easy Assist app. In the
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app, select your printer, then touch Support. It connects you to Xerox's Support Agent Live Chatbot.

Set Up Computer

You can download Print and Scan Drivers for your printer through Xerox Easy Assist app. In the app, select your
printer, then touch Set Up Computer. In the Email field, type your registered email address, then touch the +

icon to add your email. To download and install the Print and Scan Drivers, the app sends a Quick Link to your

email address.

Print Test Page

To confirm that all settings are correct, you can print a test page. In the app, select your printer, then touch
Print Test Page.

Remove a Printer

You can remove a printer from the Xerox Easy Assist app. On your app, select a printer from My Printers page,
then swipe left and touch Remove.

Prior to Installing the Printer: Initial Setup with Xerox® Easy Assist (XEA) App

To complete the initial setup and install the Xerox Easy Assist app for the first time, do the following:

1.

For initial setup when the printer is powered on for the first time, the initial setup wizard appears. At the printer
control panel, do the following:

a. Select your Language, then touch Next.
The Xerox Easy Assist Mobile App screen appears.
b. To use your mobile device to set up and manage your printer, touch Yes.
Get the App screen appears to confirm the type of your mobile device. Choose any one option:
e i0S: To install the Xerox Easy Assist app for your iPhone, select this option.
e Android: To install the Xerox Easy Assist app for your Android mobile device, select this option.

e I have the App: If you have installed Xerox Easy Assist app on your mobile device already, select this
option.

If you have selected iOS or Android option, a screen appears to help you download the app. At the control
panel, touch Show QR Code option.

A screen appears with the QR Code. To install the app, scan the QR Code with your smartphone camera.
Download and install the Xerox Easy Assist app on your smartphone:

e For Android phones: Go to Google Play Store, then search for Xerox Easy Assist app.

e ForiOS or iPhones: Go to Apple App Store, then search for Xerox Easy Assist app.

When you install the app for the first time on your smartphone, for End-User License Agreement (EULA), touch
I Agree.

j’ Note: The Xerox Easy Assist App has instructions that help you to unpack the printer from its packaging box.
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To watch a helpful video to unpack your printer, scan the QR Code on the packaging box or the Installation
Guide that came with your printer, with your smartphone camera. Accept the End-User License Agreement
(EULA), then follow the instructions that appear on the app.
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5. Follow the instructions that appear on the app. To connect your smartphone with the printer, touch Connect
To My Printer.

6. At the printer control panel, to connect to the app, touch Show QR Code option. The second or connect—-QR
Code appears.

7. Scan the QR Code through the Xerox Easy Assist app. Follow the instructions that appear on the app.

When the connection is configured, your smartphone and the printer share the same Wireless network,
temporarily.

8.  With the support of Xerox Easy Assist app, complete the general settings and register the printer on the
network.
General settings include Admin Password, Connectivity, Measurements, Sound, Power Saver settings, and more.

f Note: Ensure that your smartphone is connected to the same Wireless or wired network as the printer and
they can communicate after the setup is complete.

9. To complete the initial setup in the app, type the necessary information for your printer, then touch Complete
Setup.

The Welcome screen appears.
When the initial setup is complete, with the Xerox Easy Assist app, you can perform the following:
e Setting up a new printer
e Checking the printer status and order supplies
e Downloading Print and Scan Drivers
e Printing
e (Getting troubleshooting support
e Removing a printer from the XEA app My Printers list

For Xerox Easy Assist app features, refer to Xerox® Easy Assist (XEA) App.

After Initial Installation: Connecting to the Xerox® Easy Assist App from the Control Panel

For a printer that is already installed and does not require initial installation setup, to use the features of the XEA
app, connect the printer to Xerox Easy Assist app. By accessing Xerox Easy Assist (XEA) app through your
smartphone, you can setup additional printers, manage its configuration, view alerts indicating supply requirements
and order them, and get live troubleshooting support for your printer. You can find the QR Code and connect to the
XEA app from the printer control panel:

1. At the control panel Home screen, touch Device.
2. From Device options, touch the icon for Xerox Easy Assist App.

The Xerox Easy Assist App screen appears, with a display of main features Setup, Manage, Print.
3. Select from the following options:

e Get Started: Select this option to connect and add the printer to the XEA app.

e Close: Select this option to return to the Device screen.
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To add the printer to the app, touch Get Started.

Get the App screen appears on the printer control panel.

Touch any one option:

e Back: To return to the initial XEA app screen, select this option.

e I Have the App: When you have the XEA app installed on your smartphone, select this option.
e Android: To install the XEA app from Google Play Store, select this option.

e i0S: To install the XEA app from Apple App Store, select this option.

If you have the XEA app installed on your smartphone already, then touch I Have the App.
Connect to Xerox Easy Assist Mobile App screen appears with a QR Code.

To connect the printer to the app, scan the QR Code through the XEA app, then follow the instructions that
appear on your smartphone and the control panel.

To view the Wireless network information, touch Manual Entry. The Wi-Fi Direct information appear on the
control panel touchscreen. To connect the printer to the app, you can type the Wi-Fi Direct information
manually on the XEA app.

j’ Note: If the printer and mobile device cannot communicate, ensure that they are on the same network.

9. To return to the Connect to Xerox Easy Assist Mobile App screen, touch Close.

10. To return to the Xerox Easy Assist App main screen, touch Back.

Adding Multiple Printers to the Xerox Easy Assist App

If your printer is already set up on your network and the Initial Setup Wizard is complete, through the XEA app, you
can include additional printers directly to the list of My Printers. To add printers that are on the network, open the
XEA app Home page. On the My Printers screen, touch the + icon, then refer to the following options:

92

Setting Up a New Printer: To set up a new printer from your smartphone XEA app, at the Add Printer screen,
select Set Up a New Printer. Follow the instructions that appear on the printer control panel and your mobile
device.

Adding an Existing Printer: To add an existing printer from the network, select any one from the options:

— QR Code: To scan the printer QR Code with the XEA app scanner, touch QR Code. To find the QR Code of
the printer, refer to After Initial Installation: Connecting to the Xerox® Easy Assist App from the Control
Panel.

— IP Address: To connect to the printer by typing the IP Address manually, touch IP Address. Type the IP
Address of the printer, then touch OK. To find the IP Address of the printer, refer to Finding the IP Address
of Your Printer.

Finding the Nearby Network Printers: When your smartphone is connected to the same Wireless or wired
network as the printer, to find nearby printers, select Printers Around Me. The app looks for nearby printers on
the network:

— If the app finds the printer, you can select and add the printer directly.

— If the app is unable to find the printer you are looking for, then you can add the printer by typing its IP
address.
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j’ Note: If the printer and mobile device cannot communicate, ensure that they are on the same network.
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Jobs

JOBS OVERVIEW

You can use Jobs to view current jobs, print saved and secure jobs, and view details
about completed jobs. You can pause, delete, print, or view job progress or job details for
a selected job.

JOB OPTIONS

The following job options are available:

OPTION DESCRIPTION

Interrupt Button | When enabled by the System Administrator, pressing the Interrupt
= button allows you to pause the current job to run a more urgent job.

j’ Note: Sometimes this option is hidden from view. To enable
the Interrupt function, refer to the System Administrator Guide
at www.xerox.com/office/ALB8 1XXdocs.

Pause Button Pressing the Pause button allows you to temporarily pause an active
“ print job. The job pauses with the option to resume printing or to
delete the job.

MANAGING JOBS

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs. You can
interrupt, pause, or delete jobs that are printing. You can also view job progress or job details for a selected job.

A print job can be held by the printer when it is unable to complete the job. For example, if the printer needs
attention, paper, or supplies. When the condition is resolved, the printer automatically resumes printing. When you
send a Secure Print job, the job is held until you release it by entering a passcode at the control panel. For more
details, refer to Managing Special Job Types.

From the Jobs window in the Embedded Web Server, you can view a list of active and saved print jobs. For more
details, refer to Managing Jobs using the Embedded Web Server.

Imaging Security
Imaging Security uses infrared light to track and manage sensitive documents.

If the Infrared Security option is enabled in the Embedded Web Server, the device detects concealed security
marks applied by a Xerox® AltalLink® C81XX Series printer. This method of detection can prevent the accidental
disclosure of confidential documents.

The system administrator can configure infrared mark detection for jobs. When Detect Mark is enabled, the device
detects security marks on documents that are scanned. When a security mark is detected during scanning,
depending on the settings configured, the device inhibits the job, sends an email alert and continues the job, or
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sends an email alert and inhibits the job. When a security mark is detected, the device adds an entry to the Audit
Log.

If a security mark is detected on your job, a message appears on the control panel to indicate the action taken. If a
job is deleted because a security mark was detected, if Job Details is selected, the status indicates a security
document has been detected.

For more information about Imaging Security, contact your system administrator, or refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

Interrupting Printing

System Administrators can allow users to interrupt active print jobs. For details about Interrupt Printing
Enablement, refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

1. At the printer control panel, press the Home button.
2. Touch Jobs.
A list with active jobs, that are queued for the printer, appears.

3. At the control panel, touch the Interrupt button. The printer continues to print while it determines the best
place to pause the spooled print job.

4. Printing stops to allow the printer to complete another job.

5. To resume printing, touch the Interrupt button again.

Pausing or Deleting a Print Job
1. At the printer control panel, press the Home button.
2. Touch Jobs.
A list with active jobs, that are queued for the printer, appears.
3. To pause a job that is printing, touch the Pause button on the control panel.
4. Select a task.
e To resume the print job, touch Resume.
e To delete the print job, touch Delete. At the prompt, touch Delete.

5. To return to the Home screen, press the Home button.

Printing a Job Held for Resources

When a job is held for resources, a status message and a pop-up alert appear on the control panel, as default. From
the Embedded Web Server, the system administrator can configure whether only a status message appears, or both
status message and a pop-up alert appear on the control panel.

1. If the pop-up alert is disabled by the system administrator, to view the held jobs, do the following:
a. At the printer control panel, press the Home button.

b. Touch Jobs.

A list with active jobs, that are queued for the printer, appears.
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4.

When the pop-up alert is enabled, if a job is held for resources, a pop-up alert appears on the control panel. On
the pop-up alert, touch View Active Jobs.

A list with active jobs, that are queued for the printer, appears.
From the jobs list, touch the held job name. The following options appear:

e Print On Alternate Paper: To choose an alternative paper source to enable the job to print, touch Print On
Alternate Paper. Select a paper tray, then touch OK.

e Delete: To delete the print job, touch Delete. At the prompt, touch Delete.
e Job Progress: To view the progress, touch Job Progress.

e Job Details: To view the details, touch Job Details. At the prompt, you can view the Job Settings and
Required Resources.

To print the job, replenish the resources required. The job resumes automatically when the required or alternate
resources are available.

f Note: The Print On Alternate Paper option is enabled using the Embedded Web Server. For details about

5.

the Print On Alternate Paper option, refer to the System Administrator Guide at www.xerox.com/office/
ALB81XXdocs.

To return to the Home screen, press the Home button.

MANAGING SPECIAL JOB TYPES

Special job types allow you to send a print job from your computer, then print it from the printer control panel.
Select special job types in the print driver, Printing Options tab, under Job Type.

Saved Job

Saved Jobs are documents that are sent to the printer and stored there for future use. All users can print or delete a
Saved Job.

At the control panel, from the Print From menu, you can view and print saved jobs. In the Embedded Web Server, in
the Jobs window, you can view, print, and delete saved jobs, and you can manage where jobs are stored.

Printing using Saved Job

1.

96

In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

Select your printer, then open the print driver.

e For Windows, click Printer Properties. Depending on your application, the title of the button can vary.
e  For Macintosh, in the Print window, in the print options list, click Xerox Features.

For Job Type, select Saved Job.

a. Type ajob name or select a name from the list.

b. Type a folder name or select a name from the list.

c. Toadd a passcode, click Private, type the passcode, then confirm the passcode.

d. Click OK.
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Select other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Printing deleting, moving, or copying a saved job in the Embedded Web Server

1.

o v &~ w N

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

In the Embedded Web Server, click Home.

Click Jobs.

Click the Saved Jobs tab.

For the job that you want to process, select the check box.

From the menu, select an option.

e Print Job: This option prints a job immediately.

e Delete Job This option deletes the saved job.

e Move Job: Use this option to move the job to another folder location.
e Copy Job: Use this option to duplicate the job.

Click Go.

Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the printer until
you enter your passcode at the printer control panel.

After a Secure Print job is printed, it is deleted automatically.

Printing using Secure Print

1.

In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

Select your printer, then open the print driver.

e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

For Job Type, select Secure Print.

Type the passcode, confirm the passcode, then click OK.

Select any other required printing options.

e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Secure Print job

1.

At the printer control panel, press the Home button.
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2. Touch Jobs.
3. To view Secure Print jobs, touch Secure Jobs.
4. Do one of the following:

e If you submitted a single Secure Print job, touch the folder, then touch the job. Enter the passcode number,
then touch OK. The job prints automatically.

e If you submitted multiple Secure Print jobs, touch the folder, enter the passcode number, then touch OK.
Select an option:

e To print a single Secure Print job, touch the job required.
e To print all the jobs in the folder, touch Print All.
e To delete a single Secure Print job, touch the Trash icon. At the prompt, touch Delete.

e To delete all the jobs in the folder, touch Delete All.
j’ Note: After a Secure Print job prints, the printer deletes it automatically.

5. Toreturn to the Home screen, press the Home button.

Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining copies. After
reviewing the sample set, you can either print the remaining copies or delete them at the printer control panel.

Sample Set is a type of saved job with these features:

e A Sample Set job appears in a folder named after the user ID associated with the print job.

e A Sample Set job does not use a passcode.

e Any user can print or delete a Sample Set job.

e A Sample Set prints one copy of a job to allow you to proofread the job before printing any remaining copies.
After a Sample Set job is printed, it is deleted automatically.

To print a Sample Set, refer to Printing using Sample Set.

Printing using Sample Set

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Sample Set.

4. Select any other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.
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Releasing a Sample Set
1. At the printer control panel, press the Home button.
2. To view available jobs, touch Jobs.

3. Touch the Sample Set job.

j’ Note: The Sample Set file description shows the job as Held for Future Printing, and shows the number of
remaining copies of the job.

4, Select an option.
e To print the remaining copies of the job, touch Release.
e To delete the remaining copies of the job, touch Delete.

5. To return to the Home screen, press the Home button.

MANAGING JOBS USING THE EMBEDDED WEB SERVER

In the Embedded Web Server Active Jobs list, you can view a list of active jobs and delete print jobs. You can use
the Embedded Web Server to submit jobs for printing at the device. You can use the Job Submission feature to print
.ps, .pdf, .pcl, and .xps files without installing a print driver. You can select jobs for printing from your local computer
hard drive, mass storage devices, or a network drive.

Saved jobs are documents sent to the printer and stored there for future use. Any saved jobs appear on the Saved
Jobs page. Use the Saved Jobs page to view, print, and delete saved jobs, and create and manage folders in which
they are stored.

To manage jobs using the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

2. Inthe Embedded Web Server, click Jobs.
3. Click the job name.
4. From the menu, select an option.
e To pause the print job, click Pause, then click Go.
e To delete the print job, click Delete, then click Go. At the prompt, click OK.

5. To return to the Home screen, click Home.

Submitting Jobs for Printing using the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

2. Inthe Embedded Web Server, click Home.

3. Click Print.

4. For File Name, click Browse or Choose File, then do one of the following steps.
¢ Navigate to the file, then select it.

e Type the path to the file that you want to select.
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5. Inthe Printing areq, for Copies, select Auto, or enter the number of copies to print.
6. For Job Type, select an option:
e Normal Print: This option prints a job immediately.
e Secure Print: This option prints a job after you enter your passcode at the printer control panel.

e Sample Set or Proof Print: These options print one copy of a multiple-copy print job. The device holds the
remaining copies in memory until you release them for printing at the control panel.

e Save Job for Reprint: This option saves a print job in a folder on the print server for future printing. You can
specify a job name and folder.

e Delay Print: This option prints a job at a specified time up to 24 hours from the original job submission.
7. As needed, for Paper Selection, select paper size, color, type, and tray.
8. As needed, select job options.

e 2-Sided Printing

e Collate

e Orientation

e Staple

e Folding

e Output Destination
j’ Note: The available options vary by device.

9. If Accounting is enabled, enter your User ID and Account ID.

10. Click Submit Job.

Reprinting Saved Jobs using the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

In the Embedded Web Server, click Home.
Click Jobs.
Click the Saved Jobs tab.

For the job that you want to process, select the check box.

S

From the menu, select an option.

e Print Job: This option prints a job immediately.

e Delete Job This option deletes the saved job.

e Move Job: Use this option to move the job to another folder location.
e Copy Job: Use this option to duplicate the job.

7. Click Go.
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Copy

COPY OVERVIEW

To make a copy, the device scans your original documents and temporarily stores the
images. It then prints the images based on the options that you selected. You can
change settings for individual jobs based on the original documents. You can save
settings that you use for regular jobs and retrieve them for later use.

For information about all the Copy App features and available settings, refer to Apps Features.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

If authentication or accounting is enabled on your device, to access features, enter your login details. For details
about Personalization for logged-in users, refer to Personalize.

Detecting Imaging Security Marks
Imaging Security uses infrared light to track and manage sensitive documents.

If the Infrared Security option is enabled in the Embedded Web Server, the device detects concealed security
marks applied by a Xerox® AltaLink® C81XX Series printer. This method of detection can prevent the accidental
disclosure of confidential documents.

The system administrator can configure infrared mark detection for copy jobs. When Detect Mark is enabled, the
device detects security marks on documents that are scanned. When an infrared mark is detected during scanning,
depending on the settings configured, the device inhibits the job, sends an email alert and continues the job, or
sends an email alert and inhibits the job. When a security mark is detected, the device adds an entry to the Audit
Log.

If a security mark is detected and the job is allowed to continue, a generic mark is applied to the job output to
indicate that the original documents contained a security mark. The generic mark includes a predefined label and
updated tracking information.

If a security mark is detected on your job, a message appears on the control panel to indicate the action taken. For
more information about Imaging Security, contact your system administrator, or refer to the System Administrator
Guide at www.xerox.com/office/ALB81XXdocs.

MAKING A COPY

To make a copy:
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1. Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in
the upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against
the original documents.

f Note:

e When the original documents are detected, the automatic document feeder confirmation indicator LED
illuminates.

o [f the Default Screen When Originals Are Detected feature is configured, when the original
documents are detected, the default app is launched automatically.

e If the Auto Start When Originals Are Detected feature is enabled, when the original documents are
detected, the job starts automatically and the countdown screen is displayed. To stop the countdown
and program the job manually, touch Cancel.

2. At the printer control panel, press the Home button.
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Touch Copy.
To clear previous app settings, touch Reset.

To enter the number of copies needed, use the numeric keypad.

o v &~ W

Adjust copy settings as needed.

e To scan more documents using the document glass, or to change settings for different sections of the job,
touch Build Job.

If you are scanning from 2-sided original documents, touch 2-Sided Copying, then select an option.

If finishing options are available, touch Finishing, then select an option.

j’ Note: If a finisher is installed and the Conditional Finisher Offset setting is enabled, when the finisher
operates at a lower speed than the device and no other finishing settings are selected, the offset function is
disabled. If other finishing settings are selected, the offset function operates normally. If the device and
finisher operate at the same speed, the Conditional Finisher Offset setting is ignored. For more
information about the Conditional Finisher Offset setting, refer to the System Administrator Guide at
www.xerox.com/office/ALB81XXdocs.

For details about available features, refer to Apps Features.
7. Touch Start. If you placed documents in the feeder, scanning continues until the feeder is empty.
8. If Build Job is enabled, touch Scan, then, when prompted, do these steps:

e To change settings, touch Program Next Segment.

e To scan another page, touch Scan Next Segment.

e To finish, touch Submit.

9. For logged-in users, if the Adaptive Learning feature is enabled for Personalization, a suggestion to create a 1-
Touch App can appear for repetitive or complex jobs. To create a personalized 1-Touch App, touch Create 1-
Touch App, then set up the app as required. To decline the suggestion, touch Cancel.

For more information about the Personalization feature and 1-Touch App creation, refer to Personalize.

10. To return to the Home screen, press the Home button.

COPY WORKFLOWS

Note: Some features are hidden from view when the Copy App is installed. For details on configuring and
customizing the Apps, refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

Erasing the Edges of Copies

You can erase content from the edges of your copies using the Edge Erase feature. You can specify the amount to
erase on the right, left, top, and bottom edges.

To erase the edges of copies:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Edge Erase.

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide 103


https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALB81XX&PgName=Man
https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALB81XX&PgName=Man

Xerox® Apps

4. Select one of the following options.

e All Edges: This option erases all four edges by the same amount. To adjust the amount to erase, move the
slider.

e Individual Edges: This option allows you to specify different amounts to erase from the edges. Touch the
required Top, Bottom, Left or Right field. To enter the amount to erase, use the numeric keypad, or touch
the arrows.

5. To mirror the same erase amount applied to Side 1 on Side 2, touch the Mirror Side 1 check box.
6. To select a pre-defined amount of erase, use the Presets option.

7. Touch OK.

Specifying the Size of the Original

Use the Original Size feature to set a standard or custom size for scanning, or for the printer to determine the
original size document automatically. You can use this feature to enable mixed-size original document scanning.

To specify the original size:

1. At the printer control panel, press the Home button.

2. Touch Copy.
3. Touch Original Size.
4, Select an option.
e Auto Detect: This option allows the printer to determine the size of the original document.
e Preset Scan Area: This option specifies the area to scan when it matches a standard paper size. In the
scrolling list, touch the desired paper size.
e Custom Scan Area: You can specify the width and length of the area to scan. To specify the original width
or length, touch the appropriate field. To enter the size, use the numeric keypad, or use the arrows.
+ Mixed Size Originals: You can scan standard-size originals of varying sizes. To determine which original
sizes can be mixed in the same job, use the diagram on the screen.
5. Touch OK.
Shifting the Image

You can change the placement of an image on the copy page. This is useful if the image is smaller than the page
size. For image shift to work correctly, position original documents as follows.

e Document Feeder: Position original documents face up, long edge entering the feeder first.

e Document Glass: Position original documents face down, in the upper-left corner of the document glass, long
edge to the left.

To change the placement of the image:

1. At the printer control panel, press the Home button.
2. Touch Copy.
3. Touch Image Shift.
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4. Select one of the following options.
e Off: This option is the default setting.
e Auto Center: This option centers the image on the page.

5. To enter a specific amount of image shift, touch More, then touch Margin Shift. Touch the required Up /
Down or Left / Right fields. To enter the amount of shift, use the numeric keypad, or touch the arrows.

6. To mirror the same image shift applied to Side 1 on Side 2, touch the Mirror Side 1 check box.
7. To select a pre-defined amount of shift, use the Presets option.

8. Touch OK.

Book Copying

You can use the Book Copying feature to copy books, magazines, or other bound documents. You can use this
feature to copy images for different results.

You can copy either the left or right page onto a single sheet of paper. You can copy both the left and right pages
onto two sheets of paper.

f Note: Use the document glass to make copies from books, magazines, or other bound documents. Do not
place bound originals in the document feeder.

To set up book copying:

1. At the printer control panel, press the Home button.
Touch Copy.

Touch Book Copying.

&= WN

Select one of the following options.
e Off: This option is the default setting.
e Both Pages: This option scans both pages of an open book onto two sheets of paper.

e Left/Right Page Only: This option scans the left or right page of an open book onto a single sheet of
paper.

5. If Binding Edge Erase is required, touch More. Touch the Binding Edge Erase field. To enter the amount to
erase, use the numeric keypad, or touch the arrows. You can erase up to 50 mm (2 in.) from both pages, or 25
mm (1 in.) from one page.

6. Touch OK.

Creating a Booklet

The Booklet Creation feature prints two pages on each side of the paper. The printer reorders and reorients the
pages so that they are in the correct order and orientation when folded. If more finishing options are available, the
pages can be stapled and folded to create a booklet.

To create a booklet:

f Note: In this mode, the printer scans all the original documents before it prints the copies.

1. At the printer control panel, press the Home button.
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2. Touch Copy.
3. Touch Booklet Creation.
4. Select one of the following options.
e Off: This option is the default setting.

e On: This option enables Booklet Creation.

f Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the required
paper tray, then touch OK.

5. To change the Original Input, Paper Supply or finishing options, touch More, then select an option.
e Toscan 1 or 2-sided originals, touch Original Input, then select an option.
e To change the paper source for the booklet, touch Paper Supply, then select an option.
e If your printer has a finisher installed, for Fold & Staple, select a staple or fold option.

6. Touch OK.

Adding Covers

You can print the first and last pages of your copy job on different paper, such as colored or heavyweight paper.
The printer selects the paper from a different tray. The covers can be blank or printed.

To add covers to your copy job:
1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Special Pages > Covers.

j’ Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the required
paper tray, then touch OK.

4. For Covers Options, select an option.
e Front & Back Same: This option includes front and back covers from the same tray.
e Front & Back Different: This option includes a front and a back cover from different trays.
e Front Only: This option includes a front cover only.
e Back Only: This option includes a back cover only.
5. For Printing Options, select an option.

e Blank Cover: This option inserts a blank cover.

Print on Side 1 Only: This option prints on the front side of the cover only. To rotate the image on side 2
by 180degrees, touch Rotate Side 2.

Print on Side 2 Only: This option prints on the back of the cover only. To rotate the image on side 2 by
180degrees, touch Rotate Side 2.

Print on Both Sides: This option prints on both sides of the cover.

Rotate Side 2: If covers are 2-Sided, touch this option to rotate the image on side 2 by 180 degrees.
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For Paper Supply, touch the required tray.
Touch OK. The options that you selected appear on the Special Pages screen.
To edit or delete a special page entry, touch the entry in the list. From the menu, touch the required option.

Touch OK.
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Adding Inserts

You can insert blank pages or pre-printed sheets in specific locations in your copy job. To do this, you specify the
tray that contains the inserts.

To add inserts to a copy job:
1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Special PagesInserts.

¥ Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the required
) y
paper tray, then touch OK.

4. To specify the number of sheets to insert, touch the Insert Quantity field. To enter the number of sheets, use
the numeric keypad, or use the arrows. Touch Enter.

5. To enter a location for the insert, touch the Insert After Page entry box. To enter a page number, use the
numeric keypad. Touch Enter.

6. To specify the paper tray to use for the insert:
a. Touch Paper Supply.
b. Touch the required paper tray.
c. Touch OK.
7. Touch Add. The insert appears in the list on the Inserts screen. To add more inserts, repeat the previous steps.
8. Touch X. The options that you selected appear on the Special Pages screen.
9. To edit or delete a special-page entry, touch the entry in the list. From the menu, touch the required option.

10. Touch OK.

Specifying Chapter Start Pagination

If you select 2-sided copies, you can set each chapter to start on the front or back of the page. If necessary, the
printer leaves one side of the paper blank so that the chapter starts on the specified side of the paper.

To specify chapter start pagination:

1. At the printer control panel, press the Home button.
Touch Copy.

Touch Special Pages > Chapter Starts.

&= WN

To specify the chapter start page, touch Page Number. To enter the page number, use the numeric keypad.
Touch Enter.
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5. For Start Chapter, select an option.

e On Right Page: This option specifies the front of the paper.

e On Left Page: This option specifies the back of the paper.

Touch Add. The page is added to the list on the right side of the screen.

To set other pages, repeat the previous steps.

Touch X. The options that you selected appear on the Special Pages screen.

To edit or delete a special-page entry, touch the entry in the list. From the menu, touch the required option.

© v ® N o

Touch OK.

Specifying Exception Pages

You can specify exception pages to print on paper that is loaded in a different paper tray than the paper for the
rest of the document. Ensure that the paper you use for the exception pages is the same size as the paper that you
use for the rest of the document.

To specify the exception pages:
1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Touch Special Pages > Exceptions.

j’ Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the required
paper tray, then touch OK.

4. To enter the range of pages to print on different paper:

e To enter the starting page number, touch the first Page Number field. To enter the starting page number,
use the numeric keypad. Touch Enter.

e To enter the ending page number, touch the second Page Number field. To enter the last page number,
use the numeric keypad. Touch Enter.

j’ Note: To specify a single page as an exception, enter that page number as the start and end of the range.

5. To specify the paper to use for the exception pages:

a. Touch Paper Supply.

b. Touch the tray that contains paper to use for the exception pages.

c. Touch OK.

Touch Add. The page range is added to the list on the right side of the screen.
To set other pages, repeat the previous steps.

Touch X. The options that you selected appear on the Special Pages screen.

To edit or delete a special-page entry, touch the entry in the list. From the menu, touch the required option.

© v ® N o

Touch OK.
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Adding Annotations

You can automatically add annotations such as page numbers and the date to your copies.

j’ Note:

You cannot add annotations to covers, inserts, or blank chapter-start pages.

If Booklet Creation is selected, you cannot add annotations.

To add annotations:

1. At the printer control panel, press the Home button.

& wWN

a.

b.

Touch Copy.
Touch Annotations.

To add page numbers:

Touch Page Number.
Touch On.

Touch the Starting Page Number entry box. To enter a page number, use the numeric keypad, then touch
Enter.

Touch Apply To, then select an option.
To position the page number, touch an arrow. The sample page shows the location of the page number.

Touch OK.

5. Toinsert a comment:

Touch Comment.

Touch On.

For Stored Comments, touch an option in the list.
e Touch an existing comment.

e To create a comment, touch an Available option. To enter the annotation text, use the touch screen
keypad, then touch OK.

e To edit or delete a comment, use the buttons below the Stored Comments list.
Touch Apply To, then select an option.
To position the comment, touch an arrow. The sample page shows the location of the comment.

Touch OK.

6. To insert the current date:

Touch the desired current date location.
Touch Date.
Touch On, then touch the date format that you wish to use.

Touch Apply To, then select an option.
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9.
10.

e. To position the date in the header or footer, touch an arrow. The sample page shows the location of the
date.

f.  Touch OK.

To insert a Bates Stamp:

a. Touch Bates Stamp.

b. Touch On.

c. For Stored Prefixes, touch an option in the list.
e Touch an existing prefix.
e To create a prefix, touch an Available option. To enter text, use the touch keypad, then touch OK.
e To edit or delete a prefix, use the buttons below the Stored Prefixes list.

d. Touch Starting Page Number. To enter the starting page number, use the alphanumeric keypad. You can
use leading zeros to indicate the number of digits required. Touch Enter.

e. Touch Apply To, then select an option.

f. To position the Bates Stamp in the header or footer, touch an arrow. The sample page shows the location
of the Bates Stamp.

g. Touch OK.
To change the text formatting, touch Format & Style, choose the required settings, then touch OK.
To remove all entered annotations, touch Delete All.

Touch OK.

Changing the Page Layout

You can use Page Layout to place a defined number of pages on one or both sides of the paper.

To change the page layout:

1.
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At the printer control panel, press the Home button.
Touch Copy.

Touch Page Layout.

Select one of the following options.

e Pages per Side: This option places a defined number of pages on one or both sides of the paper. Select
the required number of pages per side.

e Repeat Image: This option places a defined number of the same image on one or both sides of the paper.
Select the number of images required. Auto Repeat allows the printer to determine the maximum number
of images that can fit on the currently selected paper size.

To enter a specific number of rows and columns, touch Specify Rows & Columns. Touch the Rows or Columns
field. To enter the number of rows and columns, use the numeric keypad, or touch the arrows. To rotate the
paper, select the check box for Rotate Background.

To change the original orientation, touch Original Orientation. Select Portrait or Landscape.

Touch OK.
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Building a Copy Job

Use this feature to produce complex jobs that include a variety of originals requiring different App settings. Each
segment of the job can have different settings. After all the segments are programmed, scanned, and temporarily
stored in the printer, the job is processed and completed.

To build a job:

1. At the printer control panel, press the Home button.
Touch Copy.

To clear previous App settings, touch Reset.

Touch Build Job.

Split the job into the required segments for scanning.
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Program and scan the first segment:

a. Load the original document for the first segment.
b. Select the options required for the segment.

c.  Touch Scan.

7. Set the required build job display options.

8. Print a Sample segment or delete a segment.

a. To print a sample of the previous segment scanned, touch the segments option, then touch Sample Last
segment.

b. To delete the previous segment scanned, touch the segments option, then touch Delete Last Segment.

c. To delete all the previous segment scanned, touch the segments option, then touch Delete All Segments.
9. Program and scan more segments.

a. Load the originals for the next segment.

b. To change the settings for the next segment, touch Program Next Segment, then select the options
required for the segment.

c. Touch Scan Next Segment.
10. Continue scanning segments until all original documents are scanned.

11. Touch Submit.

Printing a Sample Job

Sample Job allows you to print a test copy of a job to inspect before printing multiple copies. This feature is useful
for complex or high-volume jobs. After you print and inspect the test copy, you can choose to print or cancel the
remaining copies.

To print a sample copy of your job:

1. At the printer control panel, press the Home button.
2. Touch Copy.

3. Adjust the copy settings as needed.
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Enter the number of copies needed.

Touch the Sample Job toggle button.

Touch the Start button. The sample job prints.

Inspect the sample job, then select one of the following options:

e If the copy is unsatisfactory, touch Delete. Touch Delete to confirm. The job is canceled and no more
copies are printed.

o If the copy is satisfactory, touch Print. The remaining copies are printed.

To return to the home screen, press the Home button.

Saving Current Copy Settings

To use a particular combination of copy settings for future copy jobs, you can save the settings with a name and
retrieve them for later use.

To save the current copy settings:

1.
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At the printer control panel, press the Home button.

Touch Copy.

Change the settings required.

Touch Save Current Settings.

To create a new saved setting, touch any option labeled <Available>.

Enter a name for the saved setting using the touch screen keyboard, then touch OK.

Retrieving Saved Copy Settings

You can retrieve and use any previously saved copy settings for current jobs.

j’ Note: To save the copy settings with a name, refer to Saving Current Copy Settings.

To retrieve saved settings:

1.
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5.
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At the printer control panel, press the Home button.
Touch Copy.
Touch Retrieve Saved Settings.

Touch the saved setting required.

j’ Note: To delete a saved setting, touch the setting, then touch Delete Settings. Touch Delete to confirm.

Touch OK. The saved settings are loaded for the current copy job.
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ID Card Copy

ID CARD COPY OVERVIEW

You can use the ID Card Copy App to copy both sides of an ID card or small document
onto one side of paper. To copy the card properly, place each side in the upper-left
corner of the document glass. The printer stores both sides of the document, then prints
them side by side on the paper.

The ID Card Copy App is hidden from view on initial device setup. For details about configuring and customizing the
Apps, refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

For information about all the ID Card Copy App features and available settings, refer to Apps Features.

If authentication or accounting is enabled on your device, to access features, enter your login details. For details
about Personalization for logged-in users, refer to Personalize.

COPYING AN ID CARD

To copy an ID card:

1.
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Lift the document feeder, then place the original document in the upper-left corner of the document glass.
At the printer control panel, press the Home button.

Touch ID Card Copy.

To clear previous App settings, touch Reset.

Adjust the settings as required.

Touch Scan Front.

When scanning is finished, lift the document feeder. Place the second side of the original document in the
upper-left corner of the document glass.

To scan the second side of the original document and print the copies, touch Scan Back.

To return to the home screen, press the Home button.
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Email

EMAIL OVERVIEW

You can use the Email App to scan images and attach them to emails. You can specify
the file name and format of the attachment, and include a subject heading and
message for the email.

For information about all the Email App features and available settings, refer to Apps Features.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

If authentication or accounting is enabled on your device, to access features, enter your login details. For details
about Personalization for logged-in users, refer to Personalize.

Detecting Imaging Security Marks
Imaging Security uses infrared light to track and manage sensitive documents.

If the Infrared Security option is enabled in the Embedded Web Server, the device detects concealed security
marks applied by a Xerox® AltalLink® C81XX Series printer. This method of detection can prevent the accidental
disclosure of confidential documents.

The system administrator can configure infrared mark detection for jobs. When Detect Mark is enabled, the device
detects security marks on documents that are scanned. When a security mark is detected during scanning,
depending on the settings configured, the device inhibits the job, sends an email alert and continues the job, or
sends an email alert and inhibits the job. When a security mark is detected, the device adds an entry to the Audit
Log.

If a security mark is detected and the job is allowed to continue, a generic mark is added to the scanned image file
to indicate that the original documents contained a security mark. The generic mark added to the file includes a
predefined label and updated tracking information.

If a security mark is detected on your job, a message appears on the control panel to indicate the action taken. For
more information about Imaging Security, contact your system administrator, or refer to the System Administrator
Guide at www xerox.com/office/ALB81XXdocs.

SENDING A SCANNED IMAGE IN AN EMAIL

To send a scanned image in an email:
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1. Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in
the upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove all staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against
the original documents.

f Note:

e When the original documents are detected, the automatic document feeder confirmation indicator LED
illuminates.

o [f the Default Screen When Originals Are Detected feature is configured, when the original
documents are detected, the default app is launched automatically.

e If the Auto Start When Originals Are Detected feature is enabled, when the original documents are
detected, the job starts automatically and the countdown screen is displayed. To stop the countdown
and program the job manually, touch Cancel.

2. At the printer control panel, press the Home button.
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11.
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Touch Email.

To clear previous app settings, touch Reset.

Enter recipients.

e If the entry screen appears, to enter a recipient, touch an option, or touch X.

e Toselect a contact or group from the Address Book, touch Device Address Book. Touch Favorites or
Contacts, then select a recipient. Touch OK.

e To select a contact from the Network Address Book, touch Network Address Book. Enter a name, touch
Search, then select a recipient. Touch OK.

e To enter the email address manually, touch Manual Entry. In the Enter Email Address field, enter the email
address, then touch Add.

e To add your own email address to the recipient list, touch Add Me. If necessary, enter your login details.

e To add more recipients, touch Add Recipient, then repeat the procedure.

j’ Note: The choices available for adding recipients depends on system configuration.

To organize the recipients, touch one of the recipient names on the list. From the menu, select To:, Cc:, or Bcc:.
Adjust the email settings as needed.
e To change the subject, touch Subject, enter a new subject, then touch OK.

e To save the scanned document as a specific file name, touch the attachment file name, enter a new name,
then touch OK.

e To save the scanned document as a specific file format, touch the attachment file format, then select the
required format. To create a searchable file or to add password protection, from the file format menu, select
More.

e To change the email message, touch Message, enter a new message, then touch OK.

e To scan more documents using the document glass, or to change settings for different sections of the job,
touch Build Job.

e If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
For details about available features, refer to Apps Features.

To start the scan, touch Send.

If Build Job is enabled, touch Scan, then, when prompted, do these steps.

e To change settings, touch Program Next Segment.

e To scan another page, touch Scan Next Segment.

e To finish, touch Submit.

For logged-in users, if the Adaptive Learning feature is enabled for Personalization, a suggestion to create a 1-
Touch App can appear for repetitive or complex jobs. To create a personalized 1-Touch App, touch Create 1-
Touch App, then set up the app as required. To decline the suggestion, touch Cancel.

For more information about the Personalization feature, and 1-Touch App creation, refer to Personalize.

To return to the Home screen, press the Home button.
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PREVIEWING JOBS

Use the Preview option to view and verify scanned images.

1.
2.
3.
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10.

11.

At the printer control panel, press the Home button.
To clear previous app settings, touch Reset.
Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in
the upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove all staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against
the original documents.

Touch the app required, then select the job settings.

To enable preview, touch Preview.

If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
To start scanning, touch Preview.

The original documents are scanned, then preview images appear on the device user interface.

Scroll through and verify the preview images.

e To change the size of the preview image thumbnails, in the bottom-left corner, touch the large or small
thumbnail view options.

e Tozoom in on an image, tap the image twice.
e To zoom out, tap the image twice.
To scan more original documents:
a. Load your original documents in the document feeder, or place a single document on the document glass.
b. Swipe to scroll to the end of the thumbnail images, then touch Scan More (+).
c. If you are using the document glass, touch the original document size, then touch OK.
The original documents are scanned and new preview images appear on the user interface.
d. Continue this procedure until you have scanned all the original documents.

To process the job and send the scanned images, touch Submit. To discard the job, touch X, then touch Delete
and Close.

To return to the Home screen, press the Home button.
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ADDING OR EDITING CONTACTS IN THE DEVICE ADDRESS BOOK FROM THE CONTROL PANEL

You can set up the Device Address Book using the Embedded Web Server. The Address Book can contain up to
5000 contacts that you can access when you enter recipients or destinations using apps.

To add or edit contacts in the Device Address Book from the control panel:

f Note: Before you can use this feature, the system administrator must enable Create/Edit Contact from Touch
Screen for All Users.

1. Load your original documents.

At the printer control panel, press the Home button.

Touch Email.

To clear previous App settings, touch Reset.

Touch Manual Entry. To enter an email address, use the touch screen keypad.

To add the recipient to the Device Address Book, touch the Address Book icon.
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Do one of the following steps.

e To create an entry, touch Create New Contact. To enter contact details, touch a field, then use the touch
screen keypad. Touch OK.

e To add to an existing entry, touch Add to Existing Contact. In the list, touch a contact. To find a contact,
touch Search.

8. To mark a recipient to appear as a favorite option, touch the Star icon.
9. Adjust the email settings as needed.
10. To start the scan, touch Send.

11.  To return to the Home screen, press the Home button.
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Workflow Scanning

WORKFLOW SCANNING OVERVIEW

The Workflow Scanning App allows you to scan an original document, distribute, and
archive the scanned image file. The Workflow Scanning feature simplifies the task of
scanning many multi-page documents and saving the scanned image files in one or
more file locations.

f Note: The system administrator must set up this feature before you can use it. For details, refer to the
System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

The Workflow Scanning App enables you to scan documents using pre-defined settings to a range of file
destinations quickly and easily. There are several workflow options:

e Distribution workflows enable you to scan documents to one or more file destinations. File destinations include
an FTP site, a website, and a network server. You can add fax destinations to workflows too.

e Scan to Mailbox enables you to scan documents to public or private mailbox folders on the printer hard drive.
e Scan to Home enables you to scan documents to a personal Home folder on your network.

e Scan to USB enables you to scan documents to a connected USB flash drive.

f Note:
e To scan original documents to a file destination associated with a contact in the address book, refer to
Scan To.

e To scan original documents to an email address, refer to Email.
For information about all the Workflow Scanning App features and available settings, refer to Apps Features.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

If authentication or accounting is enabled on your device, to access features, enter your login details. For details
about Personalization for logged-in users, refer to Personalize.

Detecting Imaging Security Marks
Imaging Security uses infrared light to track and manage sensitive documents.

If the Infrared Security option is enabled in the Embedded Web Server, the device detects concealed security
marks applied by a Xerox® AltaLink® C81XX Series printer. This method of detection can prevent the accidental
disclosure of confidential documents.

The system administrator can configure infrared mark detection for jobs. When Detect Mark is enabled, the device
detects security marks on documents that are scanned. When a security mark is detected during scanning,
depending on the settings configured, the device inhibits the job, sends an email alert and continues the job, or
sends an email alert and inhibits the job. When a security mark is detected, the device adds an entry to the Audit
Log.

If a security mark is detected and the job is allowed to continue, a generic mark is added to the scanned image file
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to indicate that the original documents contained a security mark. The generic mark added to the file includes a
predefined label and updated tracking information.

If a security mark is detected on your job, a message appears on the control panel to indicate the action taken. For
more information about Imaging Security, contact your system administrator, or refer to the System Administrator
Guide at www.xerox.com/office/ALB81XXdocs.

USING WORKFLOW SCANNING

To scan an original document:
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1. Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in
the upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against
the original documents.

f Note: When the original documents are detected, the automatic document feeder confirmation indicator
LED illuminates.

2. At the printer control panel, press the Home button.
3. Touch Workflow Scanning.

4, To clear previous app settings, touch Reset.

5

To select a workflow, from the Pick a Workflow screen, touch an option. If necessary, to refresh the workflow list,
touch Update.

f Note: If the Pick a Workflow screen does not appear automatically, to display the screen, touch Change
Workflow.
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6. If needed, enter recipients, workflow destination details, or browse to the location required for the scanned
documents.

7. To add a file destination, touch Add File Destinations. From the list, select a file destination.
f Note: You can add file destinations to a workflow from the predefined list of file repository settings.

e Inthe Embedded Web Server, to create a new workflow, you can add file destinations from the
predefined list.

e In the Workflow Scanning App, for a selected workflow, you can add more file destinations from the
predefined list.

For details, refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.
8. Adjust the workflow scanning settings as needed.

e To save the scanned document as a specific file name, touch the attachment file name, enter a new name,
then touch OK.

e To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

o To define what action the device takes when the filename is used already, touch If File Already Exists.
Select an option, then touch OK.

j’ Note: If the Add to pdf folder option is not available, access the Embedded Web Server, then enable the
Filing Option settings. For details, refer to the System Administrator Guide at www.xerox.com/office/
ALB81XXdocs.

If you are using the document glass, to combine pages into a single scan file, enable the Build Job feature.
To enable the feature, touch the toggle button for Build Job.

e If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
For details about available features, refer to Apps Features.
9. To start the scan, touch Scan.
10. If Build Job is enabled, when prompted, do these steps:
e To change settings, touch Program Next Segment.
e To scan another page, touch Scan Next Segment.
e To finish, touch Submit.

11. To return to the Home screen, press the Home button.
f Note:
e For remote scanning, a network connection is required.

o For details about remote scanning, refer to the Help in the Embedded Web Server.

e Print, copy, and fax jobs can print while you are scanning original documents or downloading files from
the printer hard drive.
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Distribution Workflows

Distribution Workflows are customized workflows used in the Workflow Scanning App. A workflow contains pre-
programmed settings for a scan job that specify how and where scanned documents are distributed. A workflow
can include one or more file destinations, as well as fax destinations. You can store customized scan settings in each
workflow.

Using the Embedded Web Server, you can create a workflow using one or more scan destinations. The following
options are available:

e Predefined scan destinations from the list of file repositories.
e New scan destinations such as an FTP site, a website, or an SMB server.
e Fax number destinations.

When you create a workflow, it appears in the list of workflows in the Pick a Workflow screen of the Workflow
Scanning App.

At the printer control panel, when you select a workflow, you can change the scan settings and add more scan
destinations from the predefined list.

Predefined Network File Repositories

A file repository is a predefined file destination that you can use in a workflow. You can use the printer control panel
to add a file repository to a workflow.

The system administrator configures the file repositories available as predefined scanned file destinations. At least
one repository must be set up for the Workflow Scanning feature to be available. For details, refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

f Note: On the Pick a Workflow screen, the DEFAULT workflow is associated with the default file repository.

Creating a New Workflow

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter
or Return.

f Note: For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your
Printer.

2. Click the Scan tab.
3. Inthe Display areq, select Workflows, then select Create New Workflow.
4. For Add Destination to Workflow, select an option:
e To add an existing file destination to the workflow, select Select from a Predefined List.
e To add a file destination to the workflow, select Enter a Scan Destination.
e To add a fax destination to the workflow, select Enter a Server Fax Number.
5. For Select from a Predefined List, select a destination from the File Destination list, then click Add.
6. For Enter a Scan Destination, add these details:

a. Click the Friendly Name field, then enter a name for the scan destination.
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b. For Protocol, select an option, then enter the destination address.

o For IP Address, enter the IP Address: Port number.

e For Host Name, enter the Host Name: Port number.
c. Enter the name of the destination folder as needed. In SMB, the destination folder is the shared folder.
d. In Document Path, enter the name of the subfolder within the destination folder. Select a Filing Policy.

e. Enter avalid login name and password.

j’ Note: Use the login name for the computer that holds the destination folder. The login name can include
the domain name, such as domain name\login name.

7. Click Add.
8. To add another destination to the workflow:
e To add a file destination, for File Destinations, click Add.
e To add a fax destination, for Fax Destinations, click Add.
9. Set the scan settings for the workflow as required.

After a workflow is created in the Embedded Web Server, the workflow is added to the list in the Workflow Scanning
App.

Scanning to a Shared Network Folder

You can scan to a shared folder on a network using SMB. The folder can be on a server or computer running SMB
services.

To scan to a shared network folder, create a shared folder with read and write access privileges.

Sharing a Folder on a Windows Computer

1. Open Windows Explorer.

Right-click the folder you want to share, then select Properties.

Click the Sharing tab, then click Advanced Sharing.

Select Share this folder.

Click Permissions.

Select the Everyone group, then verify that all permissions are enabled.

Click OK.
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f Note: Remember the Share name for later use.
8. Click OK again.
9. Click Close.

Sharing a Folder in Macintosh OS X Version 10.7 and Later
1. From the Apple menu, select System Preferences.

2. From the System Preferences window, select Sharing, then select File Sharing.
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3. Under Shared Folders, click the Plus icon ( +). Browse to the folder that you want to share on the network, then
click Add.

4. To modify access rights for your folder, select the folder. The groups activate.
5. From the Users list, click Everyone, then use the arrows to select Read & Write.
6. Click Options, then select a share-folder option.
e To share the folder, select Share files and folders using SMB.
e To share the folder with specific users, next to the user name, select On.
7. Click Done.

8. Close the System Preferences window.

j’ Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the folder and
‘ subfolders.

Scanning to a Mailbox Folder

Scanning to a folder is the simplest scanning method. This function allows users to scan files to mailboxes, which
are folders created on the printer hard drive. When you scan an image at the printer, the scan file is stored in a
folder on the internal hard drive. You can use the Embedded Web Server to retrieve the stored scan file to save to
your computer.

The default settings create a 1-sided, color, portable document format .pdf file. You can change the default settings
using the printer control panel, or using the Embedded Web Server at your computer. Control panel selections
override the settings in the Embedded Web Server.

Scanning to the Public Mailbox Folder

The printer provides a public mailbox folder to store scanned images. You do not need a password to scan images
to the public mailbox folder, or to retrieve the scanned images. All users can view scanned documents in the public
mailbox folder. You can create a password-protected private mailbox folder. For details, refer to Creating a Private
Mailbox Folder.

To scan an image to the public mailbox folder:
1. Load your original documents.
2. At the printer control panel, press the Home button.
3. Touch Workflow Scanning.
4. To select a workflow, from the Pick a Workflow screen, touch Default Public Mailbox.
f Note: If the Pick a Workflow screen is not automatically displayed, to display it, touch Change Workflow.

5. To add a file destination, touch Add File Destinations, then select a file destination from the list.
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6. Adjust the workflow scanning settings as needed.

e To save the scanned document as a specific file name, touch the attachment file name, enter a new name,
then touch OK.

e To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

e If you are using the document glass, to combine pages into a single scan file, enable Build Job.
e If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
For details about available features, refer to Apps Features.

7. To start the scan, touch Scan. The Job Progress screen appears, and the original document is scanned. The
printer stores the scanned image on the printer hard drive.

8. If Build Job is enabled, when prompted, do these steps.
e To change settings, touch Program Next Segment.
e To scan another page, touch Scan Next Segment.
e To finish, touch Submit.

9. To move the file to your computer, use the Embedded Web Server. For details, refer to Retrieving Scan Files
from a Mailbox Folder.

Scanning to a Private Mailbox Folder

This feature allows you to scan documents to a private mailbox folder. Private mailbox folders can require a
password.

You can use the Embedded Web Server to create your private mailbox folders. For details, refer to Creating a Private
Mailbox Folder.

To scan to a private mailbox folder:

1. Load your original documents.
At the printer control panel, press the Home button.

Touch Workflow Scanning.

&ow N

To select a workflow, from the Pick a Workflow screen, select a private mailbox folder.
j’ Note: If the Pick a Workflow screen is not automatically displayed, to display it, touch Change Workflow.

5. On the Mailbox Password screen, enter the password, then touch OK.

6. To add a file destination, touch Add File Destinations, then select a file destination from the list.
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7. Adjust the workflow scanning settings as needed.

e To save the scanned document as a specific file name, touch the attachment file name, enter a new name,
then touch OK.

e To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

e If you are using the document glass, to combine pages into a single scan file, enable Build Job.
e If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
For details about available features, refer to Apps Features.
8. To start the scan, touch Scan.
9. If Build Job is enabled, when prompted, do these steps:
e To change settings, touch Program Next Segment.
e To scan another page, touch Scan Next Segment.
e To finish, touch Submit.

10. To move the file to your computer, use the Embedded Web Server. For details, refer to Retrieving Scan Files
from a Mailbox Folder.

Creating a Private Mailbox Folder

If the scan policy to allow additional folders is enabled, you can create a private mailbox folder. The system
administrator can create a private mailbox folder at any time. For details, refer to the System Administrator Guide at
www.xerox.com/office/ALB81XXdocs.

To create a private mailbox folder with a password:

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter
or Return.

f Note: For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your
Printer.

2. Click the Scan tab.

3. Inthe Display section, select Mailboxes.

f Note: If the Display section does not appear, Scan to Mailbox is not enabled. For details, refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

In the Scan to Mailbox section, click Create Folder.
Click the Folder Name: field, then type a name for the folder.
In the Folder Password field, type a password that adheres to the password rules.

In the Confirm Folder Password field, type the password again.
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Click Apply.

Your private mailbox folder appears in the mailbox folder list in the Embedded Web Server and on the printer touch
screen under Pick a Workflow. The contents are stored on the printer hard drive.
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Retrieving Scan Files from a Mailbox Folder

You can use the Embedded Web Server to retrieve scan files from a mailbox folder and copy the files to your
computer.

To retrieve your scan files:

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter
or Return.

f Note: For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your
Printer.

2. Click the Scan tab.
3. Inthe Display section, select Mailboxes.

4. In the Scan to Mailbox section, click the folder containing the scan.

¢ Note:
e Fora password protected private folder, click the Folder Password field, type the password, then click
OK.

e If your image file does not appear, click Update View.
Your scan file appears in the Folder Contents window.
5. Under Action, select an option, then click Go.

e Download saves a copy of the file to your computer. When prompted, click Save, then navigate to the
location on your computer to save the file. Open the file or close the dialog box.

e Reprint prints the file without saving a copy of the file to your computer.

e Delete removes the file from the mailbox. When prompted, click OK to delete the file or Cancel to cancel
the operation.

f Note: You can also print a mailbox file using the Print From App. For details, refer to Print From.

Scanning to a User Home Folder

Scan to Home allows you to scan documents to a home directory on an external server. The home directory is
distinct for each authenticated user. The directory path is established through LDAP.

The Scan to Home feature is available as the Home workflow in the Workflow Scanning App.
To enable the Home workflow:
e Ensure that LDAP Network Authentication is configured.

e Ensure that Home folder locations are defined for each user in the LDAP directory.

j’ Note: When a user logs in to the printer using network credentials, the Home workflow appears on the Pick a
Workflow screen.

To use the Home workflow:

1. Load your original documents.
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To log in to the printer, touch Log In, then log in with your network credentials.
At the printer control panel, press the Home button.
Touch Workflow Scanning.

From the Pick a Workflow screen, touch the Home workflow.

f Note:

o If the Pick a Workflow screen is not automatically displayed, to display it, touch Change Workflow.

o If the Home workflow is not displayed, check that you have logged in with the required credentials.

6. To add a file destination, touch Add File Destinations, then select a file destination from the list.

7. Adjust the workflow scanning settings as needed.

To save the scanned document as a specific file name, touch the attachment file name, enter a new name,
then touch OK.

To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

If you are using the document glass, to combine pages into a single scan file, enable Build Job.

If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.

For details about available features, refer to Apps Features.

8. To start the scan, touch Scan.

9. If Build Job is enabled, when prompted, do these steps.

To change settings, touch Program Next Segment.
To scan another page, touch Scan Next Segment.

To finish, touch Submit.

10. To return to the Home screen, press the Home button.

Scanning to a USB Flash Drive

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function produces scans
in .jpg, .pdf, .pdf (a), .xps, and _tif file formats.

The Scan to USB feature is available as the USB workflow in the Workflow Scanning App.

j’ Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To scan to a USB Flash drive:

1. Load your original documents.

2. At the printer control panel, press the Home button.

3. Insert the USB Flash drive into the USB memory port.
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4. At the USB Drive Detected screen, touch Scan to USB.

f Note: If the USB Flash drive is inserted in the printer already, touch Workflow Scanning. Touch Change

Workflow, then touch USB.

5. To add afile destination, touch Add File Destinations, then select a file destination from the list.

6. Adjust the workflow scanning settings as needed.

To save the scanned document as a specific file name, touch the attachment file name, enter a new name,
then touch OK.

To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

If you are using the document glass, to combine pages into a single scan file, enable Build Job.

If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.

For details about available features, refer to Apps Features.

7. To start the scan, touch Scan.

8. If Build Job is enabled, when prompted, do these steps.

To change settings, touch Program Next Segment.
To scan another page, touch Scan Next Segment.

To finish, touch Submit.

A Warning: Do not remove the USB Flash drive while the printer is processing the scan job. If you remove

the Flash drive before the transfer is complete, the file can become unusable and other files on the drive
can be damaged.

9. To return to the Home screen, press the Home button.

Single-Touch Apps

A Single-Touch App enables you to use a workflow without having to use the Workflow Scanning App. Single-Touch
Apps are displayed on the Home screen, and used with a single touch.

You can use the Embedded Web Server to design the app, associate it with a workflow, and assign user rights. For
details about creating Single-Touch Apps for workflow scanning destinations, refer to the System Administrator
Guide at www.xerox.com/office/ALB81XXdocs.
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Scan To

SCAN TO OVERVIEW

You can use the Scan To App to scan documents to multiple destinations and recipients
in a single scan. A Scan To destination can be an email address, a USB flash drive, an
SMB network location, or another remote destination. A Scan To recipient can be a
contact in the device address book or network address book, an email address, or the
logged-in user.

The Scan To App supports the following scanning functions:
e Scan original documents to an email address. For details, refer to Scanning to an Email Address.
e Scan original documents to a USB flash drive. For details, refer to Scanning to a USB Flash Drive.

e Scan original documents to the email address associated with the logged-in user. For details, refer to Scanning
to the Logged-In User.

o Scan original documents to remote destinations. For details, refer to Scanning to Remote Destinations.
To scan documents to one or more file destinations using customized workflows, refer to Workflow Scanning.
For information about all the Scan To App features and available settings, refer to Apps Features.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

If authentication or accounting is enabled on your device, to access features, enter your login details. For details
about Personalization for logged-in users, refer to Personalize.

Detecting Imaging Security Marks
Imaging Security uses infrared light to track and manage sensitive documents.

If the Infrared Security option is enabled in the Embedded Web Server, the device detects concealed security
marks applied by a Xerox® AltalLink® C81XX Series printer. This method of detection can prevent the accidental
disclosure of confidential documents.

The system administrator can configure infrared mark detection for jobs. When Detect Mark is enabled, the device
detects security marks on documents that are scanned. When a security mark is detected during scanning,
depending on the settings configured, the device inhibits the job, sends an email alert and continues the job, or
sends an email alert and inhibits the job. When a security mark is detected, the device adds an entry to the Audit
Log.

If a security mark is detected and the job is allowed to continue, a generic mark is added to the scanned image file
to indicate that the original documents contained a security mark. The generic mark added to the file includes a
predefined label and updated tracking information.

If a security mark is detected on your job, a message appears on the control panel to indicate the action taken. For
more information about Imaging Security, contact your system administrator, or refer to the System Administrator
Guide at www.xerox.com/office/ALB81XXdocs.
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SCANNING TO AN EMAIL ADDRESS

You can scan a document and send the scanned file to an email address. The Scan To App produces scans in .jpg, .
pdf, .pdf (a), .xps, and .tif file formats.

Before you scan to an email address, ensure that you configure the printer with the email server information. For
details, refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

To scan an image and send it to an email address:
1. Load the original document on the document glass or into the automatic document feeder.

f Note:
e When the original documents are detected, the automatic document feeder confirmation indicator LED
illuminates.

o If the Default Screen When Originals Are Detected feature is configured, when the original
documents are detected, the default app is launched automatically.

o If the Auto Start When Originals Are Detected feature is enabled, when the original documents are
detected, the job starts automatically and the countdown screen is displayed. To stop the countdown
and program the job manually, touch Cancel.

At the control panel, touch Home.
Touch Scan To.

If the Scan To destination window does not appear, touch Add Destination.

v W N

Add recipients.
e To enter the email address manually, touch Email. Enter an email address, then touch Add.

e Toselect a contact or group from the Device Address Book, touch Device Address Book. Touch Favorites
or Contacts, then select a recipient.

e To select a contact or group from the Network Address Book, touch Network Address Book. In the search
bar, type the name of the contact or group that you want to add, then touch Search. From the list of
results, select a recipient.

f Note: For details about using the Address Book and managing and creating Favorites, refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

6. To add another Scan To destination, touch Add Destination, then select the required destination.

7. To save the scanned document as a specific filename, touch the attachment filename, then enter a new name
using the touch screen keypad. Touch Enter.

8. To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

j’ Note: To make scanned documents searchable, your system administrator can enable the Searchable
‘ feature.
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Adjust scanning options as needed.

e To change the email subject line, touch Subject. Enter a new subject line using the touch screen keypad,
then touch Enter.

e To change the email body message, touch Message. Enter a new message, then touch OK.

e To scan multiple pages using the document glass, or to change settings for different sections of the job,
touch Build Job.

To begin the scan, touch Scan.

If Build Job is enabled, when prompted, do these steps.

e To change settings for the next segment of the document, touch Program Segment.

e To scan another page, load the new document onto the document glass, then touch Scan Segment.
e To finish, touch Submit.

For logged-in users, if the Adaptive Learning feature is enabled for Personalization, a suggestion to create a 1-
Touch App can appear for repetitive or complex jobs. To create a personalized 1-Touch App, touch Create 1-
Touch App, then set up the app as required. To decline the suggestion, touch Cancel.

For more information about the Personalization feature, and 1-Touch App creation, refer to Personalize.

To return to the Home screen, press the Home button.

SCANNING TO A USB FLASH DRIVE

You can scan a document and store the scanned file on a USB Flash drive. The Scan To App produces scans in .jpg, -
pdf, .pdf (a), .xps, and .tif file formats.

j’ Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To scan to a USB Flash drive:
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Load the original document on the document glass or in the automatic document feeder.
At the printer control panel, press the Home button.

Touch Scan To.

If the Scan To destination window does not appear, touch Add Destination.

Insert your USB Flash drive into the USB port on the front of the printer, then touch USB.

j’ Note: If you select USB as the Scan To destination before inserting a USB Flash drive, you will be prompted

to insert it.
To add another Scan To destination, touch Add Destination, then select the required destination.

To save the scanned document as a specific file name, touch the attachment file name, then enter a new name
using the touch screen keypad. Touch Enter.

To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

Adjust scanning features as needed.

To scan multiple pages using the document glass, or to change settings for different sections of the job, touch
Build Job.
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11.  To begin the scan, press Scan.
12. If Build Job is enabled, when prompted, do these steps.
e To change settings for the next segment of the document, touch Program Segment.
e To scan another page, load the new page onto the document glass, then touch Scan Segment.
e To finish, touch Submit.
The printer scans your images to the root folder of the USB Flash drive.

13. If you are scanning from the document glass, when prompted, to finish, touch Done or to scan another page,
touch Add Page.

j’ Note: If you are scanning a document from the automatic document feeder, a prompt does not appear.

(D Caution: Do not remove the USB Flash drive while the device is scanning and processing the job. If you
remove the Flash drive before the transfer is complete, the file can become unusable and other files on
the drive can be damaged.

14. To return to the Home screen, press the Home button.

SCANNING TO THE LOGGED-IN USER

You can use the Add Me function to scan a document and send the scanned file to the email address associated
with a logged-in user.

j’ Note: Only users authenticated through an LDAP server can have an associated email address.

Before scanning to a logged in user, ensure that LDAP user authentication is configured. For details, refer to the
System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

The Scan To App produces scans in .jpg, .pdf, .pdf (a), .xps, and tif file formats.

To scan an image and send it to the email address of the logged-in user:

1. Load the original document on the document glass or into the automatic document feeder.
At the control panel, touch Home.

Touch Scan To.

If the Scan To destination window does not appear, touch Add Destination.

Touch Add Me.
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If you are not logged in, a login screen appears. Enter your LDAP network user name and password, then touch
Done.

7. To add another Scan To destination, touch Add Destination, then select the required destination.

8. To save the scanned document as a specific file name, touch the attachment file name, then enter a new name
using the touch screen keypad. Touch Enter.
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9. To save the scanned document as a specific file format, touch the attachment file format, then select the
required format.

j’ Note: To make scanned documents searchable, your system administrator can enable the Searchable
‘ feature.

10. Adjust scanning options as needed.

11. To scan multiple pages using the document glass, or to change settings for different sections of the job, touch
Build Job.

12. To begin the scan, touch Scan.

13. If Build Jobis enabled, when prompted, do these steps.
e To change settings for the next segment of the document, touch Program Segment.
e To scan another page, load the new document onto the document glass, then touch Scan Segment.
e To finish, touch Submit.

14. To return to the Home screen, press the Home button.

SCANNING TO REMOTE DESTINATIONS

You can scan to the following remote destinations:

e Cloud Services: Dropbox, Google Drive, and Microsoft OneDrive
e FTPand SFTP

e SMB

The Scan To Cloud service is a licensed feature. Access to the service requires a feature installation key. To enable
this option, on the Feature Installation page, provide a Scan to Cloud Licensing feature installation key. To purchase
a Scan to Cloud Licensing feature installation key for your device, contact your Xerox representative.

For more information on configuring the Scan To Remote Destination feature, refer to the System Administrator
Guide.

Scanning to Cloud Services

Before you scan to a cloud destination, ensure that you configure the printer with the cloud service information. For
details, refer to the System Administrator Guide. To scan a document and send it to a cloud service, do the
following:

1. Load the original document on the document glass or into the duplex automatic document feeder.

At the control panel, press the Home button.

Touch Scan To.

Touch Dropbox, Google Drive, or Microsoft Onedrive.

If prompted, type a valid user name and password in the login window of the cloud provider, then touch Enter.

Select a folder location for your scanned document, then touch OK.
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To save the scanned document as a specific file name, touch the file name. Enter a new name using the touch
screen keypad, then touch Enter.
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8. To save the scanned document as a specific file format, touch the file format, then select the required format.
Adjust scanning options as needed.

9. To begin the scan, touch Scan.

The printer scans documents to the folder that you specified.

Scanning to FTP or SFTP Server

Before you scan to an FTP or SFTP server, ensure that you configure the printer with the server information. For
details, refer to the System Administrator Guide. To scan a document and send it to an FTP or SFTP server, do the
following:

1. Load the original document on the document glass or into the duplex automatic document feeder.
At the control panel, press the Home button.

Touch Scan To.

Touch FTPor SFTP, then enter the server address.

If prompted, enter a valid user name and password, then touch Enter.

Select a folder location for your scanned document, then touch OK.

N o v & W N

To save the scanned document as a specific file name, touch the file name. Enter a new name using the touch
screen keypad, then touch Enter.

8. To save the scanned document as a specific file format, touch the file format, then select the required format.
Adjust scanning options as needed.

9. To begin the scan, touch Scan.
The printer scans documents to the folder that you specified.

10. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan another page,
touch Add Page.

j’ Note: If you are scanning a document from the automatic document feeder, a prompt does not appear.

11.  To return to the Home screen, press the Home button.

Scanning to a Shared Folder on a Networked Computer

You can scan a document and save the scanned file to a folder on a networked computer. The Scan To App
produces scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats.

j’ Note: To scan to a user home folder, use the Workflow Scanning App. For details, refer to Adding a Scan To
Destination to an Address Book Entry.

Before You Begin
Before scanning to a folder on a networked computer, perform these steps:

e Create a shared folder on your computer:

136 Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide



Xerox® Apps

—  For Windows, refer to Sharing a Folder on a Windows Computer.
—  For Macintosh, refer to Sharing a Folder in Macintosh OS X Version 10.7 and Later.

e Configure an SMB Folder. For details, refer to the System Administrator Guide, at www.xerox.com/office/
ALB81XXdocs.

e Use the Embedded Web Server to associate a Scan To destination with a Device Address Book contact. For
details, refer to Adding a Scan To Destination to an Address Book Entry.

j’ Note: Ensure that the Address Book contains at least one contact with a scan-to destination.

Scanning to a Shared Folder on a Networked Computer
1. Load the original document on the document glass or into the automatic document feeder.
At the printer control panel, press the Home button.

Touch Scan To.
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To specify the destination of the scanned document, select one of the following options.

e To scan to an SMB folder on a networked computer, touch Network. Browse to the required folder, or enter
the network path name, then touch OK.

j’ Note: For information on configuring SMB folders, refer to the System Administrator Guide at www.xerox.
com/office/ALB81XXdocs.

e To scan to a folder associated with a contact in the address book, touch Device Address Book. Select the
required contact, then touch the Scan To location.

j’ Note: For details on how to associate a networked folder with an address book contact, refer to Adding a
Scan To Destination to an Address Book Entry.

5. To add another Scan To destination, touch Add Destination, then select the required destination.

6. To save the scanned document as a specific filename, touch the filename. Enter a new name using the touch
screen keypad, then touch Enter.

7. To save the scanned document as a specific file format, touch the file format, then select the required format.
8. Adjust scanning options as needed.

9. To scan multiple pages using the document glass, or to change settings for different sections of the job, touch
Build Job.

10. To begin the scan, press Scan.

11.  If Build Jobis enabled, when prompted, do these steps.
e To change settings for the next segment of the document, touch Program Segment.
e To scan another page, load the new document onto the document glass, then touch Scan Segment.
e To finish, touch Submit.

12. To return to the Home screen, press the Home button.

PREVIEWING JOBS

Use the Preview option to view and verify scanned images.
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10.

11.

At the printer control panel, press the Home button.

To clear previous app settings, touch Reset.

Load your original documents.

For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in
the upper-left corner of the document glass.

For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove all staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against
the original documents.

Touch the app required, then select the job settings.

To enable preview, touch Preview.

If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.

To start scanning, touch Preview.

The original documents are scanned, then preview images appear on the device user interface.

Scroll through and verify the preview images.

To change the size of the preview image thumbnails, in the bottom-left corner, touch the large or small
thumbnail view options.

To zoom in on an image, tap the image twice.

To zoom out, tap the image twice.

To scan more original documents:

d.

Load your original documents in the document feeder, or place a single document on the document glass.
Swipe to scroll to the end of the thumbnail images, then touch Scan More (+).

If you are using the document glass, touch the original document size, then touch OK.

The original documents are scanned and new preview images appear on the user interface.

Continue this procedure until you have scanned all the original documents.

To process the job and send the scanned images, touch Submit. To discard the job, touch X, then touch Delete
and Close.

To return to the Home screen, press the Home button.

ADDING A SCAN TO DESTINATION TO AN ADDRESS BOOK ENTRY

You can create Address Book contacts using the Embedded Web Server. A contact is a user with an associated email
address, fax number, or scan to destination. If a contact has been set up to include a scan to destination, the
contact is available for selection in the Scan To App. Contacts can be marked as a Favorite.

To create an address book contact and add a scan to destination:

138

Xerox® Altalink® B8145/B8155/B8170 Series Multifunction Printer User Guide



Xerox® Apps

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

fo Note: For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your
Printer.

2. Click Address Book.
3. To add or edit a contact in the address book:
e To add a contact, click Add, then enter the contact information.

e To edit a contact, select the contact, then click Edit.

f Note: If the Add button is unavailable, the address book has reached its limit. The Device Address Book can
contain up to 5000 contacts.

4. To associate a scan destination with this contact, for Scan To Destination, click the Add Destination ( +)
button. Enter the nickname that you want to appear in the Address Book.

5. Under Protocol, select an option, then enter the destination address:
e For FTP, SFTP, or SMB:
e For IP Address, enter the IP Address: Port number.
e For Host Name, enter the Host Name: Port number.
e For Netware, enter the Server Name, Server Volume, NDS Tree, and NDS Context.

6. For SMB, in the Share field, enter the name of the destination folder. For example, to save scanned files to a
shared folder named scans, type scans.

7. In Document Path, enter the name of the subfolder within the destination folder. For example, to save the
scanned files to a folder named colorscans inside the scans folder, type colorscans.

8. Enter avalid login name and password.

j’ Note: Use the login name for the computer that holds the destination folder. For SMB, the login name is
your computer user name.

9. To confirm the validity of the destination details, click Destination Test.

10. Click Save, or select Add Another Contact After Saving, then click Save.

j’ Note: To mark a contact as a Favorite for email, fax, or scan to destination, for the appropriate field, click the
Staricon. If you click the Star icon for Display Name, the contact becomes a Global Favorite.
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Fax

FAX OVERVIEW

When you send a fax from the printer control panel, the document is scanned and
transmitted to a fax machine, using a dedicated telephone line. You can use the Fax App
to fax documents to a fax number, an individual contact, or to a group of contacts.

You can use the Fax App to do the following tasks:

e Delay the send of your fax job for up to 24 hours.
e Send a fax from your computer.

e Forward fax documents to an email address.

e Print a fax from a secure folder.

The fax function works best with an analog phone line. Voice-Over-Internet Protocols (VOIPs) such as Fiber Optic
Service (FIOS) and Digital Subscriber Line (DSL) are not supported. Before you use the Fax App, configure the Fax
Settings to ensure that they are compatible with your local connection and regulations. The Fax Settings include
optional features you can use to configure the printer for faxing.

f Note: Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

For information about all the Fax App features and available settings, refer to Apps Features.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

If authentication or accounting is enabled on your device, to access features, enter your login details. For details
about Personalization for logged-in users, refer to Personalize.

SENDING A FAX

To send a fax:
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1. Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in
the upper-left corner of the document glass.

e For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against
the original documents.

f Note:

e When the original documents are detected, the automatic document feeder confirmation indicator LED
illuminates.

o [f the Default Screen When Originals Are Detected feature is configured, when the original
documents are detected, the default app is launched automatically.

e If the Auto Start When Originals Are Detected feature is enabled, when the original documents are
detected, the job starts automatically and the countdown screen is displayed. To stop the countdown
and program the job manually, touch Cancel.

2. At the printer control panel, press the Home button.
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3. Touch Fax.
4, To clear previous app settings, touch Reset.
5. Enter recipients:
e If the entry screen appears, to enter a recipient, touch an option, or touch X.

e Toselect a contact or group from the Device Address Book, touch Device Address Book. Touch Favorites
or Contacts, then select a recipient.

e To enter the fax number manually, touch Manual Entry. In the Enter Fax Number field, enter the fax
number, then touch Add.

e To add more recipients, touch Add Recipient, then repeat the procedure.

j’ Note: To insert a pause as needed, touch Dial Pause. To enter longer pauses, touch Dial Pause multiple
times.

6. Adjust the fax settings as needed.

e To scan more documents using the document glass, or to change settings for different sections of the job,
touch Build Job.

e If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
For details about available features, refer to Apps Features.
7. Touch Send.
8. If Build Job is enabled, touch Scan, then, when prompted, do these steps:
e To change settings, touch Program Next Segment.
e To scan another page, touch Scan Next Segment.
e To finish, touch Submit.

9. To return to the Home screen, press the Home button.
FAX WORKFLOWS

Sending a Delayed Fax

You can set a time in the future for the printer to send your fax job. You can delay the send of your fax job for up to
24 hours.

f Note: Before you use this feature, ensure that the printer is set to the current time. For details, refer to the
System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

To specify the time to send your fax:
1. Load your original documents.
At the printer control panel, press the Home button, then touch Fax.

Add fax recipients, then adjust fax settings as needed. For details, refer to Sending a Fax.

& W N

Touch Delay Send.
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5. Touch Delay send, then set the time to send the fax.
e To set the hour, touch the Hour field, then use the numeric keypad, or touch the arrows.
e To set the minutes, touch the Minute field, then use the numeric keypad, or touch the arrows.
e If your printer is set to display the 12-hour clock, touch AM or PM.

6. Touch OK.

7. Touch Send. The fax is scanned and saved, then sent at the specified time.

Adding a Cover Sheet

You can use the Cover Sheet option to add an introduction page to the beginning of your fax. You can add a short
comment to the cover sheet, as well as To and From details.

To include a cover sheet:

1. Load your original documents.

2. At the printer control panel, press the Home button, then touch Fax.
3. Add fax recipients, then adjust fax settings as needed. For details, refer to Sending a Fax.
4. Touch Cover Sheet > On.
5. To enter the name of the recipient, touch the To field, then use the touch screen keyboard. Touch OK.
6. To enter the name of the sender, touch the From field, then use the touch screen keyboard. Touch OK.
7. To add a comment, do one of the following steps.
e Touch an existing comment.
e Touch an <Available> comment, then touch the Edit icon. To type text, use the touch screen keypad. Touch
OK.
f Note:
e To delete an existing comment, touch the comment, then touch X. To confirm the action, touch Delete.
e To edit an existing comment, touch the comment, then touch the Edit icon. To change the comment,
use the touch screen keypad. Touch OK.
8. Touch OK.

Printing a Secure Fax

When the Fax Secure Receive option is enabled, all faxes that the device receives are held in the Job list until you
enter a passcode. After you enter the passcode, the faxes are released and printed.

j’ Note: Before you can receive a Secure Fax, ensure that the Secure Fax Receive feature is enabled. For details,
refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

To print a secure fax:
1. At the printer control panel, press the Home button.

2. Touch Jobs, then from the list, touch the secure fax job required.
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Touch Print, then enter the passcode.
Touch Release All Fax Jobs.
All secure faxes print.

To return to the Home screen, press the Home button.

Deleting a Secure Fax

To delete a secure fax:

1.
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At the printer control panel, press the Home button.

Touch Jobs, then from the list, touch the secure fax job required.
Touch Delete, then enter the passcode.

Touch OK.

To return to the Home screen, press the Home button.

Polling a Remote Fax Machine

Fax Polling allows you to store a fax document on the printer and make it available for other fax machines to poll.
You can also retrieve faxes stored on other fax machines. To use this feature, both the polling printer and the
remote printer must have the Fax Polling feature.

Storing a Fax for Polling

You can store faxes for polling as Non-Secure or Secure. When you select Secure Storage, you create a list of remote
device fax numbers that are allowed to access secure faxes.

Storing a Fax for Non-Secure Polling

1.
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Load your original documents.

At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.
Touch Store Polling Files.

Touch Non-Secure Storage, then touch OK. To confirm, touch Update Setting.

Touch Send. The original documents are scanned and stored for non-secure polling.

Storing a Fax for Secure Polling

1.
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Load your original documents.

At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.

Touch Store Polling Files.

Touch Secure Storage.

Touch Enter a Fax Number. To enter the fax number for the remote device, use the keypad. Touch OK.

Touch the + button. The fax number is added to the access list.
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8. Continue to enter fax numbers for all remote devices that require access to the secure documents.

9. Touch OK. To confirm, touch Update Setting.

10. Touch Send. The original documents are scanned and stored for secure polling.

Deleting Documents Stored for Polling

1.
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At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.
Touch Store Polling Files.

Touch Empty Fax Polling. To confirm, touch Empty Fax Polling again.

Touch OK.

Printing Faxes Stored for Polling

To print faxes stored for polling:

1.
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6.

At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.
Touch Print From Polling Device.

To print faxes that are stored for polling on the local device:

a. Touch Local Fax Polling.

b. Touch Print.

Xerox® Apps

c. To delete stored faxes after they print, touch Empty Fax Polling. To confirm, touch Empty Fax Mailbox.

The local faxes that are stored for polling print.
To print faxes that are stored for polling on a remote device:

a. Touch Remote Fax Polling.

b. Touch Enter Fax Number. To enter the fax number of the remote device, use the keypad. Touch OK.

c. To add a number to the list, touch the + button. Enter more fax numbers as needed.
d. To edit the list of fax numbers, touch a number in the list, then touch Remove or Edit.
e. To set a specific time to poll the remote device, touch Delay Polling.

e Touch Delay Polling.

e To set the hour, touch the Hour field, then use the numeric keypad, or touch the arrows.

e To set the minutes, touch the Minute field, then use the numeric keypad, or touch the arrows.

e If your printer is set to display the 12-hour clock, touch AM or PM.
e Touch OK.

f. Touch Print.

The faxes that are stored on the remote device for polling print.

Touch X to exit.
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Storing a Fax in a Local Mailbox

The system administrator must create a mailbox before you can use this feature. For details, refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

To store a fax in a local mailbox:

—_

Load your original documents.

At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.

Touch Store To Mailbox.

Touch Local Mailbox.

Touch a mailbox from the list.

If a passcode is required, touch the Mailbox Passcode field. To enter the passcode, use the keypad. Touch OK.
Touch OK. The mailbox appears as the recipient of the fax.

To select a different mailbox, touch the recipient field, then touch Remove or Edit.
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Touch Send. The original documents are scanned and stored in the mailbox.

Printing Local Mailbox Documents

To use this feature, ensure that you have the documents stored in a mailbox. For details, refer to Storing a Fax in a
Local Mailbox.

To print local mailbox documents:

1. At the printer control panel, press the Home button, then touch Fax.

If the entry screen appears, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.
Touch Print From Mailbox.

Touch Local Mailbox.

Touch a mailbox from the list.

A

If a passcode is required, touch the Mailbox Passcode field. To enter the four-digit mailbox passcode, use the
touch screen keypad. Touch OK.

7. Touch Print.
The documents in the mailbox print.

8. To delete the contents of the mailbox after the device finishes printing, touch Empty Mailbox. To confirm,
touch Empty Mailbox.

9. To exit, touch X.

Storing a Fax in a Remote Mailbox
To store a fax in a remote mailbox:
1. Load your original documents.

2. At the printer control panel, press the Home button, then touch Fax.
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If the entry screen appears, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.
Touch Store To Mailbox.
Touch Remote Mailbox.

To enter the fax number of the remote device, touch Enter Remote Fax Number, then use the numeric
keypad. Touch OK.

To enter the mailbox number, touch the Mailbox Number field, then use the numeric keypad. Touch Enter.
Touch OK. To select a different mailbox, touch the recipient field, then touch Remove or Edit.
Touch Send.

The original documents are scanned, then stored in the remote mailbox.

Printing Remote Mailbox Documents

To print remote mailbox documents:

1.
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At the printer control panel, press the Home button, then touch Fax.

If the entry screen is displayed, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.
Touch Print From Mailbox.

Touch Remote Mailbox.

To enter the fax number of the remote device, touch Enter Remote Fax Number, then use the numeric
keypad. Touch OK.

To enter the mailbox number, touch the Mailbox Number field, then use the numeric keypad. Touch Enter.

If a passcode is required, touch the Mailbox Passcode field. To enter the four-digit mailbox passcode, use the
keypad. Touch OK.

Touch Print. The documents in the remote mailbox print.

Touch X to exit.

Adding or Editing Contacts in the Device Address Book from the Control Panel

You can set up the Device Address Book using the Embedded Web Server. The Address Book can contain up to
5000 contacts that you can access when you enter recipients or destinations using apps.

To add or edit contacts in the Device Address Book from the control panel:
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f” Note: Before you can use this feature, the system administrator must enable Create/Edit Contact from Touch

Screen for All Users.
Load your original documents.
At the printer control panel, press the Home button.
Touch Fax.
To clear previous App settings, touch Reset.
Touch Manual Entry. To type the fax number, use the touch screen keypad.

To add the recipient to the Device Address Book, touch the Address Book icon.
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7. Do one of the following steps.

e To create an entry, touch Create New Contact. Touch each field, then enter the contact details using the
touch screen keypad. Touch OK.

e To add to an existing entry, touch Add to Existing Contact. Touch a contact in the list, or use the Search
option to find a contact.

8. To mark a recipient to appear as a favorite option, touch the Star icon.
9. Adjust the fax settings as needed.
10. To start the scan, touch Send.

11.  To return to the Home screen, press the Home button.

Sending a Fax From Your Computer

You can send a fax to the printer from an application on your computer.

Sending a Fax from Windows Applications
You can use the print driver to send a fax from Windows applications.

You can use the fax window to enter recipients, create a cover page with notes, and set options. You can send a
confirmation sheet, set the send speed, resolution, send time, and dialing options.

To send a fax from Windows applications:

1. With the desired document or image open in your application, open the Print dialog box. For most software
applications, click File > Print or press CTRL+P.

Select the required printer. To open the print driver dialog box, click Printer Properties.
On the Printing Options tab, from the Job Type list, select Fax.

In the Fax window, click the Recipients tab.
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To add recipients manually:

a. Click the Add Recipient icon.

b. Type the recipient name and fax number, then add other information as required.
c.  Click OK.

d. To add more recipients, repeat this procedure.

6. To add existing contacts from a phonebook:

a. Click the Add From Phonebook icon.

b. Select the required phonebook from the list.

c.  Select names from the list, or search for a contact using the search bar.

d. To add the selected contacts to the Fax Recipients list, click the Down Arrow.
e. Click OK.

f.  To add more recipients, repeat this procedure.

148 Xerox® AltalLink® B8145/B8155/B8170 Series Multifunction Printer User Guide



9.
10.

Xerox® Apps

To include a cover sheet, click the Cover Sheet tab. From the Cover Sheet Options list, select Print a Cover
Sheet. Enter the details as needed, then click OK.

On the Options tab, select the required options, then click OK.
To save your settings and return to the main print dialog page, click OK.

Click Print. In the Fax Confirmation window, click OK.

Sending a Fax from Macintosh® Applications

You can use the print driver to send a fax from many Macintosh® applications. To install the print driver, refer to
Installing the Software.

To send a fax from Macintosh® applications:

1.
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With the required document or image open in your application, open the Print dialog box. For most software
applications, click File > Print or press CMD+P.

Select the required printer.
In the Print window, in the print options list, click Xerox Features.
From the Paper/Output window, click Job Type, then click Fax.

To add a recipient, in the Fax window, click the Recipients tab, then click the Add Recipient icon. Type the
recipient name and fax number, add other information as required, then click OK. To add more recipients,
repeat this procedure.

To include a cover sheet, click the Cover Sheet tab. From the Cover Sheet list, select Print a Cover Sheet, then
enter the details as required.

To delay the fax send time, click the Options tab, click the Send Time menu, then click Send At. To enter the
send time, click the time entry field, then enter the time required.

To select additional fax options, from the Options window, select the fax settings required.
To save your settings and return to the main print dialog box, click OK.

To send the fax, click Print.
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Server Fax

SERVER FAX OVERVIEW

Server Fax allows you to send a fax over a network to a fax server. The fax server then
sends the fax to a fax machine over a phone line. Before you can send a server fax,
configure a fax filing repository or filing location. The fax server retrieves the documents
from the filing location and transmits them over the telephone network.

For information about all the Server Fax App features and available settings, refer to Apps Features.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

If authentication or accounting is enabled on your device, to access features, enter your login details. For details
about Personalization for logged-in users, refer to Personalize.

SENDING A SERVER FAX

If a fax server is connected to the network, you can send a document to a fax machine without requiring a
dedicated telephone line.

When you use the server fax, a document is scanned and sent to a fax repository on the network. The fax server
sends the fax over a telephone line to a fax machine.

Before you can use the server fax, the system administrator is required to enable the server fax app and configure a
fax repository or filing location.

To send a server fax:
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1. Load your original documents.

e For single pages or paper that cannot be fed using the duplex automatic document feeder, use the
document glass. Lift the duplex automatic document feeder, then place the original document face down in

the upper-left corner of the document glass.

For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any staples and
paper clips from the pages. Insert the original documents face up in the duplex automatic document
feeder, with the top of the page entering the feeder first. Adjust the paper guides so that they fit against

the original documents.

)
& Note: When the original documents are detected, the automatic document feeder confirmation indicator

LED illuminates.
2. At the device control panel, press the Home button.
3. Touch Server Fax.

4, To clear previous app settings, touch Reset.
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Enter recipients.
e If the entry screen appears, touch an option, or touch X.

e To select a contact or group from the Device Address Book, touch Device Address Book, then select a
recipient.

e To enter the fax number manually, touch Manual Entry. In the Enter Fax Number field, enter the fax
number, then touch Add.

e To add more recipients, touch Add Recipient, then repeat the procedure.

f Note: To insert a pause as needed, touch Dial Pause. To enter longer pauses, touch Dial Pause multiple

times.
Adjust server fax settings as needed.

e To scan more documents using the document glass, or to change settings for different sections of the job,
touch Build Job.

e If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option.
For details about available features, refer to Apps Features.

Touch Send.

If Build Job is enabled, touch Scan, then, when prompted, do these steps;

e To change settings, touch Program Next Segment.

e To scan another page, touch Scan Next Segment.

e To finish, touch Submit.

To return to the Home screen, press the Home button.

SENDING A DELAYED SERVER FAX

You can set a time in the future for the printer to send your fax job. The delay can range from 15 minutes through
24 hours.

f Note: Before you use this feature, set the printer to the current time.

To specify the time to send your server fax:

1.
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Load your original documents.

At the printer control panel, press the Home button.

Touch Server Fax.

Add server fax recipients, then adjust server fax settings as needed. For details, refer to Sending a Server Fax.
Touch Delay Send.

Touch Delay Send, then set the time to send the server fax:

e To set the hour, touch the Hour field, then use the numeric keypad, or touch the arrows.

e To set the minutes, touch the Minute field, then use the numeric keypad, or touch the arrows.

e If your printer is set to display the 12-hour clock, touch AM or PM.

Xerox® Altalink® B8145/B8155/B8170 Series Multifunction Printer User Guide



Xerox® Apps

7. Touch OK.
8. Touch Send. The fax is scanned and saved, then sent at the time you specified.

9. To return to the Home screen, press the Home button.
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Print From

PRINT FROM OVERVIEW

You can use the Print From App to print jobs from various sources. You can print jobs
stored in a print-ready format from a USB stick. You can print saved jobs and jobs stored
in a mailbox.

To create a print-ready file, when you print your documents from programs such as
Microsoft Word, select the print to file option. Check with your specific publishing
application for options to create print-ready files.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

If authentication or accounting is enabled on your device, to access features, enter your login details.

PRINTING FROM A USB FLASH DRIVE

You can print single or multiple files stored on a USB Flash drive. The USB port is on the front of the printer.
f Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To print from a USB Flash drive:
1. Insert the USB Flash drive into the USB port on the printer.
2. At the USB Drive Detected screen, touch Print from USB.

f Note: If the Print from USB feature does not appear, enable the feature, or contact your system
administrator. For details, refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

3. To select a file for printing, browse to the file, then touch the check box. If multiple files require printing, browse
to each file, then select the check box for each file.

4. Touch OK.
A list of files selected for printing appears.
5. To remove files from the printing list:
e Toremove a single file, touch the file, then select Remove. To confirm removal, touch Remove.
e Toremove all the files, touch a file, then select Remove All. To confirm removal, touch Remove All.
6. Adjust the feature settings as needed.
7. Touch Print.
8.  When you are finished, remove the USB Flash drive.
9

To return to the Home screen, press the Home button.
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PRINTING FROM SAVED JOBS

To print from saved jobs:

1. At the control panel, press the Home button, then touch Print From.

Touch Saved Jobs, then touch the name of the folder that contains the saved job.
Touch the name of the saved job that you want to print.

Select the options for paper supply, quantity, 2-sided printing, and finishing.
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Touch Print.

f Note: To print a private saved job, at the Passcode Required screen, enter the passcode, then touch OK.

6. To print another saved job, touch the current job name, then touch Remove. Touch Add Document, touch
Saved Jobs, then navigate to the job required.

7. To return to the Home screen, press the Home button.

PRINTING FROM A MAILBOX

The print from mailbox feature allows you to print a file that is stored in a folder on the printer hard drive.
To print from a mailbox:

1. At the control panel, press the Home button, then touch Print From.

2. Select Mailboxes, then touch the name of the folder that contains the document.

f Note: If Mailboxes does not appear, enable the feature or contact the system administrator. For details, refer
to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

3. Touch the name of the document that you want to print.

4. Select the options for paper supply, quantity, 2-sided printing, and finishing.
5. Touch Print.
6

To select another job in the mailbox, touch the current job name, then touch Remove. Touch Add Document,
touch Mailboxes, then navigate to the job required.

7. To return to the Home screen, press the Home button.
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@PrintByXerox

@PRINTBYXEROX OVERVIEW

You can use the Xerox® @PrintByXerox App to print email attachments and documents sent
to your printer from mobile devices.

When your Xerox device is connected to the Internet, the @PrintByXerox App works with
Xerox® Workplace Cloud for simple email-based printing.

fo Note: The @PrintByXerox App is free to use. For more advanced workflows, use Xerox® Workplace Cloud. The

Xerox® Workplace Cloud software requires a specific licence. For details, refer to the Xerox® @PrintByXerox
App Quick Start Guide available at www.xerox.com/XeroxAppGallery.

For details on configuring and customizing the Apps, refer to the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

If authentication or accounting is enabled on your device, to access features, enter your login details.

PRINTING WITH THE @PRINTBYXEROX APP

1.

156
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Send an email with an attachment that contains a supported file type to Print@printbyxerox.com.
First-time users receive a response email with a user ID and password.

At the Xerox device control panel, press the Home button.

Touch @PrintByXerox.

Enter your email address, then touch OK.

On the enter password screen, enter your password using the touch screen keypad, then touch OK.
Select the documents that you want to print.

To modify print settings, touch Print Settings, then touch OK.

To release your print jobs, touch Print.

e ASubmitting Jobs to Print message and the conversion state appear.

e When the documents begin to print, a green check mark appears.
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Xerox® Apps

Xerox® Connect for XMPie

XEROX® CONNECT FOR XMPIE APP OVERVIEW

The Xerox® Connect for XMPie App, provides instant access to 50 or more templates. With
m one touch, you can create personalized content from your printer.

Use the Xerox® Connect for XMPie App for free access to templates, with the ability to
personalize them for immediate printing.

To configure the Connect for XMPie App on your printer, contact your system administrator, or refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

To use the Connect for XMPie App from the Home screen, touch Connect for XMPie, The main screen displays
Featured Products and Product Categories. You can browse the categories for the products that you want to create.
Follow the instructions on screen to create a job with customized fields. You can preview and print as needed. For
more information on XMPie, go to www.support.xerox.com and in the Search box, type XMPie.

If authentication or accounting is enabled on your device, to access features, enter your login details. For details
about Personalization for logged-in users, refer to Personalize.
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Printing Overview

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected to an active
network. Ensure that you have the correct print driver software installed on your computer. For details, refer to
Installing the Software.

1. Select the appropriate paper.
2. Load paper in the appropriate tray. At the printer control panel, specify the paper size, color, and type.

3. Access the print settings in your software application. For most software applications, for Windows, press CTRL
+P, or for Macintosh, press CMD+P.

4. Select your printer.

5. To access the print driver settings, for Windows, select Printer Properties, Print Options, or Preferences. For
Macintosh, select Xerox Features. The name of the option can vary depending on your application.

6. Modify the print driver settings as necessary, then click OK.
7. To send the job to the printer, click Print.

8. If you selected a special job type, for example Secure Print or Sample Print, your job is held at the printer and
requires further action to print. To manage jobs at the printer, use the Jobs app.

For further information on managing print jobs, refer to Managing Jobs.
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Selecting Printing Options

Printing options, also called print driver software options, are specified as Printing preferences in Windows and
Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page layout, and print quality.
Printing options that you set from Printing preferences within the Devices and Printers window become the default
setting. Printing options that you set within the software application are temporary. The application and the
computer do not save the settings after the application is closed.

PRINT DRIVER HELP

Xerox® print driver software Help information is available from the Printing Preferences window. To see the help,
click the Help (?) button in the bottom-left corner of the Printing Preferences window.
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Information about Printing Preferences appears in the Help window. From this window, you can select by topic or
use the search field. In the search field, enter the topic or function required.

WINDOWS PRINTING OPTIONS

Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings that are specified in the
Printing Preferences window. You can specify your most common printing options and save the options for reuse so
that you do not have to change the settings each time that you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in Printing
Preferences.
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1. On your computer, navigate to the list of printers:
e For Windows Server 2008 and later, click Start > Settings > Printers.
e For Windows 7, click Start > Devices and Printers.
e For Windows 8, click Start > Control Panel > Devices and Printers.
e For Windows 10, click Start > Settings > Devices > Printers & scanners.

e For Windows 11 and later, click Start > Settings > Bluetooth & devices > Printers & scanners.

j’ Note: If you are using a custom Start menu application, the application can change the navigation path to
your list of printers.

2. For your printer, select Printing preferences:

e For Windows Server 2008 or later, Windows 7, or Windows 8, right-click the icon for your printer, then click
Printing preferences.

e For Windows 10, click the icon for your printer, then click Manage > Printing preferences.
e For Windows 11 and later, click the icon for your printer, then click Printing preferences.

3. Inthe Printing Preferences window, click a tab, then select the options. To save the settings, click OK.

j’ Note: For more information about Windows print driver options, click the Help button (?) in the Printing
Preferences window.

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, you can change the Printing Preferences before sending the job
to the printer.

1. With the document open in your software application, access the print settings. For most software applications,
click File > Print or press CTRL+P for Windows.

2. To open the Printing Preferences window, select your printer, then click the Printer Properties, Print Options,
or Preferences button. The title of the button can vary, depending on your application.

3. Click a tab in the Printing Preferences window, then make selections.
4. To save your selections and close the Printing Preferences window, click OK.

5. To send the job to the printer, click Print.

Selecting Finishing Options for Windows

If your printer has a finisher installed, you can select finishing options in the Properties window of the print driver.
Finishing options allow you to select how your document is delivered. For example, you can select hole-punching,
stapling, folding, or printing in a booklet format.

j’ Note: Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

To select finishing options in the PostScript and PCL print drivers:

1. Inthe print driver, click the Printing Options tab.
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2. To select a finishing option, for Finishing, click the arrow.

V4

Note: The print driver displays stapling positions for paper fed on the long edge. If paper feeds on the short
edge instead of the long edge, the finisher can insert the staple in the wrong location.

3. To select the output tray, for Output Destination, click the arrow, then select an option:

V4

Automatic: This option determines the output destination based on the number of sets and the stapling
option selected. The printer sends multiple sets or stapled sets to the finisher output tray.

Center Tray: This option selects the output tray that is in the middle of the Offset Catch Tray, or the
selected finisher.

Center Bottom Tray: This option selects the output tray that is on the bottom of the Offset Catch Tray.
Left Tray: This option selects the output tray that is on the left side of the printer or the selected finisher.
Finisher Tray: This option selects the output tray that is on the Global Integrated Office Finisher.

Right Tray: This option selects the output tray that is on top of the Office Finisher.

Right Top Tray: This option selects the output tray that is on top of the Business Ready Finisher.

Right Middle Tray: This option selects the output tray that is in the middle of the Business Ready Booklet
Maker Finisher.

Right Bottom Tray: This option selects the output tray that is on the bottom of the Business Ready
Finisher when the optional Booklet Maker is not installed.

Note: If a finisher is installed and the Conditional Finisher Offset setting is enabled, when the finisher
operates at a lower speed than the device and no other finishing settings are selected, the offset function is
disabled. If other finishing settings are selected, the offset function operates normally. If the device and
finisher operate at the same speed, the Conditional Finisher Offset setting is ignored. For more
information about the Conditional Finisher Offset setting, refer to the System Administrator Guide at
www.xerox.com/office/ALB81XXdocs.

4. To send the job to the printer, click OK, then click Print.

Selecting Printing Defaults in Windows for a Shared Network Printer

1. On your computer, navigate to the list of printers:

V4

For Windows Server 2008 and later, click Start > Settings > Printers.

For Windows 7, click Start > Devices and Printers.

For Windows 8, click Start > Control Panel > Devices and Printers.

For Windows 10, click Start > Settings > Devices > Printers & scanners.

For Windows 11 and later, click Start > Settings > Bluetooth & devices > Printers & scanners.

Note: If the Control Panel icon does not appear on the desktop, right-click the desktop, then select
Personalize > Control Panel Home > Devices and Printers.
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2. For your printer, select Printer properties:

e For Windows Server 2008 or later, Windows 7, or Windows 8, right-click the icon for your printer, then click
Printing properties.

e For Windows 10, click the icon for your printer, then click Manage > Printer properties.
e For Windows 11 and later, click the icon for your printer, then click Printing preferences.
In the printer Properties dialog box, click the Advanced tab.

On the Advanced tab, click Printing Defaults.

On the print driver tabs, make your selections as needed, then click Apply.

o v & W

To save the settings, click OK.

Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs. After you save a set of
print options, they are available for selection from the Saved Settings or Presets list, or the 1-Touch areaq, if
available.

To save a set of printing options:

1. With the document open in your application, click File > Print.

To open the Printing Preferences window, select your printer, then click Properties or Preferences.
In the Printing Properties window, click the tabs, then select the required settings.

In the Printing Properties window, click Saved Settings or Presets, then click Save As.

v W N

Type a name for the saved setting or preset, then choose preset options, if available:
e Choose an icon for the preset.

e To enable the preset as 1-Touch, select 1-Touch Preset.

e To share the preset in all print drivers, select Show this Preset in All Drivers.

6. Click OK.

7. To print with these settings:

e From the Saved Settings or Presets list, select the name of the preset.

e Fora 1-Touch preset, click 1-Touch, then click the required 1-Touch preset.

MACINTOSH PRINTING OPTIONS

Selecting Printing Options for Macintosh
To use specific printing options, change the settings before sending the job to the printer.
1. With the document open in your application, click File > Print.

2. Select your printer.
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3. Inthe Print window, in the print options list, click Xerox Features.
j’ Note: To see all printing options, click Show Details.

4. Select any other required printing options from the lists.

5. Tosend the job to the printer, click Print.

Selecting Finishing Options for Macintosh

If your printer has a finisher installed, select finishing options in the Xerox® Features of the print driver.

To select finishing options in the Macintosh print driver:

1. In the Print window, in the print options list, click Xerox Features.

2. To select a finishing option, click the arrow to the right of the Finishing field, then select an option.

3. To select the output tray, click the arrow to the right of the Output Destination field, then select an option.

e Automatic: This option determines the output destination based on the number of sets and the stapling
option selected. The printer sends multiple sets or stapled sets to the finisher output tray.

e Center Tray: This option selects the output tray in the middle of the Offset Catch Tray, the Office Finisher,
or the Business Ready Finisher.

e Center Bottom Tray: This option selects the output tray on the bottom of the Offset Catch Tray.
« Finisher Tray: This option selects the output tray on the Integrated Office Finisher.

e Left Tray: This option selects the output tray on the left side of the printer.

e Right Tray: This option selects the output tray on top of the Office Finisher.

e Right Top Tray: This option selects the output tray on top of the Business Ready Finisher.

e Right Middle Tray: This option selects the output tray that is in the middle of the Business Ready Booklet
Maker Finisher.

e Right Bottom Tray: This option selects the output tray that is on the bottom of the Business Ready
Finisher when the optional Booklet Maker is not installed.

f Note: If a finisher is installed and the Conditional Finisher Offset setting is enabled, when the finisher
operates at a lower speed than the device and no other finishing settings are selected, the offset function is
disabled. If other finishing settings are selected, the offset function operates normally. If the device and
finisher operate at the same speed, the Conditional Finisher Offset setting is ignored. For more
information about the Conditional Finisher Offset setting, refer to the System Administrator Guide at
www.xerox.com/office/ALB81XXdocs.

4, To send the job to the printer, click Print.

Saving a Set of Commonly Used Printing Options for Macintosh

You can define and save a set of options, so that you can apply them to future print jobs.
To save a set of printing options:

1. With the document open in your application, click File > Print.

2. Select your printer from the Printers list.
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3. Select the required printing options from the lists in the Print dialog box.
j’ Note: To see all printing options, click Show Details.

4. Click Presets > Save Current Settings as Preset.
5. Type a name for the printing options. To save the set of options in the Presets list, click OK.

6. To print using these options, select the name from the Presets list.

UNIX, LINUX, AND AS/400 PRINTING

To provide printer spooling and network print server functionality, UNIX-based printing uses LPD/LPR port 515 or Ip
to port 9100. Xerox printers can communicate using either protocol.

Xerox® Printer Manager

Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in UNIX and
Linux environments.

Xerox® Printer Manager allows you to:

e Configure and check the status of network connected printers.

o Set up a printer on your network and monitor the operation of the printer once installed.
e Perform maintenance checks and view supplies status at any time.

e Provide a common look and feel across the many different suppliers of UNIX and Linux operating systems.

Installing Xerox® Printer Manager
Before you begin, ensure that you have root or superuser privileges to install Xerox® Printer Manager.
To install Xerox® Printer Manager:

1. Download the appropriate package for your operating system. To locate print drivers for your printer, go to
www.xerox.com/office/ALB81XXdrivers. The files available are:

e XeroxOSDPkg-AIXpowerpc-x.xx.xxx.xxxx.rpm for the IBM PowerPC family.

o XeroxOSDPkg-HPUXia64-x.xx.xxx.xxxx.depot.gz to support HP Itanium workstations.

e XeroxOfficev5Pkg-Linuxi686-x.xx.xxx.xxxx.rpm to support RPM-based 32-bit Linux environments.

e XeroxOfficev5Pkg-Linuxi686-x.xx.xxx.xxxx.deb to support Debian-based 32-bit Linux environments.

o XeroxOfficev5Pkg-Linuxx86_64-x.xx.xxx.xxxx.rpm to support RPM-based 64-bit Linux environments.

o XeroxOfficev5Pkg-Linuxx86_64-x.xx.xxx.xxxx.deb to support Debian-based 64-bit Linux environments.
e XeroxOSDPkg-Sun0Si386-x.xx.xxx.xxxx.pkg.gz for Sun Solaris x86 systems.

e XeroxOSDPkg-SunOSsparc-x.xx.xxx.xxxx.pkg.gz for Sun Solaris SPARC systems.
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2. Toinstall the custom print driver, log in as root, then type the appropriate command for your system:
e AIX: rpm -U XeroxOSDPkg-AIXpOWEeIrpC—X.XX . XXX . XXXX . rpm
e HPUX: swinstall -s XeroxOSDPkg-HPUXia64-x.xX.xXx.xxxx.depot.gz \*
e Solaris, x86 based: pkgadd —d XeroxOSDPkg—Sun0Si386-x.xX.XxXX.XxXXxX.pkg
e Solaris, SPARC based: pkgadd -d XeroxOSDPkg-SunOSsparc—x.xX.XxX.XxXx.pkg
The installation creates a Xerox directory in /opt/Xerox/prtsys.

3. Toinstall the Xerox® Office Standard Driver on Linux platform, log in as root, then type the appropriate
command for your system:

e Linux, RPM based: rpm -U XeroxOfficev5Pkg-Linuxi686-x.xXX.XXX.XXXX.rpm
e Linux, Debian based: dpkg -1 XeroxOfficev5Pkg-Linuxi686-x.xX.xXx.Xxxx.deb

The installation creates a XeroxOffice directory in /opt/XeroxOffice/prtsys.

Launching Xerox® Printer Manager
To launch Xerox® Printer Manager:

1. From your computer, access a command window. At the command prompt, log in as root, then type
xeroxofficeprtmgr.

2. Press Enter or Return.

Printing from a Linux Workstation

To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS (Common UNIX Printing
System) print driver. You do not need both drivers.

Xerox recommends that you install one of the full-featured custom print drivers for Linux. To locate drivers for your
printer, go to www.xerox.com/support/drivers.

If you use CUPS, ensure that CUPS is installed and running on your workstation. The instructions for installing and
building CUPS are contained in the CUPS Software Administrators Manual, written and copyrighted by Easy
Software Products. For complete information on CUPS printing capabilities, refer to the CUPS Software Users
Manual available from www.cups.org/documentation.php.

Installing the PPD File on the Workstation

1. On the Xerox Support website, from the Drivers and Downloads page, download the Xerox® PPD for CUPS
(Common UNIX Printing System).

2. Copy the PPD file into the CUPS ppd/Xerox folder on your workstation. If you are unsure of the location of the
folder, use the Find command to locate the PPD files.

3. Follow the instructions that are included with the PPD file.

Adding the Printer
1. Verify that the CUPS (Common UNIX Printing System) daemon is running.
2. Open a Web browser, type http://localhost:631/admin, then press Enter or Return.

3. For User ID, type root. For password, type the root password.
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4, Click Add Printer, then follow the onscreen prompts to add the printer to the CUPS printer list.

Printing with CUPS (Common UNIX Printing System)
CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands.
1. To print to a specific printer in System V, type 1p ~dprinter filename, then press Enter.

2. To print to a specific printer in Berkeley, type 1pr -Pprinter filename, then press Enter.

AS/400

Xerox provides Work Station Customization Object (WSCO) files to support IBM i V6R1 or later. A Work Station
Customization Object is a lookup table that the host print transform (HPT) uses to translate AS/400 commands to
the equivalent PCL code that is specific to a particular printer. A WSCO file can modify many print features,
including: paper input tray, 2-sided printing, characters per inch, lines per inch, orientation, fonts, and margins.

The XTOOLS library provides a source WSCO file for each supported Xerox® printer or device. The library and
installation instructions are available from www.support.xerox.com.

To install the XTOOLS library, select the downloadable files for the IBM AS/400 operating system, unzip the
downloaded XTOOLSxxxx . z1ip file, then follow the instructions to install the library. Download and install the
library only once.

j’ Note:

e The host print transform works only on AFPDS and SCS files. To use the WSCO for printing, convert IPDS-
formatted printer files to AFPDS files.

e Administrator credentials with IOSYSCFG permissions are required to create a device description or a
remote queue.

e For details on AS/400, refer to the IBM AS/400 Printing V, (Red Book), available on the IBM website.
Installing the WSCO Library and Setting Up Print Queues

For detailed instructions on installing the WSCO library and setting up print queues, refer to the installation
instructions that are included with the library.

MOBILE PRINTING OPTIONS

This printer can print from iOS and Android mobile devices.

Printing with Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smartphone, using Wi-Fi
Direct.

For details, refer to Connecting with Wi-Fi Direct.

For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device.

j’ Note: Depending on which mobile device you are using, the printing procedure varies.
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Printing with AirPrint

You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint®. To enable AirPrint® for your printer,
refer to Configuring AirPrint.

To print with AirPrint®:

1. Open the email, photograph, webpage, or document that you want to print.
Tap the Action icon.

Tap Print.

Select your printer, then set the printer options.

v W N

Tap Print.

For more information on configuring and using AirPrint®, refer to the Using Apple® AirPrint® with Xerox® AltaLink®
Multifunction Printers User Guide.

Printing with Universal Print

To allow users to access the device, the Azure® administrator needs to share the printer in the Azure® portal. After
the printer is shared, the Add Printer feature enables an authorized user to discover the device in Windows 10 or
later. The device appears as the cloud printer in the discovered printers list. To enable Universal Print for your printer,
refer to Configuring a Device for Universal Print.

To add a printer in Windows OS, do the following:
1. To add a printer in Windows® Operating System, do the following:
e For Windows 10, click Settings > Printers & scanners > Add a printer or scanner.

e For Windows 11 and later, click Settings > Bluetooth & devices > Printers & scanners > Add a printer or
scanner.

2. Select the cloud printer in the list of discovered printers, then click Add device.

f Note: When a print job is submitted to Universal Print, it is queued in the cloud until the printer fetches the
job. The printer checks for jobs after the polling interval elapses, or when you initiate the Check For Jobs
Now function.

Printing from a Mopria-Enabled Mobile Device

Mopria is a software feature that enables users to print from mobile devices without requiring a print driver. You can
use Mopria to print from your mobile device to Mopria-enabled printers.
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j’ Note:

Mopria and all of its required protocols are enabled by default.

Ensure that you have the latest version of the Mopria Print Service software installed on your mobile
device. You can obtain a free download of the software from the Google Play Store.

To connect the printer to Wi-Fi or Wi-Fi Direct, purchase and install the Xerox Wireless Network Adapter.
For more information, refer to the Xerox® Dual Band Wireless Kit Hardware Install and Setup instructions
that are included with the kit.

To use Wi-Fi Direct, in the Embedded Web Server, enable the Wi-Fi Direct feature. For details on
configuring Wi-Fi Direct, refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

To configure the Wireless settings, ensure that devices are connected to the same wireless network as the
printer.

The name and location of your printer appears in a list of Mopria-enabled printers on connected devices.

To print using Moprig, follow the directions that are provided with your mobile device.
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Print Jobs

MANAGING JOBS

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs. You can pause,
delete, print, or view job progress or job details for a selected job. When you send a secure print job, the job is held
until you release it by typing a passcode at the control panel. For details, refer to Printing Special Job Types

From the Jobs window in the Embedded Web Server, you can view a list of active and saved print jobs.

Pausing, Promoting, or Deleting a Job Waiting to Print
1. At the printer control panel, press the Home button.
2. Touch Jobs, then touch the name of the required print job.
3. Select a task.
f Note: If you do not make a selection, the job automatically resumes after the set timeout period.
e To pause the print job, touch Hold. To resume the print job, touch Release.
e To delete the print job, touch Delete. At the prompt, touch Delete.
e To move the job to the top of the list, touch Promote.
e To view the status of the job, touch Job Progress.
e To view information about the job, touch Job Details, then touch Job Settings or Required Resources.

4. To return to the Home screen, press the Home button.

¢ Note:

e The system administrator can restrict users from deleting jobs. If a system administrator restricts job
deletion, you can view the jobs, but you cannot delete them.

e Only the user that sent the job, or the system administrator, can delete a Secure Print job.

Printing a Job Held for Resources

When a job is held for resources, a status message and a pop-up alert appear on the control panel, as default. From
the Embedded Web Server, the system administrator can configure whether only a status message appears, or both
status message and a pop-up alert appear on the control panel.

1. If the pop-up alert is disabled by the system administrator, to view the held jobs, do the following:
a. At the printer control panel, press the Home button.
b. Touch Jobs.
A list with active jobs, that are queued for the printer, appears.

2. When the pop-up alert is enabled, if a job is held for resources, a pop-up alert appears on the control panel. On
the pop-up alert, touch View Active Jobs.

A list with active jobs, that are queued for the printer, appears.
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3. From the jobs list, touch the held job hame. The following options appear:

e Print On Alternate Paper: To choose an alternative paper source to enable the job to print, touch Print On
Alternate Paper. Select a paper tray, then touch OK.

e Delete: To delete the print job, touch Delete. At the prompt, touch Delete.
e Job Progress: To view the progress, touch Job Progress.

e Job Detadils: To view the details, touch Job Details. At the prompt, you can view the Job Settings and
Required Resources.

4. To print the job, replenish the resources required. The job resumes automatically when the required or alternate
resources are available.

f Note: The Print On Alternate Paper option is enabled using the Embedded Web Server. For details about
the Print On Alternate Paper option, refer to the System Administrator Guide at www.xerox.com/office/
ALB81XXdocs.

5. Toreturn to the Home screen, press the Home button.

PRINTING SPECIAL JOB TYPES

Special job types allow you to send a print job from your computer, then print it from the printer control panel.
Select special job types in the print driver, Printing Options tab, under Job Type.

Saved Job

Saved Jobs are documents that are sent to the printer and stored there for future use. All users can print or delete a
Saved Job.

At the control panel, from the Print From menu, you can view and print saved jobs. In the Embedded Web Server, in
the Jobs window, you can view, print, and delete saved jobs, and you can manage where jobs are stored.

Printing using Saved Job

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button can vary.
e For Macintosh, in the Print window, in the print options list, click Xerox Features.
3. For Job Type, select Saved Job.
a. Type ajob name or select a name from the list.
b. Type a folder name or select a name from the list.
c. To add a passcode, click Private, type the passcode, then confirm the passcode.
d. Click OK.
4. Select other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.
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Print, Delete, Move, or Copy a Saved Job in the Embedded Web Server

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

In the Embedded Web Server, click Home.
Click Jobs.
Click the Saved Jobs tab.

For the job that you want to process, select the check box.

o v &~ W N

From the menu, select an option.

e Print Job: This option prints a job immediately.

e Delete Job This option deletes the saved job.

e Move Job: Use this option to move the job to another folder location.
e Copy Job: Use this option to duplicate the job.

7. Click Go.

Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the printer until
you enter your passcode at the printer control panel.

After a Secure Print job is printed, it is deleted automatically.

Printing using Secure Print

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Secure Print.

4. Type the passcode, confirm the passcode, then click OK.

5. Select any other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Secure Print job
1. At the printer control panel, press the Home button.
2. Touch Jobs.

3. To view Secure Print jobs, touch Secure Jobs.
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4. Do one of the following:

e If you submitted a single Secure Print job, touch the folder, then touch the job. Enter the passcode number,
then touch OK. The job prints automatically.

e If you submitted multiple Secure Print jobs, touch the folder, enter the passcode number, then touch OK.
Select an option:

e To print a single Secure Print job, touch the job required.
e To print all the jobs in the folder, touch Print All
e To delete a single Secure Print job, touch the Trash icon. At the prompt, touch Delete.

e To delete all the jobs in the folder, touch Delete All.
j’ Note: After a Secure Print job prints, the printer deletes it automatically.

5. To return to the Home screen, press the Home button.

Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining copies. After
reviewing the sample set, you can either print the remaining copies or delete them at the printer control panel.

Sample Set is a type of saved job with these features:

e A Sample Set job appears in a folder named after the user ID associated with the print job.

e A Sample Set job does not use a passcode.

e Any user can print or delete a Sample Set job.

e A Sample Set prints one copy of a job to allow you to proofread the job before printing any remaining copies.
After a Sample Set job is printed, it is deleted automatically.

To print a Sample Set, refer to Printing using Sample Set.

Printing using Sample Set

1. In your software application, access the print settings. For most software applications, press CTRL+P for
Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
e For Windows, click Printer Properties. Depending on your application, the title of the button varies.
e For Macintosh, in the Print window, click Preview, then select Xerox Features.

3. For Job Type, select Sample Set.

4. Select any other required printing options.
e For Windows, click OK, then click Print.

e For Macintosh, click Print.

Releasing a Sample Set

1. At the printer control panel, press the Home button.
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2. To view available jobs, touch Jobs.

3. Touch the Sample Set job.

j’ Note: The Sample Set file description shows the job as Held for Future Printing, and shows the number of
remaining copies of the job.

4, Select an option.
e To print the remaining copies of the job, touch Release.
e To delete the remaining copies of the job, touch Delete.

5. To return to the Home screen, press the Home button.
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Printing Features

SELECTING PAPER OPTIONS FOR PRINTING

There are two ways to select the paper for your print job. You can let the printer select which paper to use based on
the document size, paper type, and paper color you specify. You can also select a specific tray loaded with the
desired paper.

e To locate paper options in Windows, in the print driver, click the Printing Options tab.

e To locate paper options on Macintosh, in the Print window, in the print options list, click Xerox Features. Within
Xerox Features, in the options list, click Paper/Output.

Select By Tray

Use Select By Tray to print from a specific tray without specifying paper attributes in the print driver or at the printer
control panel. This option prints the job from the selected tray, even when more than one tray contains the correct
paper for the job.

The following options are available:

e Automatically Select: This option prints from any tray that is loaded with the size and type of paper that is
required for the print job.

e Tray X: This option prints from the selected tray.

e Bypass Tray: This option prints from the manual-feed tray. The printer prompts you to remove any other paper
from the tray and load the paper that is required for your job.

j’ Note:

e Load the Bypass Tray with the correct size and type of paper for the print job.

e For banner paper, ensure that you select the appropriate paper-size setting, then load banner paper in
the Bypass Tray. For details, refer to Large Banner Paper.

Scaling
Scaling reduces or enlarges the original document to match the selected output paper size.
e For Windows, the scale options are on the Printing Options tab, in the Paper field.

e For Macintosh, the scale options are in the Print window. To view more printing options, click Show Details.

j’ Note: Not all options described are supported on all printers. Some options apply only to a specific printer
model, configuration, operating system, or print driver type.

The following scaling options are available:
e Fit to New Paper Size: This option scales the document to fit the new paper size.

e Change Document Size: Use this setting to match the paper size selected in your application. This option does
not change the size of the page image printed on the output paper.

e Automatically Scale: This option scales the document to fit the selected Output Paper Size. The scaling
amount appears in the percentage box below the sample image.
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e No Scaling: This option does not change the size of the page image printed on the output paper,and 100%
appears in the percentage box. If the original document size is larger than the output size, the page image is
cropped. If the original document size is smaller than the output size, extra space appears around the page
image.

e Manually Scale: This option scales the document by the amount entered in the percentage box below the
preview image.

PRINTING ON BOTH SIDES OF THE PAPER

Printing a 2-Sided Document

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print driver uses
the settings for portrait or landscape orientation from the application for printing the document.

f Note: Ensure that the paper size and weight are supported. For more information, refer to Supported Paper.

2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. These settings
override the application page orientation settings.

e 1-Sided Print: This option prints on one side of the media. Use this option when printing on envelopes, labels,
or other media that cannot be printed on both sides.

e 2-Sided Print: This option prints the job on both sides of the paper to allow binding on the long edge of the
paper. The following illustrations show the result for documents with portrait and landscape orientations,
respectively:

12 B

e 2-Sided Print, Flip on Short Edge: This option prints on both sides of the paper. The images print to allow
binding on the short edge of the paper. The following illustrations show the result for documents with portrait
and landscape orientations, respectively:

| (12

f Note: 2-Sided Printing is part of the Earth Smart settings.

To change your default print driver settings, refer to Selecting Printing Options.

PRINT QUALITY

The Windows Postscript print driver and the Macintosh print drivers provide the highest print-quality modes:
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e High Resolution: This print-quality mode prints halftones at 1200 x 1200 dpi.
e Standard: This print-quality mode prints halftones at 600 x 600 dpi.

IMAGE OPTIONS

Image options controls how the printer uses lightness and contrast to produce your document. The Windows
PostScript print driver and the Macintosh print drivers provide the widest range of controls on the Image Options
tab.

e To locate Image Options in Windows, in the print driver, click the Image Options tab.

e To locate Image Options on Macintosh, in the Print window, in the print options list, click Xerox Features.
Within Xerox Features, in the options list, click Image Options.

Lightness

The Lightness feature allows you to adjust the overall lightness or darkness of the text and images in your printed
job.

Contrast

You can use the Contrast feature to adjust the variation between light and dark areas of the print job.

PRINTING MULTIPLE PAGES TO A SINGLE SHEET

When printing a multiple-page document, you can print more than one page on a single sheet of paper.
Toprint 1, 2, 4,6, 9, or 16 pages per side, on the Page Layout tab, select Pages Per Sheet.

e To locate Pages Per Sheet in Windows, on the Document Options tab, click Page Layout.

e To locate Pages Per Sheet on Macintosh, in the Print window, in the print options list, click Layout.

1 | A

To print a border around each page, select Page Borders.

PRINTING BOOKLETS

With 2-sided printing, you can print a document in the form of a small booklet. You can create booklets from any
paper size that is supported for 2-sided printing.

The print driver automatically reduces each page image and prints four page images per sheet of paper, two page
images on each side. The pages are printed in the correct order so that you can fold and staple the pages to create
the booklet.

178 Xerox® AltalLink® B8145/B8155/B8170 Series Multifunction Printer User Guide



Printing

e To locate booklet creation in Windows, on the Document Options tab, click Page Layout.

e To locate booklet creation on Macintosh, in the Print window, in the print options list, click Xerox Features.
Within Xerox Features, in the options list, click Booklet Layout.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter and creep.
e QGutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm (1/72 in.).

e Creep: Specifies how much the page images shift outward in tenths of a point. Shifting compensates for the
thickness of the folded paper, which can cause the page images to shift outward slightly when folded. You can
select a value from zero to 1 point.

GUTTER CREEP

—

fo Note: To print a border around each page, select Page Borders.

USING SPECIAL PAGES
The Special Pages options control how covers, inserts, and exception pages are added to your printed document.
e To locate Special Pages in Windows, on the Document Options tab, click Special Pages.

e To locate Special Pages on Macintosh, in the Print window, in the print options list, click Xerox Features. Within
Xerox Features, in the options list, click Special Pages.

Printing Cover Pages

A cover page is the first or last page of a document. You can select paper sources for the cover pages that are
different from the source used for the body of a document. For example, you can use your company letterhead for
the first page of a document. You can use heavyweight paper for the first and last pages of a report. You can use
any applicable paper tray as the source for printing cover pages.

In the Covers window, the following options are available:

e No Covers or Disabled: This option does not print cover pages. No cover pages are added to the document.
e Front Only: This option allows you to add a blank or printed front cover to your job.

e Back Only: This option allows you to add a blank or printed back cover to your job.

e Front and Back: Same: This option adds a front and back cover to your job, and applies the same printing and
paper settings for both covers.

e Front and Back: Different: This option adds a front and back cover to your job, and allows you to select
different printing and paper settings for each cover.
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After you make a selection for printing the cover pages, you can select the paper for the front and back covers by
size, color, or type. You can use blank or pre-printed paper, and you can print side one, side two, or both sides of the
cover pages.

Printing Insert Pages

You can add blank or pre-printed insert pages before page one of each document or after designated pages within
a document. The addition of an insert after designated pages within a document separates sections, or acts as a
marker or placeholder. Ensure that you specify the paper to use for the insert pages.

In the Inserts window, you can set the location, characteristics, and paper settings for the insert pages:
o Inserts: This option allows you to select where to place the insert.
¢ Quantity: Use this option to specify the number of pages to insert at each location.

e Pages: Use this option to specify where to place the inserts within the job. Separate individual pages or page
ranges with commas. Specify pages within a range with a hyphen. For example, to specify pages 1, 6, 9, 10, and
11, type1,6,9-11.

e Paper Settings: This option allows you to select the paper size, color, and type to use for the insert pages. To
use the same paper size, color, or type as the main body of the job, select Use Job Setting.

Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can specify differences, such as
page size, page type, and page color. You can change the side of the paper on which to print as your job requires. A
print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a special paper, and
the remainder of the pages printed 2-sided on regular paper. You can use exception pages to print the job.

In the Exceptions window, you can set the location, characteristics, and paper settings for the exception pages:

e Pages: Specifies the page or range of pages that use the exception page characteristics. Separate individual
pages or page ranges with commas. Specify pages within a range with a hyphen. For example, to specify pages
1,6,9,10,and 11, type 1, 6, 9-11.

e Paper Settings: Allows you to select the paper size, color, and type to use for the exception pages. To print
exception pages on the same paper size, color, or type as the main body of the job, select Use Job Setting.

e 2-Sided Printing: Allows you to select 2-sided printing options for the exception pages. Available options are:
— 1-Sided Print: Prints the exception pages on one side only.

—  2-Sided Print: Prints the exception pages on both sides of the paper and flips the pages on the long edge.
You can bind the job on the long edge of the pages.

— 2-Sided Print, Flip on Short Edge: Prints the exception pages on both sides of the paper and flips the
pages on the short edge. You can bind the job on the short edge of the pages.

— Use Job Setting: Prints the job using the same 2-Sided Printing setting that is selected for the main body
of the job.

j’ Note: Some combinations of 2-sided printing with certain paper types and sizes can produce unexpected
results.
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PRINTING ANNOTATIONS FOR WINDOWS

An annotation is special-purpose text or an image that you can print across one or more pages. You can preview
annotations in the Annotations Preview pane.

The annotations setup for your print job appears in the Annotations summary list. From this list, you can select an
annotation to edit or delete.

f Note:

e This feature is available only on a Windows computer printing to a network printer.

e Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

To print an annotation:
1. In the print driver, click the Document Options tab.
2. Click the Annotations tab.

3. To add a text annotation, click Add Comment. Enter the text in the field, select the required settings, then click
OK.

4. For a date or time stamp, click Add Time Stamp. Specify the date and time option, select the required settings,
then click OK.

5. To add a picture annotation, click Add Picture. To locate the picture, click the Browse icon. Select the required
settings, then click OK.

6. For each annotation, the following options are available:
e To specify the font, click the Font button.

e For a picture annotation, select the scaling option that specifies the size of the picture in relation to the
original image. Use the arrows to scale the image in increments of 1%.

e To define the angle of the annotation on the page, specify the position option. Or, to rotate the annotation
left or right by increments of 1, use the arrows.

e To define the location of the annotation on the page, specify the position option. Or, to move the
annotation in each direction in increments of 1, use the arrows.

e To adjust the transparency of the annotation, move the slider. To increase transparency, move the slider to
the right, or to decrease transparency, move the slider to the left.

e For Layering, select an option:
— Print in Background: This option prints the annotation behind the text and graphics in the document.
— Print in Foreground: This option prints the annotation over the text and graphics in the document.
e For Pages, select the pages to print the annotation:
— Print on All Pages: This option prints the annotation on all pages of your document.
—  Print on Page 1 Only: This option prints the annotation only on the first page of the document.
7. To save the annotation, click the Save Annotation icon.
8. To load a previously saved annotation, click the Load Annotation icon.

9. Click OK.
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PRINTING WATERMARKS FOR WINDOWS

A watermark is special purpose text that can be printed across one or more pages. For example, you can add a word
like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before distribution.

j’ Note:

e This feature is available only on a Windows computer printing to a network printer.

» Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

e Watermarks are not supported for some print drivers when booklet is selected or when more than one
page is printed on a sheet of paper.

To print a watermark:
1. Inthe print driver, click the Document Options tab.
2. Click the Watermark tab.

3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or create a
customized watermark. You can also manage watermarks from this menu.

4, Under Text, select an option:
o Text: Enter the text in the field, then specify the font.
e Time Stamp: Specify the date and time options, then specify the font.
e Picture: To locate the picture, click the Browse icon.

5. Specify the scaling angle and position of the watermark.

e Select the scaling option that specifies the size of the picture in relation to the original image. Use the
arrows to scale the image in increments of 1%.

o To define the angle of the image on the page, specify the position option, or to rotate the image left or
right by increments of 1, use the arrows.

e To define the location of the image on the page, specify the position option, or to move the image in each
direction in increments of 1, use the arrows.

6. Under Layering, select how to print the watermark.
e Print in Background prints the watermark behind the text and graphics in the document.

e Blend: This option combines the watermark with the text and graphics in the document. A blended
watermark is translucent, so you can see both the watermark and the document content.

e Print in Foreground prints the watermark over the text and graphics in the document.
7. Click Pages, then select the pages to print the watermark:

e Print on All Pages prints the watermark on all pages of your document.

e Print on Page 1 Only prints the watermark only on the first page of the document.
8. If you select a picture as a watermark, specify the lightness settings for the image.

9. Click OK.
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ORIENTATION
Orientation allows you to select the direction that the page prints.

e To locate orientation options in Windows, on the Document Options tab, click Orientation.

j’ Note: The orientation setting in your application print dialog box can override the orientation options in the
print driver.

e To locate orientation options on Macintosh, in the Print window, click Show Details.
The following options are available:

e Portrait: Orients the paper so that the text and images print across the short dimension of the paper.

o Landscape: Orients the paper so that the text and images print across the long dimension of the paper.

A

e Rotated Landscape: Orients the paper so that the content is rotated 180 degrees and with the long bottom
side up.

v

f Note: For Macintosh, to print portrait text and images in landscape orientation, clear the Auto Rotate check
box.

ADVANCED PRINTING OPTIONS

You can use the Advanced option or tab to set advanced printing options. Advanced printing selections apply to all
jobs that you print with the print driver.

j’ Note: Not all options listed are supported on all printers. Some options apply only to a specific printer model,
configuration, operating system, or print driver type.

Job Identification

You can use the Job ID feature to change the job identification setting for your print job. You can print the job
identification on a separate banner page or on the pages of your document.

The following options are available:
e Disable Job ID: This option directs the printer not to print a banner page.
e Print ID on a Banner Page: This option prints the job identification on a banner page.

e Print ID in Margins - First Page Only: This option prints the job identification on the first page of the
document in the top-left margin.

e Print ID in Margins - All Pages: This option prints the job identification in the top-left margin on every page of
the document.
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Printing Mirror Images

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right when printed.

Job Notification for Windows

You can select to be notified when your job finishes printing. A message appears on your computer screen with the
name of the job and the name of the printer where it was printed.

f” Note: This feature is only available on a Windows computer that is printing to a network printer.

The following options are available:
* Notify for Completed Jobs: This option provides a notification when the job has completed.

» Notify for Completed, but Altered Jobs: This option provides a notification on all jobs that completed with
restrictions.

» Notify for Failed or Canceled Jobs: This option provides notification of all jobs that failed to print or were
canceled.

o Play Alert Tone: This option sounds an alert tone when a notification appears.

Document Encryption for Windows Print Jobs

You can select encryption for your print job. The print file is encrypted before it is transmitted to the printer. The
print file is decrypted before it is printed.

This feature is available only when Document Encryption is set to Manually Encrypt Documents in the printer
properties of the printer. For details, refer to Setting Encryption Defaults in Windows.

_tf’ Note: This feature is available on a Windows computer that is printing to a network printer. It applies to the
PostScript and PCL print drivers.

Setting Encryption Defaults in Windows

1. Navigate to the list of printers on your computer:
e For Windows Server 2008 and later, click Start > Settings > Printers.
e For Windows 7, click Start > Devices and Printers.
e For Windows 8, click Start > Control Panel > Devices and Printers.
e For Windows 10, click the Windows Start > Settings > Devices > Printers & Scanners.

e For Windows 11 and later, click Start > Settings > Bluetooth & devices > Printers & scanners.

f” Note: If the Control Panel icon does not appear on the desktop, right-click the desktop, then select
' Personalize. Select Control Panel Home > Devices and Printers.

2. For your printer, select Printing properties:

e For Windows Server 2008 or later, Windows 7, or Windows 8, right-click the icon for your printer, then click
Printer properties.

e For Windows 10, click the icon for your printer, then click Manage > Printer properties.

e For Windows 11 and later, click the icon for your printer, then click Printing preferences.
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3. Inthe Printer Properties dialog box, click the Administration tab.

4. For Configurations, click Document Encryption, then select an option:
e Disabled: This option disables encryption for all documents that you send to the printer.
e Encrypt All Documents: This option encrypts all documents that you send to the printer.

e Manually Encrypt Documents: This option allows you to set encryption for specific jobs that you send to
the printer.

j’ Note: Manually Encrypt Documents is the default printer setting.

5. Click Apply.

6. To save the settings, click OK.
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Using Custom Paper Sizes

You can print on custom paper sizes that are within the minimum and maximum size range supported by the
printer. For details, refer to Supported Paper.

DEFINING CUSTOM PAPER SIZES

To print on custom paper sizes, define the custom width and length of the paper in the print driver software and on
the printer control panel. When setting the paper size, ensure that you specify the same size as the paper in the
tray. Setting the wrong size can cause a printer error. Print driver settings override control panel settings when you
print using the print driver software on your computer.

j’ Note: To print using long media or banner paper, select the appropriate banner paper size, or define a new
custom paper size.

Creating and Saving Custom Paper Sizes in the Print Driver

Custom-size paper settings are saved in the print driver and are available for you to select in all your applications.
Use the custom-size paper settings to define a custom paper size for long media or banner paper.

For details on supported paper sizes for each tray, refer to Supported Paper.

For further details about creating and saving custom paper sizes in the print driver, click the Help (?) button in the
bottom-left corner of the printer settings window.

Creating and Saving Custom Sizes for the Windows V3 Print Driver
1. In the print driver, click the Printing Options tab.
For Paper, click the arrow, then select Other Size > Advanced Paper Size > Output Paper Size > New.

In the New Custom Paper Size window, enter the height and width of the new size.

& WN

To specify the units of measurement, at the bottom of the window, click Measurements, then select Inches or
Millimeters.

5. Tosave, in the Name field, type a title for the new size, then click OK.

Creating and Saving Custom Sizes for the Windows V4 Print Driver
1. From Windows Control Panel, select Devices and Printers.
Select the printer, then click Print server properties.

On the Forms tab, for Create a new form, click the check box.

For Form name, type a name for the new paper size.

vi B WwWN

In the Form description (measurements) areq, enter the settings:
e For Units, select Metric or English.
e For Paper size, enter measurements for Width and Height.

e For Printer area margins, enter measurements for Left, Right, Top, and Bottom.

j’ Note: Ensure that the measurements that you specify are within the supported ranges for the device.
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6. Click OK.

The new paper size is added to the paper size list.

Creating and Saving Custom Sizes for Macintosh

1. Inthe application, click File > Print.

Click Paper Size, then select Manage Custom Sizes.

To add a new size, in the Manage Paper Sizes window, click the plus sign ( +).
Double-click Untitled, then type a name for the new custom size.

Enter the height and width of the new custom size.

o v &~ W N

Click the arrow for the Non-Printable Area field, then select the printer from the list. Or, for User Defined
margins, set the top, bottom, right, and left margins.

7. To save the settings, click OK.

Defining a Custom Paper Size at the Control Panel

You can print custom-size paper from Bypass Tray. If Trays 1 and 2 are set to Fully Adjustable mode, you can print
custom-size paper from Trays 1 and 2. You can print custom-size paper from any tray that is set to Fully Adjustable,
except for the High Capacity Feeder and Tandem Tray configuration. Custom-size paper settings are saved in the
print driver and are available for you to select in all your applications.

j’ Note: To configure the tray settings for Fully Adjustable or Dedicated mode, refer to Configuring Paper Tray
Settings. You can print a custom-size paper from a Dedicated tray. First, set the custom-size with the tray in
Fully Adjustable mode, then change the tray settings to Dedicated mode.

1. Open the paper tray, then load the custom-size paper.
Close the tray.
At the control panel, to define the new paper size, touch Size, then touch Custom.

In the Custom Paper Size window, enter the height and width of the new paper size, then touch OK.

v W N

To confirm the settings, touch Confirm.

PRINTING ON CUSTOM-SIZE PAPER

f Note: Before you print on custom-size paper, define the custom width and length of the paper in the print
driver software and on the printer control panel. For more information, refer to Defining Custom Paper Sizes.

Printing on Custom-Size Paper from the Windows V3 Print Driver

j’ Note: Before you print on custom-size paper, define the custom size in the Printer Properties. For details, refer
to Creating and Saving Custom Sizes for the Windows V3 Print Driver.

1. Load the custom-size paper in the tray.
2. Inthe application, click File > Print, then select your printer.

3. Inthe Print dialog box, click Printer Properties.
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4. On the Printing Options tab, from the Paper list, select the required custom paper size and type.
5. Select any other required options, then click OK.
6. Inthe Print dialog box, click Print.

Printing on Custom-Size Paper from the Windows V4 Print Driver

j’ Note: Before you print on custom-size paper, define and save the custom paper size as a Form. For details,
refer to Creating and Saving Custom Sizes for the Windows V4 Print Driver.

1. Load the custom-size paper in the tray.

In the application, click File > Print, then select your printer.

In the Print dialog box, click Printer Properties.

On the Printing Options tab, from the Paper list, select Other Size.

To select a custom paper size, select Fit to New Paper Size, then select the custom paper size.

Select any other required options, then click OK.

N o v &~ w N

In the Print dialog box, click Print.

Printing on Custom-Size Paper from Macintosh

1. Load the custom-size paper. For details, refer to Loading Paper.
In the application, click File > Print.

From the Paper Size list, select the custom paper size.

Click Print.

5 WN

188 Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide



Printing

Print From

PRINTING FROM A USB FLASH DRIVE

You can print single or multiple files stored on a USB Flash drive. The USB port is on the front of the printer.
j’ Note: Only USB Flash drives formatted to the typical FAT32 file system are supported.

To print from a USB Flash drive:
1. Insert the USB Flash drive into the USB port on the printer.
2. At the USB Drive Detected screen, touch Print from USB.

f Note: If the Print from USB feature does not appear, enable the feature, or contact your system
administrator. For details, refer to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

3. To select a file for printing, browse to the file, then touch the check box. If multiple files require printing, browse
to each file, then select the check box for each file.

4. Touch OK.
A list of files selected for printing appears.
5. To remove files from the printing list:
e Toremove a single file, touch the file, then select Remove. To confirm removal, touch Remove.
e Toremove all the files, touch a file, then select Remove All. To confirm removal, touch Remove All.
Adjust the feature settings as needed.
Touch Print.

When you are finished, remove the USB Flash drive.

0 N o

To return to the Home screen, press the Home button.

PRINTING FROM SAVED JOBS

To print from saved jobs:

1. At the control panel, press the Home button, then touch Print From.

Touch Saved Jobs, then touch the name of the folder that contains the saved job.
Touch the name of the saved job that you want to print.

Select the options for paper supply, quantity, 2-sided printing, and finishing.

v &~ W N

Touch Print.

f Note: To print a private saved job, at the Passcode Required screen, enter the passcode, then touch OK.

6. To print another saved job, touch the current job name, then touch Remove. Touch Add Document, touch
Saved Jobs, then navigate to the job required.

7. Toreturn to the Home screen, press the Home button.
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PRINTING FROM A MAILBOX

The print from mailbox feature allows you to print a file that is stored in a folder on the printer hard drive.
To print from a mailbox:

1. At the control panel, press the Home button, then touch Print From.

2. Select Mailboxes, then touch the name of the folder that contains the document.

f Note: If Mailboxes does not appear, enable the feature or contact the system administrator. For details, refer
to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

Touch the name of the document that you want to print.
Select the options for paper supply, quantity, 2-sided printing, and finishing.

Touch Print.

o v & W

To select another job in the mailbox, touch the current job name, then touch Remove. Touch Add Document,
touch Mailboxes, then navigate to the job required.

7. To return to the Home screen, press the Home button.

PRINTING FROM THE EMBEDDED WEB SERVER

You can print various file types, such as .txt, .pdf, .ps, and .pcl files directly from the Embedded Web Server without
the need of another application or the print driver. You can store files on a local computer hard drive, mass storage
device, or network drive.

To print from the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter
or Return.

f Note: For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your
Printer.

2. Inthe Embedded Web Server, click the Print tab.

3. To select the file from a local network or remote location, for File Name, click Browse. Select the file, then click
Open.

4. For Printing, select the required options for the job.
e Normal Print prints a job immediately.
e Secure Print prints a job after you enter your passcode at the printer control panel.

e Sample Set, or proof print, prints one copy of a multiple-copy print job and holds the remaining copies at
the printer.

e Save Job for Reprint saves a print job in a folder on the print server for future printing. You can specify a
job name and folder.

Delay Print prints a job at a specified time up to 24 hours from the original job submission.
5. If accounting is enabled, enter your User ID and account information.

6. Click Submit Job.
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j’ Note: To ensure that the job was sent to the queue, wait for the job submission confirmation message to
appear before you close this page.

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide 191



Printing

192 Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide



Paper and Media

This chapter contains:

Paper and Meditl OVEIVIEW ... ovii e et e e e 194
SUPPOTEEA PAPET ... e e et 195
Configuring Paper Tray SEHINGS ... et 203
(ool [ pTe i 2 oTo] < PSRRI 207
Printing 0N SPECIAL PAPET ... e e 217

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide 193



Paper and Media

Paper and Media Overview

The printer can have up to six paper trays:

e Trays 1 and 2 are adjustable paper trays for loading a range of paper sizes.

e Trays 3 and 4 are high-capacity trays that can hold A4, Letter, JIS B5, and Executive size paper.

e Tray 5 or the Bypass Tray is designed for loading small amounts of special paper.

e Tray 6 is an optional high-capacity paper tray that holds A4, Letter, JIS B5, or Executive size paper.

The optional Envelope Tray can replace Tray 1. For more information, refer to the Hardware Install and Setup
Instructions that are included with the Envelope Tray kit.

The printer can use various media types, such as plain, recycled paper, letterhead, pre-printed paper, cardstock,
labels, transparencies, and envelopes. Ensure that you use the correct media for the tray that you are loading. You
can load all types of media in Bypass Tray, excluding labels. For details on supported paper types and weights, refer
to Supported Paper Types and Weights.

& Warning: Printing labels from the following trays can cause misfeeds and other print problems:

e Tray 5 - Bypass Tray
e Tray 6 - High Capacity Feeder

Labels inside each tray show the correct orientation for loading certain types of media. The MAX label shows the
maximum fill line for the tray.
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Supported Paper

Your printer is designed to use various paper and other media types. To ensure the best print quality and to avoid
jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

RECOMMENDED MEDIA
A list of paper and media recommended for your printer is available at:
e www.xerox.com/rmlna Recommended Media List (United States)

e www.xerox.com/rmleu Recommended Media List (Europe)

ORDERING PAPER

To order paper, transparencies, or other media, contact your local reseller or go to www.xerox.com/office/supplies.

GENERAL PAPER LOADING GUIDELINES

e Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.

e Adjust the paper guides to fit the paper size.

e Fan paper before loading it in the paper tray.

e If excessive jams occur, use paper or other approved media from a new package.

e Use only recommended Xerox® transparencies. Print quality could vary with other transparencies.
e Do not print on label media once a label has been removed from a sheet.

e Use only paper envelopes. Print envelopes 1-sided only.

PAPER THAT CAN DAMAGE YOUR PRINTER

Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer.
Do not use the following:

e Rough or porous paper

e Inkjet paper

e Non-laser glossy or coated paper

e Paper that has been photocopied

e Paper that has been folded or wrinkled

e Paper with cutouts or perforations

e Stapled paper

e Envelopes with windows, metal clasps, side seams, or adhesives with release strips

e Padded envelopes
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e Plastic media

@ Caution: The Xerox Warranty or Service Agreement does not cover damage caused by using
unsupported paper or specialty media. For more information, contact your local Xerox representative.

PAPER STORAGE GUIDELINES
Storing your paper and other media properly contributes to optimum print quality.

e Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from ultraviolet and
visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly damaging to paper.

e Reduce the exposure of paper to strong lights for long periods of time.

e Maintain constant temperatures and relative humidity.

e Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect moisture.
e Store paper flat, either on pallets, cartons, shelves, or in cabinets.

e Avoid food or drinks in the area where paper is stored or handled.

e Do not open sealed packages of paper until you are ready to load them into the printer. Leave stored paper in
the original packaging. The paper wrapper protects the paper from moisture loss or gain.

e Some special media is packaged inside resealable plastic bags. Store the media inside the bag until you are
ready to use it. Keep unused media in the bag and reseal it for protection.

SUPPORTED PAPER TYPES AND WEIGHTS

TRAYS PAPER TYPES WEIGHTS
Trays 1-4 Lightweight 52-63 g/m?
Plain 64-90 g/m?

Hole Punched

Letterhead 64-105 g/m?
Recycled
Bond
Pre-Printed

Custom Types 1-6

Lightweight Cardstock 106-169 g/m?

Lightweight Glossy Cardstock

Labels 106-176 g/m?
Cardstock 170-256 g/m?
Glossy Cardstock
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PAPER TYPES

Heavyweight Cardstock
Heavyweight Cardstock Reloaded
Heavyweight Glossy Cardstock

Heavyweight Glossy Cardstock
Reloaded

Custom Type 7

WEIGHTS
257-300 g/m?

Paper and Media

Transparencies

Tray 6 — High Capacity Feeder

Lightweight

52-63 g/m?

Plain

Hole Punched

64-90 g/m?

Letterhead
Recycled
Bond
Pre-Printed

Custom Types 1-6

64-105 g/m?

Lightweight Cardstock
Lightweight Glossy Cardstock

106-169 g/m?

Cardstock 170-256 g/m?
Glossy Cardstock
Heavyweight Cardstock 257-300 g/m?

Heavyweight Cardstock Reloaded
Heavyweight Glossy Cardstock

Heavyweight Glossy Cardstock
Reloaded

Custom Type 7

Transparencies

Bypass Tray

Lightweight 52-63 g/m?
Plain 64-90 g/m?
Hole Punched

Letterhead 64-105 g/m?
Recycled
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TRAYS PAPER TYPES WEIGHTS

Bond
Pre-Printed

Custom Types 1-6

Lightweight Cardstock 106-169 g/m?

Lightweight Glossy Cardstock

Cardstock 170-256 g/m?
Glossy Cardstock
Heavyweight Cardstock 257-300 g/m?

Heavyweight Cardstock Reloaded
Heavyweight Glossy Cardstock

Heavyweight Glossy Cardstock
Reloaded

Custom Type 7

Transparencies

Envelopes 75-90 g/m?

Envelope Tray Envelopes 75-90 g/m?

w2
f Note: Pre-cut tabs are not supported.
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SUPPORTED STANDARD PAPER SIZES

TRAY

EUROPEAN STANDARD SIZES

Paper and Media

NORTH AMERICAN STANDARD
Y VA4S

Tray 1 A6 (105 x 148 mm, 4.1 x 5.8 in.) Statement (5.5 x 8.51in.) (140 x 216
AS (148X 210mm, 58x830n) | ™
A4 (210 x 297 mm, 8.3 x 11.7 in.) E’é‘;cﬁ'r‘r’j (725x10.51n) (184 x
A3 (297 x 420 mm, T1.7x16.51) || otrer (85 x 11 in) (216 x 279 mm)
B6 (176 x125mm, 69X 491n) | s Folio (8.5 x 13 in) (216 x 330
B5 (176 x 250 mm, 6.9 x 9.8 in.) mm)
B4 (250 x 353 mm, 9.8 x 13.91in.) | Legal (8.5 x 141in.) (216 x 356 mm)
JISB6 (128 x 182 mm, 5.0 x 7.2 in.) | Tabloid (11 x 17 in.) (279 x 432
JISB5 (182 x 257 mm, 7.2 x 10.1 mm)
in.) Postcard (4 x 6in.) (102 x 152 mm)
JISB4 (257 x 364 mm, 10.1x 143 | 5x7in. (127 x 178 mm)
n) 8 x 10 in. (203 x 254 mm)
215x315mm (8.5x1241n) 85 x 13.4in. (216 x 340 mm)

Tray 2 A6 (105 x 148 mm, 4.1 x 5.8 in.) Statement (5.5 x 8.51in.) (140 x 216

A5 (148 x 210 mm, 5.8 x 8.3 in.)
A4 (210x 297 mm, 8.3 x 11.7in.)
A3 (297 x 420 mm, 11.7 x 16.5in.)
B6 (176 x 125 mm, 6.9 x 4.9 in.)

B5 (176 x 250 mm, 6.9 x 9.8 in.)

B4 (250 x 353 mm, 9.8 x 13.9 in.)
JISB6 (128 x 182 mm, 5.0 x 7.2 in.)

JISB5 (182 x 257 mm, 7.2 x 10.1
in.)

JISB4 (257 x 364 mm, 10.1 x 14.3
in.)

215x315mm (8.5x 12.4in.)

SRA3 (320 x 450 mm, 12.6 x 17.7
in.)

mm)

Executive (7.25 x 10.5in.) (184 x
267 mm)

Letter (8.5x 11in.) (216 x 279 mm)

US Folio (8.5x 13in.) (216 x 330
mm)

Legal (8.5 x 14in.) (216 x 356 mm)

Tabloid (11 x 17 in.) (279 x 432
mm)

Postcard (4 x 6in.) (102 x 152 mm)
5x7in. (127 x 178 mm)

8x10in. (203 x 254 mm)
8.5x13in. (216 x 330 mm)

12 x 18 in. (305 x 457 mm)

Trays 3 and 4 of the Tandem Tray
Module

Tray 6 - High Capacity Feeder

A4(210x 297 mm, 8.3 x 11.7 in.)

JISB5 (182 x 257 mm, 7.2 x 10.1
in.)

Letter (8.5x 11in.) (216 x 279 mm)

Executive (7.25 x 10.5in.) (184 x
267 mm)
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TRAY

Bypass Tray

EUROPEAN STANDARD SIZES

A6 (105 x 148 mm, 4.1 x 5.8 in.)
A5 (148 x 210 mm, 5.8 x 8.3in.)
A4 (210 x 297 mm, 83 x 11.7in.)
A3 (297 x 420 mm, 11.7 x 16.5in.)
B6(125x 176 mm, 4.9 x 6.9 in.)

B5 (176 x 250 mm, 6.9 x 9.8 in.)

B4 (250 x 353 mm, 9.8 x 13.9 in.)
JISB6 (128 x 182 mm, 5.0 x 7.2 in.)

JISB5 (182 x 257 mm, 7.2 x 10.1
in.)

JIS B4 (257 x 364 mm, 10.1 x 14.3
in.)

SRA3 (320 x 450 mm, 12.6 x 17.7
in.)

215x315mm (8.5x 12.4in.)

DL Envelope (110 x 220 mm, 4.33 x
8.66in.)

C6 Envelope (114 x 162 mm, 4.5 x
6.38in.)

C5 Envelope (162 x 229 mm, 6.4 x
9in.)

C4 Envelope (229 x 324 mm, 9 x
12.81in.)

NORTH AMERICAN STANDARD
SIZES

Postcard (3.5 x 5.5 in.) (89 x 140
mm)

Postcard (4 x 6in.) (102 x 152 mm)
5x7in.(127 x 178 mm)

Statement (5.5 x 8.5in.) (140 x 216
mm)

Executive (7.25 x 10.5in.) (184 x
267 mm)

8x10in. (203 x 254 mm)
Letter (8.5x 11in.) (216 x 279 mm)
9x11in.(229 x 279 mm)

US Folio (8.5x13in.) (216 x 330
mm)

85x13.4in.(216 x 340 mm)
Legal (8.5 x 14in.) (216 x 356 mm)

Tabloid (11 x 17 in.) (279 x 432
mm)

12x 18 in. (305 x 457 mm)
12 x19in. (305 x 483 mm)

Envelope (6 x 9in.) (152 x 228
mm)

Envelope (9 x 12in.) (228 x 305
mm)

Monarch Envelope (3.9 x 7.5 in.)
(98 x 190 mm)

No. 6 3/4 Envelope (3.6 x 6.5 in.)
(92 x 165 mm)

No. 9 Envelope (3.9 x 8.9 in.) (98 x
225 mm)

No. 10 Envelope (4.1 x 9.5 in.) (105
X 241 mm)

Envelope Tray

DL Envelope (110 x 220 mm, 4.33 x
8.66in.)

C6 Envelope (114 x 162 mm, 4.5 x
6.38in.)

Envelope (6 x 9in.) (152 x 228
mm)

Envelope (9 x 12in.) (228 x 305
mm)
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NORTH AMERICAN STANDARD
TRAY EUROPEAN STANDARD SIZES SIZES

C5 Envelope (162 x 229 mm, 6.4 x Monarch Envelope (3.9 x 7.5 in.)
9in.) (98 x 190 mm)

C4 Envelope (229 x 324 mm, 9 x No. 6 3/4 Envelope (3.6 x 6.5 in.)
12.8in.) (92 x 165 mm)

No. 9 Envelope (3.9 x 8.9 in.) (98 x
225 mm)

No. 10 Envelope (4.1 x 9.5 in.) (105
X 247 mm)

SUPPORTED PAPER SIZES AND WEIGHTS FOR 2-SIDED PRINTING

EUROPEAN STANDARD SIZES NORTH AMERICAN STANDARD SIZES

A5 (148 x 210 mm, 5.8 x 8.3 in.)

A4 (210 x 297 mm, 8.3 x 11.7in.)

A3 (297 x 420 mm, 11.7 x 16.5in.)

B5 (176 x 250 mm, 6.9 x 9.8 in.)

B4 (250 x 353 mm, 9.8 x 13.91in.)
JISB6 (128 x 182 mm, 5.0 x 7.21in.)
JISB5 (182 x 257 mm, 7.2 x 10.1 in.)
JIS B4 (257 x 364 mm, 10.1 x 14.3in.)
SRA3 (320 x 450 mm, 12.6 x 17.7 in.)

215x 315 mm (8.5 x 12.41in.)

Statement (5.5 x 8.5in.) (140 x 216 mm)
Executive (7.25 x 10.5in.) (184 x 267 mm)
Letter (8.5x 11 in.) (216 x 279 mm)

US Folio (8.5 x 13in.) (216 x 330 mm)
Legal (8.5 x 14in.) (216 x 356 mm)
Tabloid (11 x 17 in.) (279 x 432 mm)

8 x10in. (203 x 254 mm)

12 x 18 in. (305 x 457 mm)

12 x 19 in. (305 x 483 mm)

In addition to the standard sizes, you can use custom-size paper within the following ranges for 2-sided printing:

e Minimum size: 128 x 140 mm (5 x 5.5in.)

e  Maximum size: 320 x 483 mm (12.6 x 19 in.)

Paper weights from 64-300 g/m2 are supported for 2-sided printing.

j’ Note:

e Do not use transparencies, envelopes, labels, lightweight paper, or reloaded paper for 2-sided printing.

e For 2-sided printing, paper weights above 220 g/m2 can cause misfeeds and paper jams.
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SUPPORTED PAPER SIZES FOR THE ENVELOPE TRAY

EUROPEAN STANDARD SIZES NORTH AMERICAN STANDARD SIZES

DL (110 x 220 mm, 4.33 x 8.66 in.) Envelope (152 x 228 mm, 6 x 9in.)
C6 (114 x 162 mm, 4.5 x 6.38 in.) Monarch (98 x 190 mm, 3.9 x 7.5in.)
C5(162x 229 mm, 6.4 x91in.) No.9 (98 x 225 mm, 3.9 x 8.9 in.)

No. 10 (105 x 241 mm, 4.1 x 9.5 in.)

SUPPORTED CUSTOM PAPER SIZES

TRAY PAPER SIZES

Tray 1 Minimum: 100 x 148 mm (3.9 x 5.8 in.)
Maximum: 297 x 432 mm (11.7 x 17 in.)

Tray 2 Minimum: 100 x 148 mm (3.9 x 5.8 in.)
Maximum: 320 x 457 mm (12.5x 18 in.)

Trays 3 and 4 of the Tandem Tray Module Standard sizes only:

A4 (210 x 297 mm, 8.3 x 11.7 in.)

Letter (216 x 279 mm, 8.5x 11in.)
JISB5 (182 x 257 mm, 7.2 x 10.1 in.)
Executive (184 x 267 mm, 7.25x 10.5in.)

Bypass Tray Minimum: 89 x 98 mm (3.5 x 3.9 in.)
Maximum: 320 x 483 mm (12.6 x 19 in.)

Bypass Tray, banner paper Minimum: 89 x 483 mm (3.5x 19 in.)
Maximum: 320 x 1321 mm (12.6 x 52 in.)

Tray 6 - High Capacity Feeder Standard sizes only:

A4 (210x 297 mm, 8.3 x 11.7in.)

Letter (216 x 279 mm, 8.5x 11 in.)
JISBS5 (182 x 257 mm, 7.2 x 10.1 in.)
Executive (184 x 267 mm, 7.25 x 10.5in.)

Envelope Tray Minimum: 90 x 98 mm (3.5 x 3.9in.)
Maximum: 2471 x 372 mm (9.5 x 14.61in.)
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Configuring Paper Tray Settings

CONFIGURING DEDICATED PAPER TRAYS

The system administrator can set trays to Fully Adjustable mode or Dedicated mode. When a paper tray is set to
Fully Adjustable mode, you can change paper settings each time that you load the tray. When a paper tray is set to
Dedicated mode, the control panel prompts you to load a specific paper size, type, and color.

Your printer can have three high-capacity paper trays installed, depending on the configuration.
e High-capacity trays are configured as Fully Adjustable trays.

e Trays 3 and 4 in the Tandem Module, and High-Capacity Tray 6 hold A4-size (210 x 297 mm), Letter-size (8.5 x
11 in.), JIS B5-size (182 x 257 mm), or Executive-size (7.25 x 10.5 in.) paper.

e High-capacity trays are designed to hold larger amounts of paper for fewer printing interruptions.

Note: To configure tray settings, refer to the System Administrator Guide at www.xerox.com/office/
ALB81XXdocs.

CHANGING PAPER SIZE, TYPE, AND COLOR

When a paper tray is set to Fully Adjustable mode, you can change paper settings each time that you load the tray.
When you close the tray, the control panel prompts you to set the paper size, type, and color of paper loaded.

When a paper tray is set to Dedicated mode, the control panel prompts you to load a specific paper size, type, and
color. If you move the guides to load a different paper size, the control panel displays an error message.

To configure the tray settings for Fully Adjustable or Dedicated mode, refer to Configuring Paper Tray Settings.
To set the paper size, type, or color when a tray is set to Fully Adjustable:
1. Open the paper tray, then load the required paper.
2. Close the tray.
3. At the control panel, select the correct paper size, type, and color:
e To select a new paper size, touch Size.
e To select a new paper type, touch Type.
e To select a new paper color, touch Color.
4. To confirm the settings, touch Confirm.

To set the paper size, type, or color when a tray is set to Dedicated, refer to Configuring Dedicated Paper Trays.

PAPER SIZE CONFIRMATION

The system administrator can configure the device response that appears on the control panel touch screen when
paper of the same size is loaded in a tray. For standard adjustable paper trays, select an option:
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e Always Show: This option shows the paper confirmation prompt on the control panel touch screen until the
user dismisses it.

e Delayed Confirmation: This option shows the paper confirmation prompt for a specified time. At the end of
the specified time, the prompt closes, which confirms the paper that is loaded. While the prompt appears on the
control panel touch screen, you can confirm any change to the paper type, color, and size.

o Auto Confirmation: This option confirms the paper type, color, and size automatically without showing a
confirmation prompt on the control panel touch screen.

f Note: Xerox does not recommend using the Auto Confirmation option unless you always load the tray
with paper of the exact same type, color, and size.

j’ Note: To configure the Automatic Tray Confirmation Prompt, refer to Required Paper Policies in the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

CONFIGURING TRAYS 3 AND 4 OF THE TANDEM TRAY MODULE

Trays 3 and 4 in the Tandem Tray Module are high-capacity paper trays. Configure Trays 3 and 4 to support the
paper in use. For details on supported paper sizes, refer to Supported Paper.

To configure Trays 3 and 4 in the Tandem Tray Module:

j’ Note: Before you make any tray adjustments, compare the paper size to the current Tray 3 and 4
configurations. If the paper size matches the tray configuration, no tray adjustment is needed.

1. Remove any paper from the tray.
2. Pinch the guide lock on the front paper guide, then slide the paper guide to the required paper size.

3. To lock the paper guides into place, release the guide lock.

j’ Note: The paper guides lock into place only at the designated standard paper sizes.

CONFIGURING TRAY 6

Tray 6 is a high-capacity tray. You can configure Tray 6 to support the paper size that you need. For details on
supported paper sizes, refer to Supported Paper.

To configure Tray 6:

j’ Note: Before you make any tray adjustments, compare the paper size to the current Tray 6 configuration. If
the paper size matches the tray configuration, no tray adjustment is needed.
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1. At the high capacity feeder, squeeze the handle, and pull out Tray 6 until it stops.

2. Open the side gate. Remove the screw that holds the spacer plate at the back of the tray, then lift the spacer
plate out of the tray. Repeat the procedure for the spacer plate at the front of the tray.

3. For the rear spacer plate, place the tabs at the bottom of the plate into the slots that correspond with the
correct paper size. Slide down the spacer plate, then engage the peg on the top of the tray with the matching
hole in the spacer plate. To secure the spacer plate, install the screw. Repeat the procedure for the spacer plate

at the front of the tray.
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4. On the top of the side gate, lift the pin, then guide it into the required paper size in the slot. To lock the side
gate into place, release the pin.

5. Load paper, close the side gate, then close the tray.
6. At the control panel, select the correct type and color.
7. To confirm the settings, touch Confirm.

For information about loading paper in Tray 6, refer to Loading Paper in Tray 6.
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Loading Paper

LOADING PAPER IN TRAYS 1 AND 2

You use the same method to load paper in Trays 1 and 2. For instructions on how to load paper in Trays 3 and 4 of
the Tandem Tray Module, refer to Loading Paper in Trays 3 and 4 of the Tandem Tray Module.

The system administrator can set Trays 1 and 2 to Fully Adjustable mode or Dedicated mode. Each time a tray is
opened and closed, the paper settings appear on the control panel.

e When trays are configured as Fully Adjustable, you can confirm or change the media settings. The tray guides
automatically detect the size of paper that is loaded.

e When trays are configured as Dedicated, the control panel displays the media settings for the tray. A warning
message appears on the control panel when the wrong media is loaded in the tray, or when the tray guides are
set incorrectly.

f Note: Only the system administrator can change the media settings for a dedicated tray. For details on how
to configure tray settings, refer to Configuring Paper Tray Settings.

When the paper in the tray is in short supply, or when a tray is empty, a warning message appears on the control
panel.

To load the paper in Trays 1 and 2:

1. Pull out the tray until it stops.

2. Remove any paper that is a different size or type.

3. To move out the length or width paper guides, pinch the guide locks, then slide out the length or width paper
guides.

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide 207



Paper and Media

4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. The
procedure separates any sheets that are stuck together and reduces the possibility of jams.

fo Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use it.
5. Load the paper in the tray. Do one of the following:
e For long-edge feed:
e Insert letterhead and pre-printed paper face down with the top edge toward the front.

e Load hole-punched paper with the holes to the left.

L.

fo Note: Do not load the paper above the maximum fill line. Overfilling the tray can cause paper jams.
e For short-edge feed:
e Insert letterhead and pre-printed paper face down with the top edge to the left.

e Load hole-punched paper with the holes toward the back.
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6. To adjust the length and width guides to fit the paper, pinch the guide locks, then slide the paper guides in until
they touch the paper.

8. At the control panel, select the correct paper size, type, and color.
e If letterhead paper is loaded in the printer, for type, select Letterhead.
e If pre-printed paper is loaded in the printer, for type, select Pre-printed.

9. To confirm the settings, touch Confirm.

f Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring Dedicated
‘ Paper Trays.

ADJUSTING THE PAPER GUIDES IN THE 520-SHEET ADJUSTABLE TRAYS

You can adjust the paper guides in Trays 1 and 2 to accommodate standard or custom paper sizes. In the standard
position, the guides move into the supported standard paper settings. You can use the Paper Size Preference feature
to set the preferred paper size to imperial or metric. Paper size options that use the selected units setting appear at
the top of the Paper Selection list on the Print tab and User Interface. You can select from the following options of
different measurement units:

e Inches: This option sets the paper-size preference to inches and displays Imperial sizes first.

e Metric: This option sets the paper-size preference to millimeters and displays Metric sizes first.
To set a custom size in the control panel, you can set the dimensions in the following increments:
e 0.1in,, if the measurement unit is set to Inches or

e 1 mm, if the measurement unit is set to Metric

To move the paper guides from the standard to the custom paper-size position:
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1. Pull out the tray until it stops.

]
N

2. Remove any paper from the tray, pinch the guide levers, and move the guides outward until they stop.
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5. Load the custom-size paper in the tray.

6. To engage the fine-adjustment block, pinch the levers and slide the guides inward.

LOADING PAPER IN TRAYS 3 AND 4 OF THE TANDEM TRAY MODULE

The control panel displays a warning message when the paper in the tray is in short supply, or when a tray is empty.
To change the paper size in Trays 3 and 4, refer to Configuring Trays 3 and 4 of the Tandem Tray Module.

To load the paper in Trays 3 and 4 of the Tandem Tray Module:

1. Pull out the tray until it stops. Wait for the tray to lower and stop.

2. Fan the edges of the paper before you load it into the paper trays. The procedure separates any sheets of
paper that are stuck together and reduces the possibility of paper jams.

fo Note: To avoid paper jams and misfeeds, do not remove the packaging from the paper until you are ready
to use it.
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3. Stack the paper against the left-rear corner of the tray.
e Insert letterhead and pre-printed paper face down with the top edge toward the front of the tray.
e Load hole-punched paper with the holes to the left.

f Note: Do not load the paper above the maximum fill line. Overfilling the tray can cause paper jams.

4.

5. At the control panel, select the correct paper type and color.
e If letterhead paper is loaded in the printer, for type, select Letterhead.
e If pre-printed paper is loaded in the printer, for type, select Pre-printed.

6. To confirm the settings, touch Confirm.

LOADING PAPER IN THE BYPASS TRAY

The Bypass Tray supports the widest variety of media types. The tray is intended primarily for small-quantity jobs
that use special media.

To load paper in the Bypass Tray:
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1. Open the Bypass Tray. If the tray is loaded with paper, remove any paper that is a different size or type.

j’ Note: For larger paper sizes, pull out the extension tray.

3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. The
procedure separates any sheets that are stuck together and reduces the possibility of jams.

fo Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use it.
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4. Load the paper in the tray.
e For long-edge feed printing:
e Load letterhead and pre-printed paper face up with the top edge toward the front.
e Load hole-punched paper with the holes to the right.

e For short-edge feed printing:

e Load letterhead and pre-printed paper face up with the top edge to the right.

e Load hole-punched paper with the holes toward the rear.

W

fo Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.

5. Adjust the width guides until they touch the edges of the paper.
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6. At the control panel, select the correct paper size, type, and color.
e If letterhead paper is loaded in the printer, for type, select Letterhead.
e If pre-printed paper is loaded in the printer, for type, select Pre-printed.

7. To confirm the settings, touch Confirm.

LOADING PAPER IN TRAY 6

The control panel displays a warning message when the paper in the tray is in short supply, or when the tray is
empty.

To change the paper size in Tray 6, refer to Configuring Tray 6.
To load paper in Tray 6:

1. At the high capacity feeder, squeeze the handle, and pull out Tray 6 until it stops.

2. Open the side gate, then wait for the tray to lower and stop.

3. The control panel displays the paper tray settings. Ensure that you load the correct paper type into the tray.
f Note: Do not load custom-size paper into Tray 6.

4. Before you load the paper into the trays, fan the edges of the paper. The procedure separates any sheets of
paper that are stuck together and reduces the possibility of paper jams.

f Note: To avoid paper jams and misfeeds, do not remove paper from the packaging until necessary.
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5. Load the paper against the right side of the tray.
e Place letterhead or pre-printed paper face up with the top edge toward the front of the tray.
e Place hole-punched paper with the holes toward the right side of the tray.

j’ Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.

7. At the control panel, select the correct type and color.

e If letterhead paper is loaded in the printer, for type, select Letterhead.
e If pre-printed paper is loaded in the printer, for type, select Pre-printed.

8. To confirm the settings, touch Confirm.
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Printing on Special Paper

To order paper, transparencies, or other media, contact your local reseller or go to www.xerox.com/office/supplies.
For reference:

www.xerox.com/rmlna : Recommended Media List (United States)

www.xerox.com/rmleu : Recommended Media List (Europe)

ENVELOPES

You can print envelopes from the Bypass Tray. When the optional Envelope Tray is installed, you can print envelopes
from Tray 1.

Guidelines for Printing Envelopes
e Use only paper envelopes.
e Do not use envelopes with windows or metal clasps.

e Print quality depends on the quality and construction of the envelopes. If you do not get the desired results, try
another envelope brand.

e Maintain constant temperatures and relative humidity.

e Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect print quality
and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during printing.

e Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book on top of the
envelopes.

e In the print driver software, select Envelope as the paper type.
e Do not use padded envelopes. Use envelopes that lie flat on a surface.
e Do not use envelopes with heat-activated glue.

e Do not use envelopes with press-and-seal flaps.

Loading Envelopes in the Bypass Tray
For supported envelope sizes, refer to Supported Paper.

To load envelopes in the Bypass Tray:

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide 217


https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&PgName=Order&Language=English
https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=rmlna
https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=rmleu

Paper and Media

1. Open the Bypass Tray.

\

O
AR\

e

\

fo Note: If you do not load envelopes in the Bypass Tray right after they are removed from the packaging, they
can bulge. To avoid jams, flatten the envelopes.
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3. Load envelopes in the tray.

e For envelopes with the flap on a long edge, load envelopes face down with the flaps closed, and flaps
toward the right.

e For envelopes with a self-seal flap on a short edge, load envelopes face down with the flaps closed, and
flaps toward the right.

NS

e For envelopes with a non-adhesive flap on a short edge, load envelopes face down with the flaps open, and
flaps toward the left.

N

w2
& Note: For envelopes to print correctly, when you load envelopes with the flaps open, in the print driver, set
the orientation as needed.

4. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is set to Envelope.

5. To confirm the settings, touch Confirm.
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Loading the Envelope Tray

You can use the optional Envelope Tray in place of Tray 1. The Envelope Tray is a dedicated tray. For supported
envelope sizes, refer to Supported Paper.

f Note: For information on installing the optional Envelope Tray, refer to the Hardware Install and Setup
Instructions that are included with the Envelope Tray kit.

To load the Envelope Tray:

1. Pull out the Envelope Tray until it stops.

2.

fo Note: When loading 6 % Envelopes or small custom envelope sizes with the flap on the long edge, keep the
short edge to the left, flaps closed, and toward the rear.

3. Adjust the paper guides so that they rest lightly against the edges of the envelopes. Ensure that the maximum
fill line is visible or that there are no more than 50 envelopes loaded in the tray.
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4. Close the tray.

5. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is set to Envelope.

6. To confirm the settings, touch Confirm.

LABELS
Print labels from the following trays only:

e Trays 1-4

& Warning: Printing labels from the following trays can cause misfeeds and other print problems:

e Tray 5 - Bypass Tray
e Tray 6 - High Capacity Feeder

Guidelines for Printing Labels

e Use labels designed for laser printing.

e Do not use vinyl labels.

e Do not feed a sheet of labels through the printer more than once.

e Do not use dry gum labels.

o Print only on one side of the sheet of labels. Use full sheet labels only.

e Store unused labels flat in their original packaging. Leave the sheets of labels inside the original packaging until
ready to use. Return any unused sheets of labels to the original packaging and reseal it.

e Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing them in
extreme conditions can cause print-quality problems or cause them to jam in the printer.

e Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and jam in the
printer.

e In the print driver software, select Label as the paper type.

e Before loading labels, remove all other paper from the tray.
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! Caution: Do not use any sheet where labels are missing, curled, or pulled away from the backing sheet.
It could damage the printer.

Loading Labels
f Note: Load labels only in trays 1-4.

1. Pull out the tray until it stops.

.
A

2. Ensure that the paper guides are set in the correct position for the size of labels you are loading.

3. Remove any paper that is a different size or type.

4. To move out the length or width paper guide, release the guide lock, then slide out the length or width paper
guide.

222 Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide



Paper and Media

5. Load the labels in the tray.

e For long-edge feed, insert labels face up with the top edge toward the front.

fo Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.

6. Adjust the length and width paper guides to fit the labels.
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7. Slide the tray back into the printer.

8. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is set to Labels.
j’ Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring Dedicated
Paper Trays.
9. To confirm the settings, touch Confirm.

10. To return to the Home screen, press the Home button.

LARGE BANNER PAPER

You can print on banner paper from the Bypass Tray only. Once the banner paper is loaded, use the Custom Paper
Size option to specify the banner paper size.

To print on long media or large banner paper, use the printer driver custom-size paper settings to define a custom
paper size. For details, refer to Defining Custom Paper Sizes.

f Note: Ensure that the recommended media weight for large banner paper is between 106220 g/m2.

j’ Note: Load only one large banner paper at a time into the Bypass Tray. Only Lightweight Cardstock,
Cardstock, Lightweight Glossy Cardstock, and Glossy Cardstock are to be used for printing the large banner

papers.

j’ Note: To aid with feeding banner paper into the Bypass Tray, you can install an optional Long Sheet Feed Kit.
For information, refer to the Hardware Install and Setup Instructions that are included with the Long Sheet

Feed Kit.

Loading Large Banner Paper in the Bypass Tray

1. Open the Bypass Tray, then pull out the extension tray. Remove any paper that is a different size or type.
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2. Move the width guides to the edges of the tray.

3. Load the large banner paper in the tray. Load the paper with the short edge leading into the printer.

f Note: To aid with feeding banner paper into the bypass tray, you can align a flat surface with the edge of
the tray.

WER

\

4. Adjust the width guides until they touch the edges of the paper.
5. At the control panel, select the correct paper size, type, and color.

a. To define the paper size, touch Size, then touch Custom. In the Custom Paper Size window, enter the
width and length of the banner paper, then touch OK.

b. To define the paper type, touch Type, then select the correct paper type.
c. To define the paper color, touch Color, then select the correct paper color.

6. To confirm the settings, touch Confirm.
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7. To return to the Home screen, press the Home button.
f Note: As the paper feeds into the printer, support the paper with your hands.

To prevent paper jams, feed one sheet of paper at a time.

\

|

M

|

Loading Large Banner Paper Using the Long Sheet Feed Extension

You can use the optional Long Sheet Feed Extension to aid with loading large banner paper into the Bypass Tray.
To load large banner paper using the Long Sheet Feed Extension:

1. Open the Long Sheet Feed Extension guides. Remove any paper that is a different size or type.

2. Move the Bypass Tray width guides to the edges of the tray.

Y

AN
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3. Load large banner paper in the tray. Load paper onto the rear Long Sheet Feed Extension guide with the short
edge leading into the printer. Ensure that the leading edge feeds underneath the front guide.

Y

AN

4. Carefully roll the remaining length of the banner paper into the Long Sheet Feed Extension guides. Ensure that
the trailing edge rests against the front guide.

\

AN

5. Adjust the Bypass Tray width guides until they touch the edges of the paper.
6. At the control panel, select the correct paper size, type, and color.

a. To define the paper size, touch Size, then touch Custom. In the Custom Paper Size window, enter the
width and length of the banner paper, then touch OK.

b. To define the paper type, touch Type, then select the correct paper type.
c. To define the paper color, touch Color, then select the correct paper color.
7. To confirm the settings, touch Confirm.

8. To return to the Home screen, press the Home button.

GLOSSY MEDIA

You can print glossy paper, up to 300 g/m2, from any tray. For Bypass Tray and Tray 6, load the paper with the
glossy side or print side down, for Trays 1-4, load the paper with the glossy side or print side up.

f Note: For best results, load Glossy Cardstock, and Glossy Cardstock Reloaded paper into Bypass Tray.
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Guidelines for Printing on Glossy Paper

e Do not open sealed packages of glossy paper until you are ready to load them into the printer.

e Leave glossy paper in the original wrapper, and leave the packages in the shipping carton until ready to use.
e Remove all other paper from the tray before loading glossy paper.

e Load only the amount of glossy paper that you are planning to use. Do not leave glossy paper in the tray when
you are finished printing. Reinsert unused paper in the original wrapper and seal.

e Rotate paper frequently. Long periods of storage in extreme conditions can cause glossy paper to curl and jam
in the printer.

o In the print driver software, select the desired glossy paper type or select the tray loaded with the desired paper.

Loading Gloss Paper in the Bypass Tray
1. Before you load glossy paper, remove all other paper from the tray.
Load only the amount of paper you plan to use.

Load the paper with the glossy side or print side down.

&~ W N

At the control panel, select the correct paper size, type, and color:

e Ensure that the paper type is set to Glossy. To select a new paper type, touch Type.
e To select a new paper size, touch Size.

e To select a new paper color, touch Color.

5. To confirm the settings, touch Confirm.

TRANSPARENCIES

Transparencies can be printed from trays 1-5. For best results, use only recommended Xerox® transparencies.

(D Caution: The Xerox Warranty or Service Agreement does not cover damage caused by using
unsupported paper or specialty media. For more information, contact your local Xerox representative.

Guidelines for Printing on Transparencies
e Before you load transparencies in the tray, remove all paper.
e Handle transparencies by the edges using both hands. Fingerprints or creases can cause poor print quality.
e Do not load more than 20 transparencies. Overloading the tray can cause the printer to jam.
e For clear or non-strip transparencies:
— Load transparencies face up into Trays 1-4.
— Load transparencies face down into the Bypass Tray.
o For striped transparencies:
— Load transparencies into Trays 1-4 with the strip face down on the right trailing edge.

— Load transparencies into the Bypass Tray with the strip face up on the left trailing edge.
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e Do not fan transparencies.
e After you load transparencies, on the control panel, change the paper type to Transparency.

e In the print driver software, for the paper type, select Transparency.
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General Precautions

& Warning:

Internal parts of the printer can be hot. Use caution when doors and covers are open.
Keep all cleaning materials out of the reach of children.

Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays contain
explosive mixtures and are not suitable for use in electrical applications. Use of pressurized spray
cleaners increases the risk of fire and explosion.

Do not remove the covers or guards that are fastened with screws. You cannot maintain or service any
parts that are behind these covers and guards. Do not attempt any maintenance procedure that is not
described in the documentation supplied with your printer.

(D Caution:
L
e When cleaning your printer do not use organic or strong chemical solvents or aerosol cleaners. Do not
pour fluids directly into any area. Use supplies and cleaning materials only as directed in this
documentation.
e Do not place anything on top of the printer.
e Do not leave the covers and doors open for any length of time, especially in well-lighted places. Light
exposure can damage the drum cartridges.
e Do not open covers and doors during printing.
e Do not tilt the printer while it is in use.
e Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print
quality to deteriorate.
e Ensure that any parts removed during cleaning are replaced before you plug in the printer.
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Cleaning the Printer

CLEANING THE PRINTER EXTERIOR
Regular cleaning keeps the touch screen, control panel, and exterior areas of the printer free from dust and dirt.
To clean the printer exterior:

1. To avoid activating buttons and menus when cleaning the printer, press the Power/Wake button, then touch
Sleep.

2. To remove fingerprints and smudges, clean the touch screen and control panel with a soft, lint-free cloth.

j’ Note: There is a lint-free cloth stored in a compartment on the document feeder.

3. Toreturn the printer to Ready mode, press the Power/Wake button.
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4. Use a soft, lint-free cloth to clean the outside of the output tray, paper trays, and other exterior areas of your
printer.

Cleaning the Scanner

To ensure optimum print quality, clean the document glass regularly. Cleaning helps avoid output with streaks,
smears, and other marks that transfer from the glass while scanning documents.

f Note: For best results, use Xerox® Glass Cleaner to remove marks and streaks.

1. Slightly dampen a soft, lint-free cloth with water.
f Note: There is a lint-free cloth stored in a compartment on the document feeder.

2. Remove any paper or other media from the output tray.
3. Open the document cover.

4. Wipe the surfaces of the document glass and CVT glass until the surfaces are clean and dry.
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5. Wipe the white underside of the document cover until it is clean and dry.

6. Close the document cover.

Cleaning the Document Feed Rollers

Dirt on the document feed rollers can cause paper jams or deteriorate print quality. For best performance, clean the
document feed rollers once a month.

1. Lift the lever and open the top cover of the document feeder.

2. While turning the rollers, wipe the rollers with a clean, lint-free cloth moistened with water.

f Note: There is a lint-free cloth stored in a compartment on the document feeder.

® Caution: Do not use alcohol or chemical cleaners on the document feed rollers.
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3. Close the document feeder top cover. If available, close the document feeder left cover.

Cleaning the Second-Side Scanning Lens Assembly

The second-side scanning lens assembly allows you to make 2-sided scans and copies with a single pass of the
original document. The assembly is on the left side of the document cover and includes a mirrored glass strip, a
metal strip, a white-plastic strip, and rollers.

f Note: It is recommended that you clean all parts of the second-side scanning lens assembly regularly.

To clean the second-side scanning lens assembly:

1. To access the second-side scanning lens assembly, on the left side of the document cover, lower the lever.
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2. Toseparate the left end of the document cover from the lens assembly, continue to lower the lever.

3. Using a soft, lint-free cloth moistened with water, wipe the mirrored glass, metal strip, both sides of the white-
plastic strip, and the rollers. If dirt is difficult to remove, moisten the cloth with a small amount of neutral

detergent, then wipe the parts dry with a dry, soft cloth.

® Caution: To prevent damage to the film around the glass, do not press heavily on the mirrored glass.

Y
P“
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4. Return the document cover to the original position, and ensure that the lever is locked in place. If you touch the
document cover, before you close the document feeder, clean the cover.
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CLEANING THE PRINTER INTERIOR

Cleaning the Printhead Lens

The printhead lens requires regular cleaning to maintain print quality. Clean the printhead lens every time the
associated drum cartridge is replaced, or if print quality starts to degrade. For example, if prints have voids or light
streaks, use the following instructions to clean the LED lens:

& Warning: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If some
toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on your skin,
wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out immediately with
cool water and consult a doctor.

® Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front door of the printer.

2. Remove the waste toner transport unit:

a. To unlock the waste toner transport unit, rotate the locking lever 45 degrees counterclockwise.
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b. To release the waste toner transport unit, press both orange tabs as shown, then pull out the unit from the
printer.

C.
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3. Remove the printhead LED lens-cleaning rod from inside the front door.

4. Slowly push the cleaning rod into the printhead LED lens cleaning slot until it stops, then pull out the rod.
Repeat this action two more times.

5. Return the cleaning rod to its original location.

6. To insert the waste toner transport unit:
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a. Position the waste toner transport unit as shown.

c. To lock the waste toner transport unit, rotate the locking lever 45 degrees clockwise.
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7. Close the printer front door.
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Supplies

CONSUMABLES

Consumable supplies are printer supplies that become depleted during the operation of the printer. Consumable
supplies for this printer include the following supplies:

e Genuine Xerox® Black Toner Cartridge.
e Staple Cartridges and Staple Refills for the Optional Integrated Office Finisher.
o Staple Cartridges and Staple Refills for the Optional Office Finisher or the Office Finisher with Booklet Maker.

e Staple Cartridges and Staple Refills for the Optional Business Ready Finisher or the Business Ready Finisher with
Booklet Maker.

f Note:

e Each consumable includes installation instructions. To replace consumables, refer to the instructions
included with the consumable supply.

¢ Only install new toner cartridges in your printer. If a used toner cartridge is installed, then the toner
remaining amount displayed can be inaccurate.

e To ensure print quality, the toner cartridge is designed to cease functioning at a predetermined
point.

(D Caution: Use of toner other than genuine Xerox®Toner can affect print quality and printer reliability.
Xerox® Toner is the only toner designed and manufactured under strict quality controls by Xerox for
specific use with this printer.

ROUTINE MAINTENANCE ITEMS

Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements can be parts or kits. Routine maintenance items are typically customer-replaceable parts.

j’ Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:
e Waste Container

e Drum Cartridge

e Transfer Belt Cleaner

e Second Bias Transfer Roller

e Hole-Punch Waste Container
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ORDERING SUPPLIES

When to Order Supplies

A warning appears on the control panel when supplies near the replacement time. Verify that you have
replacements on hand. To avoid interruptions to your printing, order these items when the messages first appear on
the control panel. An error message appears on the control panel when supplies require replacement.

Order supplies from your local reseller or go to www.xerox.com/office/supplies.

(D Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty or Service Agreement do
not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or
the use of Xerox supplies not specified for this printer.

Supply Status

You can check the status and percentage of life remaining for your printer supplies at the control panel or from the
Embedded Web Server. When printer supplies near their replacement time, warning alerts appear at the control
panel.

You can customize the alerts that appear at the control panel and configure email alert notifications using the
Embedded Web Server.

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System Administrator
Guide at www.xerox.com/office/ALB81XXdocs.

To check the supplies status at the control panel:

1. At the printer control panel, press the Home button.

To view status information for the printer supplies, touch Device > Supplies.

To view details about a specific supply item, touch the item required.

To return to the Supplies screen, touch X.

To view more details, touch Other Supplies. Scroll through the list, then select an option.
To return to the Supplies screen, touch X.

To print the Supplies Report, touch Print Supplies Report.

© N o &~ W N

To return to the Device screen, touch X.

TONER CARTRIDGES

& Warning:

e When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid contact with
clothes, skin, eyes, and mouth. Do not inhale the toner dust.

e Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have the child
spit out the toner, and rinse out their mouth with water. Consult a physician immediately.
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& Warning: Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills.
Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of toner,
contact your local Xerox representative.

Warning: Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can catch
fire and cause burn injuries or an explosion.

Replacing the Toner Cartridge

When it is time to replace the toner cartridge, the printer displays a message on the control panel.
f Note: Each toner cartridge includes installation instructions.

To replace a toner cartridge:

@ Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front cover of the printer.
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2. Firmly grip the cartridge handle, then pull the toner cartridge straight out of the printer.

3. Remove the new toner cartridge from the packaging. Tilt the cartridge up and down, then left and right 10
times.

4. Hold the new toner cartridge with the arrow facing up, then push the cartridge in slowly until it stops.

5. Push gently on the toner cartridge to ensure that it is seated.
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6. Close the printer front cover.

WASTE CONTAINER

Replacing the Waste Container
When it is time to replace the waste container, a message appears on the control panel.

When you replace the waste container, clean the printhead lens. For details, refer to Cleaning the Printhead Lens.

(D Caution: Spread paper on the floor to catch possible toner spills.

& Warning: If you spill any toner in the printer, wipe it up using a moist cloth. Never use a vacuum cleaner
to remove spilled toner. Sparks inside the vacuum cleaner can cause a fire or explosion.

& Warning: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If some
toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on your skin,
wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out immediately with
cool water and consult a doctor.

)
& Note: Each waste container includes installation instructions.

To replace the waste container:

(D Caution: Do not perform this procedure when the printer is copying or printing.
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1. Open the front cover of the printer.

2. Remove the new waste container from the packaging. Retain the packaging.

3. Pull the used waste container out slowly while supporting it with your other hand.
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4. Place the used waste container in the plastic bag, then seal the bag firmly using the zipper.

5.

7. Clean the printhead lenses. For details, refer to Cleaning the Printhead Lens.
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8. Close the printer front cover.

DRUM CARTRIDGES

Replacing the Drum Cartridge

When it is time to replace the drum cartridge, a message appears on the control panel.
f Note: Each drum cartridge includes installation instructions.

To replace the drum cartridge:

® Caution: Do not perform this procedure when the printer is copying or printing.

® Caution: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent lighting. Do
not touch or scratch the surface of the drum.

1. Open the front cover of the printer.

2. Remove the waste toner transport unit:
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a. To unlock the waste toner transport unit, rotate the locking lever 45 degrees counterclockwise.

N\

b. To release the waste toner transport unit, press both orange tabs as shown, then pull out the unit from the
printer.

?
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c. Place the removed waste toner transport unit on a level surface, with the openings facing up.
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4. Grip the orange handle of the drum cartridge as shown, then pull the drum cartridge straight out of the printer.
Place the used drum cartridge in the plastic bag, then place the bag in the box.

& Warning: Do not touch any toner that adheres to the drum cartridge.

5. Remove the packing material from the end of the new drum cartridge.

6. Rest the new cartridge, along with its black plastic protective shield, in the cartridge slot. Load the cartridge in
the direction of the arrow on the top of the shield.

7. With the guides inserted in the slot, remove the black paper sheet. Remove the tape from the top of the
cartridge shield.
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8. Hold the shield, then use the orange handle to push the cartridge into the printer.
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11.  To lock the drum cartridge, turn the orange lever to the left.

N

12. To insert the waste toner transport unit:

a. Position the waste toner transport unit as shown.
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c. To lock the waste toner transport unit, rotate the locking lever 45 degrees clockwise.

13.  Close the printer front door.

14. Dispose of the protective shield and tape as normal office waste.

REPLACING THE TRANSFER BELT CLEANER

When it is time to replace the transfer belt cleaner, a message appears on the control panel.

@ Caution: Do not perform this procedure when the printer is copying or printing.
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1. Open the front cover of the printer.

2. Remove the waste toner transport unit:

a. To unlock the waste toner transport unit, rotate the locking lever 45 degrees counterclockwise.

N\

b. To release the waste toner transport unit, press both orange tabs as shown, then pull out the unit from the
printer.
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c. Place the removed waste toner transport unit on a level surface, with the openings facing up.

3. To unlock the belt cleaner, turn the orange lever to the left. Pull the transfer belt cleaner straight out of the
printer.

@ Caution: Do not touch any toner adhering to the transfer belt cleaner. Do not tilt the transfer belt
cleaner, toner can spill.
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4. Remove the new transfer belt cleaner from the packaging, then remove the protective cover from new transfer
belt cleaner. Retain the packaging.

® Caution: Do not touch the surface of the transfer belt cleaner. This action can cause image quality to
deteriorate.

5. Place the used transfer belt cleaner in the packaging.

o

f/

6. Support the new transfer belt cleaner with your left hand and slide it straight into the opening until it stops.
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7. Push the belt cleaner until it clicks into place, then to lock the belt cleaner, turn the orange lever to the right.

8. To insert the waste toner transport unit:

a. Position the waste toner transport unit as shown.

260 Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide



Maintenance

c. To lock the waste toner transport unit, rotate the locking lever 45 degrees clockwise.

SECOND BIAS TRANSFER ROLLER

Replacing the Second Bias Transfer Roller
When the second bias transfer roller needs to be replaced, a message appears on the control panel.

1. Remove paper from the left tray, then fold up the tray.
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2. Toopen Door A, lift the release lever, then open Door A.

& Warning: The area around the fuser can be hot. To avoid injury, use caution.

® Caution: Do not touch the transfer belt. Touching the belt can reduce image quality or damage the
transfer belt. Do not touch the transfer roller. Touching the roller can reduce image quality.

3. Remove the new transfer roller from the packaging. Retain the packaging.

4. To release the used transfer roller from the printer, pinch the orange levers at each end of the transfer roller, as
shown.

262 Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide



Maintenance

5. Lift the used transfer roller out of the printer.

j’ Note: Do not touch any toner that adheres to the transfer roller.

6.

7.

8. Remove the protective cover from the transfer roller, then close Door A.

STAPLE CARTRIDGES AND STAPLE REFILLS

When a staple cartridge is empty, a message appears on the control panel.
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Replacing Staples in the Integrated Office Finisher

@ Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the finisher front door.

1

3. Check inside the finisher for any loose staples and remove them.

4. Pinch both sides of the staple pack and remove the staple pack from the cartridge.
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5. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the cartridge.

Replacing Staples in the Office Finisher

Replacing Staples in the Main Stapler of the Office Finisher

@ Caution: Do not perform this procedure when the printer is copying or printing.
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1. Open the finisher front door.

2. Reach into the finisher cabinet and pull the stapler toward you until it stops.

3. Push the stapler assembly to the right, as shown.
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5. Pinch both sides of the staple pack and remove the staple pack from the cartridge.

6. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the cartridge.

7. Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler assembly until it
clicks.

8. Close the finisher front door.

Replacing Staples in the Booklet Maker of the Office Finisher

& Warning: Do not perform this procedure while the printer is printing.

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide 267



Maintenance

1. Open the finisher side cover.

2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening and slide the
panels to the center.
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4. Hold the tabs on both sides of the new staple cartridge and insert the cartridge into the original position in the
finisher.

na]
& Note: If you have trouble inserting the cartridge, ensure that the staples are positioned correctly in the
cartridge.

fo Note: The booklet maker uses two staple cartridges. Booklet stapling requires that both staple cartridges
contain staples.

5. Repeat the procedure for the other staple cartridge.

6. Close the finisher side cover.

Replacing Staples in the Business Ready Finisher

Replacing Staples in the Main Stapler of the Business Ready Finisher

@ Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front door of the Business Ready finisher.
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2. Grasp the stapler assembly lever R1, then move the lever to the right.

4. Pinch both sides of the staple pack and remove the staple pack from the cartridge.
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5. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the cartridge.

6. Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler assembly until
the staple cartridge clicks into place.

7. Return the stapler assembly to its original position, then close the finisher door.

Replacing Staples in the Booklet Maker of the Business Ready Finisher

@ Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front door of the Business Ready Finisher.
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2. Grasp the booklet maker handle and pull the unit toward you until the staple cartridges appear on the top edge
of the device.

pl/L 1Y)
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3. Toremove a staple cartridge from the booklet maker, push down on the staple cartridge handle, as shown, then
pull the cartridge out and up.

4. Turn over the staple cartridge.

5. To remove the staple pack from the staple cartridge, press in the green tabs and pull back the handle, then lift
out the staple pack.
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6. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the cartridge.

8. To return the staple cartridge to the booklet maker, insert the staple cartridge and push up on the cartridge
handle as shown.

W
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9. Return the booklet maker to its original position, then close the finisher door.

=]

Replacing Staples in the Convenience Stapler
1. Lift the lever at the rear of the convenience stapler, then gently rotate the staple head toward you.

2. Grip the staple cartridge and pull it out of the stapler head.

3. Unpack the new staple cartridge. Remove any partial strips and any staple strips that are not flat.
4. Install the new staple cartridge in the convenience stapler. The staple cartridge clicks into place.

5. Release the lever at the front of the convenience stapler, then gently rotate the staple head away from you.

EMPTYING THE HOLE PUNCH WASTE CONTAINER

A message appears on the control panel when the hole punch waste container is full.

Emptying the Hole Punch Waste Container in the Office Finisher

@ Caution: Do not perform this procedure when the printer is copying or printing.
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1. Lift the finisher transport top cover, then open the front transport cover.

2. Pull out the hole-punch waste container.

3. Empty the container.
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4. Insert the container all the way into the finisher.

5. Close the finisher front transport cover, then close the top cover.

Emptying the Hole Punch Waste Container in the Business Ready Finisher

@ Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front door of the Business Ready Finisher.
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2. Remove the hole punch waste container from its slot near the top left of the finisher.

f Note:

e When you remove the hole punch waste container, wait 10 seconds before you reinsert it into the
printer. The hole punch counter resets after 10 seconds.

e If you remove the hole punch waste container before the device instructs you to, empty the container
before you reinsert it into the finisher.

3.

4.

—

5. Close the front door of the finisher.

RECYCLING SUPPLIES
For information on Xerox® supplies recycling programs, go to www.xerox.com/gwa .

Supplies include a prepaid return label. Please use it to return used components in their original boxes for recycling.
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RESETTING SUPPLY LIFE COUNTERS
You must reset the supply life counters when you replace some supplies.
1. At the printer control panel, press the Home button.

2. Touch the Log In button, enter the system administrator login information, then touch Done. For details, refer
to the System Administrator Guide at www.xerox.com/office/ALB81XXdocs.

Touch Device > Tools > Device Settings > Supplies.

Touch Supply Counter Reset.

To select an item to reset, touch the supply item in the list, then touch Reset Counter.
On the confirmation screen, touch Reset.

To return to the Tools screen, touch X, then touch X again.

To return to the Home screen, press the Home button.

o 0 N oo & W

Touch the Log In button, then touch Logout.
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Managing the Printer

VIEWING THE METER READING

The Billing/Usage menu displays the total number of impressions that the printer generated or printed during its
lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper. For example, a sheet of
paper that is printed on two sides counts as two impressions.

j’ Note: If you provide regular billing information for your device, you can use the Remote Services Upload
feature to simplify the process. You can enable Remote Services to send billing meter readings to Xerox
automatically so that you do not have to collect the readings manually. Refer to the System Administrator
Guide for further information.

To view the billing information for your printer:

1. At the printer control panel, press the Home button.

Touch Device > Billing/Usage.

To view more details, touch Usage Counters, then select an option.

After viewing the usage readings, to return to the Device screen touch X, then touch X again.

v W N

To return to the Home screen, press the Home button.

PRINTING THE BILLING SUMMARY REPORT

The Billing Summary Report provides information about the device and a detailed listing of the billing meters and
sheet counts.

To print the Billing Summary Report:
1. At the printer control panel, press the Home button.
Touch Device > Information Pages.

Touch Billing Summary, then touch Print.

& W N

To return to the Home screen, press the Home button.

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide 279



Maintenance

Moving the Printer

e Always power off the printer and wait for the printer to shut down. To power off the printer, verify that there are
no jobs in the queue, then press the secondary power switch. After the touch screen goes dark, wait 10 seconds,
then power off the main power switch. For details, refer to Power Options.

e Disconnect the power cord from the back of the printer.

e To avoid spilling toner, keep the printer level.

j’ Note: When moving the printer over a long distance, to prevent toner from spilling, remove the drum
cartridges and toner cartridges. Pack the printer inside a box.

(D Caution: Failure to repackage the printer properly for shipment can result in damage not covered by the
Xerox® Warranty or Service Agreement. The Xerox® Warranty or Service Agreement do not cover damage
to the printer caused by improper moving.
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General Troubleshooting

This section contains procedures to help you locate and resolve problems. Resolve some problems by simply
restarting the printer.

RESTARTING THE PRINTER

The printer has two power switches. The main power switch, located behind the front door, controls the main power
to the printer. The secondary power switch is the Power/Wake button on the control panel. The Power/Wake button
controls power to the printer electronic components, and when powered off, initiates a software-controlled
shutdown. The preferred method to power on and off the printer is to use the Power/Wake button.

To operate the printer, power on both switches:
1. Power on the main power switch.

2. At the control panel, press the Power/Wake button.

o

3. Torestart the printer:

a. At the control panel, press the Power/Wake button, then touch Restart. A message appears on the control
panel that warns you that the printer is restarting.

b. If the printer does not restart after several minutes, open the front door, then power off the main power
switch. To restart the printer, power on the main switch, then press the Power/Wake button on the control
panel.

c. Close the front door.

If restarting the printer does not resolve the issue, see the table in this chapter that best describes the problem.
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PRINTER HAS TWO POWER SWITCHES

Troubleshooting

PROBABLE CAUSES SOLUTIONS

The printer has two power switches and one is not
powered on.

Power off the printer.
e Press the Power/Wake button on the control panel.

e Open the front door and power off the main power
switch.

Power on the printer.

e Open the front door, then power on the main
power switch.

e At the printer control panel, press the Power/Wake
button. For details, refer to Power Options.

PRINTER DOES NOT POWER ON

PROBABLE CAUSES SOLUTIONS

The power switch is not switched on.

e Open the front door and check that the main power
switch is in the On position.

e At the printer control panel, press the Power/Wake
button. For details, refer to Power Options.

The power cord is not plugged into the outlet correctly.

Power off the printer, then plug the power cord into the
outlet securely. Use the bracket provided with the
printer to secure the power cord in place.

Something is wrong with the outlet connected to the
printer.

e Plug another electrical appliance into the outlet
and check if it operates properly.

e Try adifferent outlet.

The printer is connected to an outlet with a voltage or
frequency that does not match the printer
specifications.

Use a power source with the specifications listed in the
Electrical Specifications.

@ Caution: Plug the three-wire cord with grounding prong directly into a grounded AC outlet. Do not use a
power strip. If necessary, contact a licensed electrician to install a properly grounded outlet.

PRINTER RESETS OR POWERS OFF FREQUENTLY

PROBABLE CAUSES SOLUTIONS

The power cord is not plugged into the outlet correctly.

Power off the printer. Confirm that the power cord is
plugged in correctly to the printer and the outlet, then
power on the printer.

A system error occurred.

Power off the printer, then power on again. If the error
persists, contact your Xerox representative.
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PROBABLE CAUSES SOLUTIONS

The printer is connected to an uninterruptible power
supply (UPS), extension cord, or power strip.

Only use an extension cord designed to handle the
electrical current capacity of the printer. For details,
refer to Electrical Specifications.

A network configuration problem exists.

Unplug the network cable. If the problem is not
resolved, contact your system administrator to
reconfigure your network installation.

The printer is connected to an outlet with a voltage or
frequency that does not match the printer
specifications.

Use a power source with the specifications listed in
Electrical Specifications.

PRINTER DOES NOT PRINT

PROBABLE CAUSES SOLUTIONS

The printer is in Power Saver mode.

On the control panel, press the Power/Wake button.

There is a printer error.

If the Status LED is blinking amber, there is an error.To
clear the error, follow the instructions on the control
panel. If the error persists, contact your Xerox
representative.

The paper tray is empty.

Load paper into the tray.

The printer toner cartridge is empty.

Replace the toner cartridge.

A drum cartridge has reached end of life.

Replace the drum cartridge.

All control panel indicators are off.

Power off the printer, confirm that the power cord is
plugged in correctly to the printer and the outlet, then
power on the printer. If the error persists, contact your
Xerox representative.

The printer is busy.

e [f the Status LED is flashing blue, check if a previous
print job is the problem.
1 At your computer, use the printer properties to
delete all print jobs in the print queue.
2 At the control panel, touch Jobs, then delete all
pending print jobs.
e Load the paper in the tray.

e [f the Status LED does not flash once after you
send a print job, check the connection between the
printer and the computer. Power off the printer,
then power on.

The printer cable is disconnected.

If the Status LED does not flash once after you send a
print job, check the connection between the printer
and the computer.
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PROBABLE CAUSES SOLUTIONS

There is a wireless or network connectivity issue.

To test the printer, print an Information Page, such as
the Basic Configuration Report. If the page prints, there
could be a wireless or network connectivity issue.

Contact your system administrator or refer to the
System Administrator Guide at www.xerox.com/office/
ALB81XXdocs.

Incorrect print driver.

Check that you have the latest print driver installed. For
details, go to www.xerox.com/office/ALB81XXsupport.

PRINTING TAKES TOO LONG

PROBABLE CAUSES SOLUTIONS

The printer is set to print on a paper type that requires
slower printing.

Certain paper types, like heavyweight paper and
transparencies, take more time to print. Ensure that the
print driver and control panel are set to the proper

paper type.

The printer is in Power Saver mode.

Wait. It takes time for printing to start after the printer
exits Power Saver mode.

The way the printer was installed on the network could
be an issue.

e Determine if a print spooler or a computer sharing
the printer is buffering all print jobs and then
spooling them to the printer. Spooling can slow
print speeds.

e To test the speed of the printer, print multiple
copies of an information page, such as a demo
page. If the page prints at the rated speed of the
printer, there could be a network or printer
installation issue. For additional help, contact the
system administrator.

The job is complex.

Wait. No action needed.

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide

285


https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALB81XX&PgName=Man
https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALB81XX&PgName=Man
https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALB81XX&PgName=Tech

Troubleshooting

DOCUMENT FAILS TO PRINT

PROBABLE CAUSES SOLUTIONS

Selected tray has wrong paper size loaded, or paper
type or color is not available.

To view the Job Status for a failed print on the touch

screen:

1 At the printer control panel, press the Home
button.

Touch Jobs.

3 From the jobs list, touch the held job name. The
resources required for the job appear on the control
panel.

4 Do one of the following:

e To print the job, replenish the resources
required. The job resumes automatically when
the required resources are available. If the job
does not print automatically, touch Resume.

e To choose an alternative paper source to enable
the job to print, touch Print On Alternate
Paper. Select a paper tray, then touch OK.

e To delete the print job, touch Delete. At the
prompt, touch Delete.

f Note: The Print On Alternate Paper option
is enabled using the Embedded Web
Server.

5 To return to the Home screen, press the Home
button.

Incorrect network settings.

To reset network settings, contact your system
administrator or refer to the System Administrator
Guide at www.xerox.com/office/ALB81XXdocs.

The way the printer was installed on the network could
be an issue.

e Ensure that the printer is connected to the network.

e Determine if a print spooler or a computer sharing
the printer is buffering all print jobs and then
spooling them to the printer. Spooling can slow
print speeds.

e To test the printer, print an information page, such
as the Basic Configuration Report. If the page
prints, there could be a network or printer
installation issue. For help, contact your system
administrator.
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PROBABLE CAUSES SOLUTIONS

Application and print driver have conflicting tray For details, see Document Prints from Wrong Tray.
selections.

An Imaging Security mark has been detected. The Imaging Security feature is enabled, and a security

document has been detected and deleted. For
information about the Imaging Security feature
settings, contact your system administrator or refer to
the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

DOCUMENT PRINTS FROM WRONG TRAY

PROBABLE CAUSES SOLUTIONS
Application and print driver have conflicting tray 1 Check the tray selected in the print driver.
selections. 2 Access the page setup or printer settings of the

application from which you are printing.

3 Set the paper source to match the tray selected in
the print driver or set the paper source to
Automatically Select.

4 Check that you have the latest print driver installed.
For details, go to www.xerox.com/office/
ALB81XXsupport.

f Note: To have the print driver select the tray, set
the tray used as the paper source to Auto
Selection Enabled.

PRINTER IS MAKING UNUSUAL NOISES

PROBABLE CAUSES SOLUTIONS
One of the trays is not installed correctly. Open and close the tray from which you are printing.
There is an obstruction or debris inside the printer. Power off the printer and remove the obstruction or

debris. If you cannot remove the obstruction, contact
your Xerox® service representative.

The printer beeps at each touch on the control panel. Check the Alerts setting. For details, refer to the System
Administrator Guide at www.xerox.com/office/
ALB81XXdocs.
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AUTOMATIC 2-SIDED PRINTING PROBLEMS

PROBABLE CAUSES SOLUTIONS

Unsupported or incorrect paper. Ensure that you are using the correct paper. Do not use
transparencies, envelopes, labels, or reloaded paper for
automatic 2-sided printing. For details, see Supported
Paper.

Incorrect setting. On the print driver Printing Options tab, select 2-Sided
Print.

DATE AND TIME ARE INCORRECT

PROBABLE CAUSES SOLUTIONS

The Date and Time Setup is set to Manual (NTP To change the Date and Time to Automatic, in the
Disabled). Embedded Web Server, enable NTP. For details, refer to
the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

The time zone, date, or time is set incorrectly. Set the time zone, date, and time manually. For details,
refer to the System Administrator Guide at www.xerox.
com/office/ALB81XXdocs.

SCANNER ERRORS

PROBABLE CAUSES SOLUTIONS

Scanner is not communicating. Power off the printer, and check the scanner cable.
Wait two minutes and power on the printer again.

If the problem is not resolved, contact your Xerox®
service representative.
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Troubleshooting

WIRELESS ADAPTER PROBLEMS

PROBABLE CAUSES SOLUTIONS

The Wireless Adapter is not recognized by the device. e Ensure that the USB port to which the Wireless
Adapter is connected is enabled. For details, refer to
the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

e If extension cable is used, ensure that it is attached
to the Wireless Adapter correctly.

e Ensure that the correct Wireless Adapter is installed.
The compatibility of the Wireless Adapter is
dependent on the device model and software
version.

Degradation in performance has occurred. Check the wireless signal strength for the Wireless
Adapter. For details, refer to the System Administrator
Guide at www.xerox.com/office/ALB81XXdocs. If the
wireless signal strength is low, do the following:

e Place the wireless router or Access Point (AP) in a
centralized location.

e Position the Wireless Adapter closer to the AP, and
ensure that the wireless router or AP is located
away from walls or large metal objects.

e Remove any physical obstructions between the AP
and the Wireless Adapter, and ensure that the
adapter is positioned away from walls or large
metal objects.

e Position the Wireless Adapter on the Xerox device in
direct view of the wireless router or AP.

e If applicable, consider upgrading the wireless router
or AP to a high-gain antenna that transmits the
wireless signals in one direction only.
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Troubleshooting

Paper Jams

LOCATING PAPER JAMS

& Warning: Parts that are near the fuser are hot. To prevent personal injury, never touch an area that has a
Caution label. Power off the printer immediately, then wait 40 minutes for the fuser to cool. After the
printer has cooled, try to remove the jammed paper. If the error on the control panel remains, contact
your Xerox representative.

® Caution: Do not attempt to clear any paper jams using tools or instruments. This action can damage the
printer permanently.

The following illustration shows where paper jams can occur along the paper path:

\m
)
Y

1. Door B

Bypass Tray

Door A

Left Tray

Duplex Automatic Document Feeder
Document Output Tray

Finisher Areas

G N o U & W N

Paper Trays 1-4
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MINIMIZING PAPER JAMS

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper types can
cause jams. If supported paper is jamming frequently in one area, clean that area of the paper path. To avoid
damage, always remove jammed paper carefully without tearing it. Try to remove the paper in the same direction it
normally moves through the printer. Even a small piece of paper left in the printer can cause a jam. Do not reload
paper that has jammed.

The following can cause paper jams:

e Selecting the incorrect paper type in the print driver.

e Using damaged paper.

e Using unsupported paper.

e Loading paper incorrectly.

e Overfilling the tray.

e Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:

e Use only supported paper. For details, refer to Supported Paper.

e Follow proper paper handling and loading techniques.

e Always use clean, undamaged paper.

e Avoid paper that is curled, torn, moist, creased, or folded.

e To separate the sheets before loading into the tray, fan the paper.
e Observe the paper tray fill line; never overfill the tray.

e Remove transparencies from the output tray immediately after printing.

e Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted can cause
poor print quality, misfeeds, skewed prints, and printer damage.

e After loading the trays, select the correct paper type and size on the control panel.
e When printing, select the correct type and size in the print driver.

e Store paper in a dry location.

e Use only Xerox paper and transparencies designed for the printer.

Avoid the following:

e Polyester coated paper that is designed especially for inkjet printers.

e Highly glossy or coated paper.

e Paper that is folded, wrinkled, or excessively curled.

e Fanning transparencies before loading in the paper tray.

e Loading more than one type, size, or weight of paper in a tray at the same time.

e Loading hole punched paper or paper with folded corners or staples in the document feeder.

e Overfilling the paper trays.
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¢ Allowing the output tray to overfill.

e Allowing the output tray to fill with more than a few transparencies.

CLEARING PAPER JAMS

To clear jams, watch the video and follow the instructions on the control panel. To resolve the error that appears on
the control panel, remove all paper from the areas shown. If the error does not clear, check the jam areas again to
ensure that all paper has been removed. Ensure that all levers, covers, and doors have been closed correctly.

To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the paper in the same
direction it normally moves through the printer. Even a small piece of paper left in the printer can cause a jam. Do
not reload paper that has jammed.

j’ Note: Do not touch the printed side of the paper when removing it. The printed side of jammed pages could
smudge, and the toner could stick to your hands. Avoid spilling any toner inside the printer.

& Warning: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If some
toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on your skin,
wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out immediately with
cool water and consult a doctor.

Duplex Automatic Document Feeder Jams

If a jam occurs in the duplex automatic document feeder areas, a message appears to indicate the areas that
require clearing. To clear the jam, clear the areas indicated, then reorder and reload your original documents in the
document feeder input tray. The device continues scanning the job from the point the job stopped, only scanning
the original documents remaining.

If your device has the multi-feed sensor installed and enabled, the device can detect if a multi-feed of original
documents is going through the duplex automatic document feeder. If a multi-feed condition occurs, the device
stops scanning and a message appears at the control panel. The message indicates a jam in the duplex automatic
document feeder. The user can reload the original documents and continue the job with or without multi-feed
detection enabled for that job, or cancel the job.

For detailed instructions on how to configure the Document Feeder Multi-feed Detection setting, refer to the System
Administrator Guide at www.xerox.com/office/ALB81XXdocs.

If the original documents continue to jam, then for more information about the causes of document feeder jams
and potential solutions, refer to Jams in the Document Feeder.

Clearing Jams in the Document Feeder

(D Caution: Torn, wrinkled, or folded original documents can cause jams and damage the printer. To copy
torn, wrinkled, or folded original documents, use the document glass.
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1. Lift the lever and open the document feeder top cover

2. If the original document is not caught in the entry to the document feeder, pull the document straight out in
the direction shown.
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3. Clear the document feeder area. The instructions vary depending on your printer model:

e If the message on the control panel instructs you to turn the green wheel, turn the wheel in the direction
shown. Turning the green wheel moves the original document out of the feeder. Remove the jammed
document in the direction shown, then close the document feeder top cover.

e If the message on the control panel instructs you to clear the document feeder left cover area, remove the
jammed original document in the direction shown. Close the document feeder top cover, then close the
document feeder left cover.

4,
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5. To access the second-side scanning lens assembly, on the left side of the document cover, lower the lever.
Remove the original document in the direction shown.

6. If the original document is not visible when the document feeder top cover is opened, close the document
feeder. Lift the document feeder tray, then remove the jammed paper.

7. Lower the document feeder tray.

8. If the original document is not wrinkled or torn, load document into the feeder again, following the instructions
on the control panel. If your device has the multi-feed detection sensor, do one of the following:

To continue the job with multi-feed detection enabled, touch Try Again.

To continue the job without multi-feed detection enabled, touch Suppress Multi-feed Detection.

e To cancel the job, touch Cancel Job.

f Note: After clearing a document-feeder jam, reload the entire document, including the pages that are
scanned already. The printer skips the scanned pages automatically, then scans the remaining pages.

Paper Tray Jams

If a jam occurs in the paper tray areas, a message appears to indicate the areas or paper tray that requires clearing.
To clear the jam, follow the instructions on the touch screen to locate the jammed paper, then clear the jam. When
removing jammed paper from the device, remove the paper in the direction it was feeding, and take care not to
leave any remnants of paper in the device.

After the paper tray jam has been cleared, the device continues printing the job from where the job stopped.

If further paper tray jams are experienced, try to load fresh paper in the paper tray. The paper could have excessive

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide 295



Troubleshooting

curl, excessive moisture, or be damaged.

For more information about paper jam causes and potential solutions, refer to Paper Misfeeds and Paper Size Jams.

Clearing Jams at Trays 1-4

1. Before you remove any tray from the printer, view the paper jam message on the control panel. Remove the
jam that is shown on the control panel, then remove other paper jams.

2. Pull out the tray until it stops.

Lzl —

3. Remove the paper from the tray.

Lzl

4. If the paper is torn, remove the tray completely, then check inside the printer for torn pieces of paper.

5. Reload the tray with undamaged paper, then push the tray in until it stops.

6. At the control panel, if a prompt appears, select the correct paper size, type, and color.

To select a new paper size, touch Size.
To select a new paper type, touch Type.
To select a new paper color, touch Color.

To confirm the settings, touch Confirm.

Note: If a prompt does not appear, and you have changed the paper size, type, or color, update the
Required Paper Policies. For details, refer to the System Administrator Guide at www.xerox.com/office/

ALB81XXdocs.

7. Toreturn to the Home screen, press the Home button.
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Clearing Jams at the Bypass Tray

1. Remove the jammed paper from the tray. Ensure that the paper feed entrance where the tray connects to the
printer is clear.

Y

¥

3

2. If the paper is torn, check inside the printer for torn pieces of paper.
3. Fan the paper that you removed and ensure that all four corners of the paper are aligned.

4. Insert the paper into bypass tray with the printing side face down. Ensure that the leading edge of the paper
touches the paper feed entrance.

Y

AN

5. At the control panel, select the correct paper size, type, and color:
e To select a new paper size, touch Size.
e Toselect a new paper type, touch Type.
e To select a new paper color, touch Color.

6. To confirm the settings, touch Confirm.

Clearing Jams at Tray 6

To resolve the error that appears on the control panel, follow the instructions provided and remove all paper from
the Tray 6 area.

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide 297



Troubleshooting

1. Pull Tray 6 away from the side of the printer until the tray stops.

3.

4. Close the top cover, then push the tray back toward the printer, until it locks into position.
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5. At the high capacity feeder, squeeze the handle, and pull out Tray 6 until it stops.

6. Remove the damaged paper from the tray.

8. At the control panel, select the correct type and color.

e To select a new paper type, touch Type.
e To select a new paper color, touch Color.

9. To confirm the settings, touch Confirm.
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Clearing Jams at Door A

1. Remove paper from the left tray, then close the tray.

2. Lift the release lever for door A, then open door A as shown.

m_
ﬁ
T

N | /

& Warning: To avoid injury, use caution. The area around the fuser can be hot.

N

! Caution: Do not touch the transfer belt. Touching the belt can reduce image quality or damage the
transfer belt. Do not touch the transfer roller. Touching the roller can reduce image quality.
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Troubleshooting

3. Remove the jammed paper.
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4. If paper is jammed on the inside of door A, lift handle A3, then remove the jammed paper. Return handle A3 to
the original position.

E
%

R

5. If paper is jammed in the fuser, remove the jammed paper from areas A1 and A2.

a. To open the paper guide, pull handle A1 toward you.
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Troubleshooting

b. Remove any jammed paper in area A1.

9 |l
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Troubleshooting

e. Remove any jammed paper in area A2.

w2
f Note: If the paper is torn, remove all torn pieces of jammed paper from the printer.

f.  To close the paper guide, push down handle A2, then push in the handle until the paper guide clicks into
place.

6. If the paper is jammed at the exit to the center output tray, pull the jammed paper in the direction shown.

j’ Note: Toner can adhere to the transfer roller. The toner that does adhere to the transfer roller does not
affect print quality.
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7. To close door A, push up the door until it clicks into place.

=

Clearing Jams at Door B

1. To open door B, lift the release lever and open door B.

=
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Troubleshooting

2. Remove the jammed paper from the door B upper and lower areas.

‘&Q Note:

e If the paper is torn, remove all torn pieces of paper from the printer.

e If the paper is inaccessible, refer to Clearing Jams at Door A.

3. For paper that is jammed in the paper tray, open the tray and remove the paper.

4, To close door B, push up the door until it clicks into place.

TROUBLESHOOTING PAPER JAMS

Multiple Sheets Pulled Together

PROBABLE CAUSES

The paper tray is too full.

SOLUTIONS

Remove some of the paper. Do not load paper past fill
line.

The edges of the paper are not even.

Remove the paper, align the edges, and then reload it.

The paper is moist from humidity.

Remove the paper from the tray, and replace it with
new dry paper.

Too much static electricity is present.

e Try a new ream of paper.
e Do not fan transparencies before loading in tray.

Using unsupported paper.

Use only Xerox approved paper. For details, refer to
Supported Paper.

Humidity is too high for coated paper.

Feed paper one sheet at a time.
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Jams in the Document Feeder

PROBABLE CAUSES SOLUTIONS

Unsupported paper of the wrong size, thickness, or
type.

Use only Xerox-approved paper. For details, see
Supported Paper.

Originals are torn, previously stapled, bent, or folded.

Ensure that the originals are not torn, bent, or folded. If
previously stapled, remove all staples and separate the
sheets by fanning them.

The documents loaded in the document feeder exceed
the maximum capacity allowed.

Place fewer documents in the document feeder.

Improperly adjusted document feeder guides.

Adjust the paper guides to fit snugly against the paper
loaded in the document feeder.

Paper Misfeeds and Paper Size Jams

PROBABLE CAUSES ‘ SOLUTIONS

The paper is not correctly positioned in the tray.

e Remove the misfed paper and reposition it properly
in the tray.

e Adjust the paper guides in the tray to match the
size of the paper.

The paper tray is too full.

Remove some of the paper. Do not load paper past the
fill line.

The paper guides are not correctly adjusted to the
paper size.

1 Remove the paper.

2 Adjust the paper guides in the tray to match the
size of the paper.

3 Replace the paper.

The tray contains warped or wrinkled paper.

Remove the paper, smooth it out, and reload it. If it still
misfeeds, do not use that paper.

The paper is moist from humidity.

Remove the moist paper and replace it with new, dry
paper.

Using paper of the wrong size, thickness, or type.

Use only Xerox approved paper. For details, refer to
Supported Paper.
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Label and Envelope Misfeeds

Troubleshooting

PROBABLE CAUSES SOLUTIONS

The label sheet is facing the wrong way in the tray.

Load label sheets according to the instructions from
the manufacturer.

e Load labels face up in trays 1-4.

f Note: Do not load labels in Bypass Tray.

Envelopes are loaded in the wrong tray.

Use bypass tray to print envelopes.

Envelopes are loaded incorrectly in bypass tray.

To load envelopes in bypass tray:

e For envelopes with the flap on a long edge, load
envelopes face down with the flaps closed, and the
flaps toward the right.

e For envelopes with a self-seal flap on a short edge,
load envelopes face down with the flaps closed,
and the flaps toward the right.

e For envelopes with a non-adhesive flap on a short
edge, load envelopes face down with the flaps
open, and the flaps toward the left.

¢ Load C4 and custom-size envelopes longer than
320 mm (12.6 in.) short-edge feed, with the flaps
closed, and the flaps toward the right. For custom-
size envelopes, define a custom size on the control
panel.

Envelopes are loaded incorrectly in the envelope tray.

To load the envelope tray:

e For envelopes with the flap on a long edge, load
envelopes face up, with the flaps closed, and the
flaps on the left side of the tray.

e For 6 3/4 envelopes, and short-edge feed custom
envelope sizes, load envelopes with the flaps closed,
and the flaps toward the front.

Paper Jam Message Stays On

PROBABLE CAUSES SOLUTIONS

Some paper remains jammed in the printer.

Recheck the media path and make sure that you have
removed all of the jammed paper.

One of the printer doors is open.

Check the doors on the printer. Close any door that is
open.

fe Note: Check for, and remove, torn pieces of paper in the paper path.

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide 307



Troubleshooting

Jams During Automatic 2-Sided Printing

PROBABLE CAUSES SOLUTIONS

Using paper of the wrong size, thickness, or type. Use paper of the correct size, thickness, or type. For
details, see Supported Paper.

Paper type is set incorrectly in the print driver. Ensure that the paper type is set correctly in the driver
and that the paper is loaded in the correct tray. For
details, see Supported Paper.

Paper is loaded in the wrong tray. Ensure that paper is loaded into the correct tray. For
details, refer to Supported Paper.

Tray is loaded with mixed paper. Load the tray with only one type and size of paper.

CLEARING FINISHER JAMS

Clearing Jams in the Integrated Office Finisher

1. Open the finisher front door.

1i

re

‘&Q Note: If the paper is torn, remove all torn pieces of jammed paper from the printer.

308 Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide



Troubleshooting

3. Rotate the green knob in the direction shown, then carefully remove the jammed paper.

~ = = -

Clearing Jams in the Office Finisher

Clearing Jams Under the Office Finisher Top Cover

1. Pull up the lever on the top cover, then open the top cover.
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Troubleshooting

2. Remove the jammed paper.

j’ Note: If the paper is torn, remove all torn pieces of the jammed paper from the finisher.

3. Close the top cover of the finisher.

Clearing Jams in the Office Finisher Transport

1. To open the transport cover, lift the handle

of the center tray straight up.

2. Remove the jammed paper.

j’ Note: If the paper is torn, remove all torn pieces of the jammed paper from the finisher.

3. Close the transport cover.
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Troubleshooting

Clearing Jams in the Business Ready Finisher

Clearing Jams in the Center Tray

1. If the paper is jammed at the exit to the center output tray, pull the paper in the direction shown.

ey

Clearing Jams in the Finisher Transport

1. Open the finisher transport cover.
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Troubleshooting

2. Remove the jammed paper.

j’ Note: If the paper is torn, remove all torn pieces from the finisher.

3. Close the finisher transport cover.

Clearing Jams at Area 3a in the Business Ready Finisher

1. If the jammed paper is visible at the output tray exit, pull out the jammed paper in the direction shown.
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Troubleshooting

3. Lift handle 3q, then carefully remove the jammed paper.

j’ Note: If the paper is torn, remove all torn pieces of the jammed paper from the finisher.
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5. Close the front door of the Business Ready Finisher.

Clearing Jams at Area 3c in the Business Ready Finisher
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Troubleshooting

2. Move lever 3c to the left.

S —

3. Carefully remove the jammed paper.

j’ Note:

e If the paper is torn, remove all torn pieces of paper from the finisher.

e If the paper is inaccessible, or if the control panel prompts you, to release the jammed paper, rotate
knob 3b in the direction shown.

4,

5. Close the front door of the Business Ready finisher.

314 Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide



Clearing Jams at Area 3d in the Business Ready Finisher

1. Open the front door of the Business Ready Finisher.
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3. Carefully remove the jammed paper.

j’ Note: If the paper is torn, remove all torn pieces of the jammed paper from the finisher.
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4. Return lever 3d to the original position, then close the front door of the Business Ready Finisher.
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Clearing Jams at Area 4 in the Business Ready Finisher

1. Open the front door of the Business Ready Finisher.

2 R
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2. Grasp the handle, then pull out the booklet maker until it stops.
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3. Rotate knob 4 in either direction as shown, then carefully remove the paper.

j’ Note: If the paper is torn, remove all torn pieces of the jammed paper from the finisher.
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Troubleshooting

4. Return the booklet maker to its original position, then close the finisher door.
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2. To release the jammed paper, rotate knob 4 in the direction shown.
TN ) L

2

/
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Troubleshooting

3. Toremove the paper, pull the paper in the direction shown.

j’ Note: If the paper is torn, remove all torn pieces of the jammed paper from the finisher.
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4. Close the front door of the Business Ready Finisher.

Clearing Jams in the Tri-Fold Module

Clearing Jams at Area 2a in the Tri-Fold Module

1. Open the front door of the tri-fold module.

Ié::ﬁ/H
‘_‘_-_‘_-_'_'_‘_‘—-—-—-_._/

=

W

NN AY

N

2. Lift handle 2q, then carefully remove the jammed paper.

j’ Note: If the paper is torn, remove all torn pieces of paper from the folder.
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!

I
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3. Return handle 2a to the original position.
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4. Close the front door of the tri-fold module.
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Clearing Jams at Area 2b in the Tri-Fold Module

1. Open the front door of the tri-fold module.
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2. Move lever 2b to the left, then remove the jammed paper.

j’ Note: If the paper is torn, remove all torn pieces of paper from the folder.
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Troubleshooting

3. Return lever 2b to the original position.
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4. Close the front door of the tri-fold module.

Clearing Jams at Area 2e in the Tri-Fold Module

1. Open the front door of the tri-fold module.
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2. Open the folder tray, move lever 2e to the right, then carefully remove the paper.

j’ Note: If the paper is torn, remove all torn pieces of paper from the folder.
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Troubleshooting

3. Return lever 2e to the original position, then close the folder tray.

i @}“b

4. Close the front door of the tri-fold module.

Clearing Jams at Area 2f in the Tri-Fold Module

1. Open the front door of the tri-fold module.
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2. Open the folder tray, move lever 2f to the right, then carefully remove the paper.

j’ Note: If the paper is torn, remove all torn pieces of paper from the folder.
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Troubleshooting

3. Return lever 2f to its original position, then close the folder tray.

,IQ/LU

4. Close the front door of the tri-fold module.

Clearing Jams at Area 2g in the Tri-Fold Module

1. Open the front door of the tri-fold module.
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2. Open the folder tray, move lever 2g to the right, then carefully remove the paper.

f Note: If the paper is torn, remove all torn pieces of paper from the folder.

I

-
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3. Return lever 2g to the original position, then close the folder tray.
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4. Close the front door of the tri-fold module.

Clearing Staple Jams

Clearing Staple Jams in the Integrated Office Finisher

1. Open the finisher front door.

1i

3. Check inside the finisher for any loose staples, then remove the staples.
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Troubleshooting

4. To remove the staple cartridge, and open the clamp, pull the clamp in the direction shown.

5. Remove the jammed staples, then push the clamp in the direction shown until the clamp clicks into the locked
position.

& Warning: The points of the jammed staples are sharp. Remove the jammed staples carefully.

6. Grasp the staple cartridge handle, then insert the cartridge into the stapler until the cartridge clicks into
position.
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7. Close the finisher front door.

Clearing Staple Jams in the Office Finisher

Troubleshooting

& Warning: Do not perform this procedure while the printer is printing.

1. Open the finisher front door.

2. Pullthe stapler assembly toward you until it stops.

3. Push the stapler assembly to the right, as shown.
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Troubleshooting

4. To remove the staple cartridge, grasp the orange handle, then pull the handle toward you.

5. Check inside the finisher for any loose staples, then remove the staples.

6. To open the staple cartridge clamp, pull the clamp in the direction shown.

7. Remove the jammed staples, then push the clamp in the direction shown until the clamp clicks into the locked
position.

& Warning: The points of the jammed staples are sharp. Remove the jammed staples carefully.
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Troubleshooting

8. Grasp the orange handle, then insert the cartridge into the stapler assembly until the cartridge clicks into place.

9. Close the finisher front door.

Clearing Booklet Staple Jams in the Office Finisher

& Warning: Do not perform this procedure while the printer is printing.

1. Open the finisher side cover.

2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening and slide the
panels to the center.
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Troubleshooting

3. Hold the tabs on both sides of the staple cartridge and pull the cartridge out of the finisher.

4. To remove the jammed staples, pull the staples in the direction shown.

& Warning: The points of the jammed staples are sharp. Remove the jammed staples carefully.

5. Hold the tabs on both sides of the staple cartridge and insert the cartridge into the original position in the
finisher.

w2
/ Note: If you have trouble inserting the cartridge, ensure that the staples are positioned correctly in the
cartridge.

fo Note: The booklet maker uses two staple cartridges. Booklet stapling requires that both staple cartridges
contain staples.

6. Repeat the procedure for the other staple cartridge.

7. Close the finisher side cover.
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Clearing Main Staple Jams in the Business Ready Finisher

1. Open the front door of the Business Ready Finisher.
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4. To open the staple cartridge clamp, pull the clamp in the direction shown.

5. Remove the jammed staples, then push the clamp in the direction shown until the clamp clicks into the locked
position.

& Warning: The points of the jammed staples are sharp. Remove the jammed staples carefully.

6. Grasp the staple cartridge by the orange handle, then insert the cartridge into the stapler assembly until the
staple cartridge clicks into place.

7. Return the stapler assembly to the original position, then close the finisher door.
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Clearing Staple Jams in the Business Ready Finisher Booklet Maker

. %

1. Open the front

\
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2. Grasp the green handle, then pull out the booklet maker until it stops.

3. Toremove a staple cartridge from the booklet maker, push down on the staple cartridge handle, as shown, then
pull the cartridge out and up.

4. Turn over the staple cartridge.
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Troubleshooting

5. To remove the staple pack from the staple cartridge, press in the green tabs and pull back the handle, then lift
out the staple pack.

w2
/ Note: If you do not see the staple jam, remove the staple case.

6. To remove the staple case, press the rear of the case as shown. Remove the jammed staples, then return the
staple case to the original position.

\ .

fo Note: If you cannot see the staple jam, open the staple cartridge clamp.

7. To open the staple cartridge clamp, pull the clamp firmly in the direction shown.

& Warning: The points of the jammed staples are sharp. Remove the jammed staples carefully.
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8. Remove the jammed staples, then push the clamp in the direction shown until the clamp clicks into the locked
position.

9. To return the staple cartridge to the booklet maker, insert the staple cartridge, then push up on the cartridge
handle as shown.
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Clearing Hole Punch Jams

Clearing Hole-Punch Jams in the Office Finisher

If the printer stops printing and reports a hole-punch jam, empty the hole-punch waste container. For details, refer
to Emptying the Hole Punch Waste Container.

After emptying the hole-punch waste container, locate and remove any paper jams.
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Print, Copy, and Scan Problems

IDENTIFYING PRINT, COPY, AND SCAN PROBLEMS

Problems with the output quality of your printer can be a print-related, copy-related, or scan-related problem. A
quick test can help you to identify where a problem exists.

To identify if a problem is print-related or scan-related, do the following:
1. Print the Getting Started guide:

a. At the printer control panel, press the Home button.

b. Touch Device, then touch Information Pages.

c. Touch Getting Started, then touch Print.

d. Toreturn to the Home screen, press the Home button.
2. Check the quality of the printed output.

3. If the print quality appears poor, the problem is print-related. For possible solutions, refer to Print-Quality
Problems.

4. If the print quality meets your requirements, the problem is likely to be scanner-related.
a. Copy the Getting Started guide that you have printed.
b. Check the quality of the copy output.

c.  For any symptom of poor scan quality, refer to Copy and Scan Problems.

PRINT-QUALITY PROBLEMS

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, use the
information in this section to troubleshoot the problem. For more information, go to www.xerox.com/office/
ALB81XXsupport.

(D Caution: The Xerox Warranty or Service Agreement does not cover damage caused by using
unsupported paper or specialty media. For more information, contact your local Xerox representative.

j’ Note: To ensure consistent print quality, the toner cartridges and print cartridges for many devices are
designed to cease functioning at a predetermined point.

Controlling Print Quality

Various factors can affect the quality of the output of your printer. For consistent and optimum print quality, use
paper designed for your printer, and set the paper type correctly. Follow the guidelines in this section to maintain
optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. For details, refer to Environmental
Specifications.
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Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section for the best
print quality and to avoid jams:

e Use only Xerox approved paper. For details, refer to Supported Paper.

e Use only dry, undamaged paper.

(D Caution: Some paper and other media types can cause poor output quality, increased paper jams,

or damage your printer. Do not use the following:
e Rough or porous paper

e Inkjet paper

e Non-laser glossy or coated paper

e Paper that has been photocopied

e Paper that has been folded or wrinkled

e Paper with cutouts or perforations

e Stapled paper

e Envelopes with windows, metal clasps, side seams, or adhesives with release strips
e Padded envelopes

¢ Plastic media

e Iron-on transfer paper

e Ensure the paper type selected in your print driver matches the paper type on which you are printing.

e If you have the same size paper loaded in more than one tray, ensure that the proper tray is selected in the
print driver.

e Do not load more than one type, size, or weight of paper in the tray at a time.

e Store your paper and other media properly for optimum print quality. For details, refer to Paper Storage
Guidelines.

Solving Print-Quality Problems

Your printer is designed to produce high-quality prints consistently. If you observe print-quality problems, use the
information in this section to troubleshoot the problem. For more information, go to www.xerox.com/office/
ALB81XXsupport.

(D Caution: The Xerox Warranty or Service Agreement does not cover damage caused by using

unsupported paper or specialty media. For more information, contact your local Xerox representative.

j’ Note: To enhance the print quality, the toner cartridges, print cartridges, and drum cartridges for many
models are designed to cease functioning at a predetermined point.

Printing the Troubleshooting Print-Quality Pages

1. At the printer control panel, press the Home button.
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Troubleshooting

2. Touch Device.
3. Touch Information Pages.

4. To print procedures on resolving print-quality problems, touch Troubleshooting Print Quality Page, then
touch Print.

5. Compare your print-quality problems to the examples on the pages.

Eliminating the Paper or Media as the Problem

Damaged or unsupported paper or media can cause print-quality problems even when the printer, application, and
print driver are working perfectly. Use the following guidelines to eliminate the paper as the source of the print-
quality problem:

e Make sure that the printer supports the paper or media.

e Make sure that the printer is loaded with undamaged, dry paper.

e [f the condition of the paper or media is in doubt, replace it with new paper or media.

e Make sure that you have the proper tray selected in the print driver and from the control panel.

e Make sure that you have the correct paper type selected in the print driver and in the control panel of the
printer.

Isolating the Problem to the Printer or to the Application

When you are sure that the paper is supported and in good condition, use the following steps to isolate the
problem:

1. From the control panel of the printer, print the pages for Diagnosing Print Quality. For details, see Printing the
Troubleshooting Print-Quality Pages.

o If the pages printed properly, the printer is working properly and the print-quality problem is an application,
print driver, or print server problem.

e If the pages still have print-quality problems, the problem is in the printer.

2. If the pages printed properly, see Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print
Server.

3. If the pages still had print-quality issues, or did not print, see Troubleshooting Print-Quality Problems in the
Printer.

Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print Server

If the printer is printing properly from the control panel but you still have print-quality problems, the application,
print driver, or print server could be the cause.

To isolate the problem:
1. Print a similar document from another application and look for the same print-quality problems.

2. If the document has the same print-quality problem, it is probably a print driver or print server problem. Check
the print driver used for the print job.
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a. Navigate to the list of printers on your computer:
e For Windows Server 2008 and later, click Start > Settings > Printers.
e For Windows 7, click Start > Devices and Printers.
e For Windows 8, click Start > Control Panel > Devices and Printers.

e For Windows 10, click the Windows Start > Settings > Devices > Printers & Scanners. Scroll to
Related settings, then click Devices and printers.

j’ Note: If you are using a custom Start Menu application, it can change the navigation path to your list of

printers.
b. Right-click on the name of the printer.
¢.  From the drop-down list, select Properties.
e Ensure that the model name in the middle of the driver matches the model name of the printer.
e If the names do not match, install the proper print driver for the printer.
If the problem persists, delete then reinstall the print driver.

If the document printed without a print-quality problem, the application is probably the cause. Restart your
printer, restart the application, then print the document again. For more information, refer to Power Options.

If the problem still persists, ensure that you are not printing through a print server. If the problem persists, for
online support information, go to www.xerox.com/office/ALB81XXsupport.

Troubleshooting Print-Quality Problems in the Printer

If you have print-quality problems when printing a Graphics Demo Page or the Basic Configuration Report from the
control panel, the problem is in the printer.

To find the source of the problem:

1.

At the control panel, print the Troubleshooting Print Quality Page. For details, refer to Printing the
Troubleshooting Print-Quality Pages.

If the prints are too light to see print details, verify the following:
e The printer is loaded with undamaged, dry supported paper.
e The toner levels of one or more of the toner cartridges is not too low.

Compare the print-quality problems in your document to each of the examples on the Troubleshooting Print
Quality Page.

If you find a match on the Troubleshooting Print Quality Page, look in the Solutions column for the action to take to
resolve the problem.

If the problem persists, for online support information, go to www.xerox.com/office/ALB81XXsupport.

Performing the Print Calibration Procedure

1.

& WN
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At the printer control panel, press the Home button.
Touch Device.
Touch Tools.

Touch Troubleshooting > Calibration > Print Calibration > Next.
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5. Follow the onscreen instructions to run the Print Calibration procedure.

Print-Quality Problems and Solutions

Use the following table to find solutions to print-quality problems. When the print quality is poor, to correct the
problem, select the closest symptom from the following table and refer to the corresponding solution.

j’ Note: At the printer control panel, press the Home button. Touch Device > Information Pages >
Troubleshooting Print Quality Page > Print.

SYMPTOM SOLUTIONS

The output is too light.  To check the toner level, check the control panel, or
N use the print driver or the Embedded Web Server. If
™\ the toner cartridge is near empty, replace it. For

details, refer to Replacing the Toner Cartridge.

o Verify that the toner cartridge is approved for use in
this printer, and replace the toner cartridge, as
needed. For best results, use a Genuine Xerox toner
cartridge.

e Replace the paper with a recommended size and
type, and confirm that your printer and print driver
settings are correct.

o Verify that the paper is dry and that supported
paper is used. If not, change the paper.

e Change the paper type settings in the print driver.
In the print driver, on the Printing Options tab,
select Paper, then change the Other Type setting.

o Verify the Print Quality setting in the print driver. In
the print driver, on the Printing Options tab, ensure
that the Print Quality is set to Standard.

e Change the Darken Image setting. For details, refer

to the System Administrator Guide at www.xerox.
com/office/ALB81XXdocs.

Toner smears or the print rubs off.  Change the paper type settings in the print driver.
For example, change Plain to Lightweight

The output has stains on the back side.
Cardstock. In the print driver, on the Printing

e A

AN // Options tab, select Paper, then change the Other
[ ] Type setting.
AB C ° o Verify that the paper is the correct size, type, and
weight. If not, change the paper settings.
D E ‘ PY o Verify that the printer is plugged in to an outlet
that is providing the correct voltage and power.
Review the electrical specification of the printer

with an electrician, if necessary. For details, refer to
Electrical Specifications.

e Check the percentage of remaining life for the
drum cartridge. For details, refer to Supply Status.
When the remaining life is less than 20 percent,
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SYMPTOM SOLUTIONS

replace the drum cartridge. For details, refer to
Replacing the Drum Cartridge.

Random spots appear on the output, or the image is e Ensure that the toner cartridge is installed correctly.
blurry. e If you used a non-genuine brand toner cartridge,
. F\\\ install a Genuine Xerox toner cartridge.
. e Use the Rough paper type setting, or try a paper
A-B with a smoother surface.
. e Ensure that the humidity in the room is within
DEF specifications. For details, refer to Relative Humidity.
'3: e Replace the toner cartridge.
The output is blank. e Power off the printer, then power on again.
F\\\ e Clean the LED printhead. For details, refer to

Cleaning the Printhead Lens.
e Remove, then re-install the toner cartridge.
e Replace the toner cartridge.

o If the error persists, contact your Xerox
representative.

Black or white streaks appear on the output. ¢ Clean the LED printhead. For details, refer to
Cleaning the Printhead Lens.

e Replace the toner cartridge.

N
B e If the error persists, contact your Xerox
representative.

The output has a mottled appearance. « Verify that the paper is the correct size, type, and
b weight. If not, change the paper settings.
h e Ensure that the humidity in the room is within
- specifications. For details, refer to Relative Humidity.
- e Choose a different paper type at the control panel,

in the application, and in the print driver.
e Replace the paper.

e If the error persists, contact your Xerox
representative.

Ghosting appears on the printed output. e Verify that the paper is the correct size, type, and
weight. If not, change the paper settings.

340 Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide



Troubleshooting

SYMPTOM

SOLUTIONS

e Change the Paper Type settings in the print driver.
In the print driver, on the Printing Options tab,
select Paper, then change the Other Type setting.

e Check the percentage of remaining life for the
transfer belt. For details, refer to Supply Status.
When the percentage of remaining life is less than
20 percent, replace the transfer belt cleaner. For
details, refer to Replacing the Transfer Belt Cleaner

e Replace the toner cartridge.

e If the error persists, contact your Xerox
representative.

Auger marks appear on the printed output.

e To check the toner level, check the control panel, or
use the print driver or the Embedded Web Server.
For details, refer to Supply Status. If the toner
cartridge is near empty, replace it.

o Verify that the toner cartridge is approved for use in
this printer, and replace the toner cartridge, as
needed. For best results, use a Genuine Xerox toner
cartridge.

e Replace the toner cartridge.

o If the error persists, contact your Xerox
representative.

The output print is wrinkled or stained.

e Verify that the paper is the correct size, type, and
weight for the printer and that the paper is loaded
properly. If not, change the paper.

e Try a new ream of paper.

e Change the Paper Type settings in the print driver.
In the print driver, on the Printing Options tab,
select Paper then change the Other Type setting.

Envelopes are wrinkled or creased when printed.

Verify that the crease is within 30mm (1.2 in.) of the
four edges of the envelope.

e If yes, the printer is printing as expected. Your
printer is not faulty.

e If not, take the following actions:

—  Ensure that only C5 envelopes are loaded in
Bypass Tray

—  Ensure that envelopes are loaded properly in
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SYMPTOM SOLUTIONS

Bypass Tray. For details, refer to Loading
Envelopes in the Bypass Tray.

—  Follow the guidelines for printing on envelopes.
For details, refer to Guidelines for Printing
Envelopes.

The top margin is incorrect. e Ensure that the paper is loaded properly.

e Ensure that the margins are set correctly in the
application that you are using.

ABC
DEF

The printed surface of the paper is bumpy. e Clean the fuser rollers:

1 Print a solid image over the entire surface of
one sheet of paper.

A B C. 2 Load the printed sheet into the tray with the
printed side face down.

D E F. 3 To remove debris from the fuser rollers, pint five
blank pages.

COPY AND SCAN PROBLEMS

Your printer is designed to produce consistently high-quality scans and copies. If you observe quality problems, use
the information in this section to troubleshoot the problem. For more information, go to www.xerox.com/office/
ALB81XXsupport.

@ Caution: The Xerox Warranty or Service Agreement does not cover damage caused by using
unsupported paper or specialty media. For more information, contact your local Xerox representative.

Copy and Scan Problems and Solutions

If the copy or scan quality is poor, refer to the following table:

SYMPTOMS SOLUTIONS

Lines or streaks only present in copies made from the There is debris on the document glass. During
document feeder. scanning, the paper from the document feeder passes
over the debris, which creates lines or streaks. Clean all
glass surfaces with a lint-free cloth.

Spots present in copies made from the document glass. | There is debris on the document glass. When scanning,
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SYMPTOMS SOLUTIONS

the debris creates a spot on the image. Clean all glass
surfaces with a lint-free cloth.

The reverse side of the original document shows on the | Enable Background Suppression.
copy or scan.

The image is too light or too dark. Adjust the Lighten/Darken or Contrast settings.

If the problem persists, for online support information, go to www.xerox.com/office/ALB8 1XXsupport.

Performing the Copy Calibration Procedure

To optimize copy job quality, perform the Copy Calibration procedure.
1. At the printer control panel, press the Home button.

Touch Device.

Touch Tools.

Touch Troubleshooting > Calibration > Copy Calibration > Next.

A

To run the Copy Calibration procedure, follow the onscreen instructions.
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Fax Problems

If your printer cannot send and receive faxes, ensure that the printer is connected to an approved analog telephone
line. The fax machine cannot send or receive faxes when it is connected directly to a digital telephone line without

the use of an analog filter.

f Note: If the fax connection is poor, transmit the fax at a lower rate. For the Starting Rate, select Forced

(4800 bps).

PROBLEMS SENDING FAXES

SYMPTOMS

The document is not feeding
properly through the document
feeder.

PROBABLE CAUSES

The document is too thick, too thin,

or too small.

SOLUTIONS

Use the document glass.

The document is scanned at an
angle.

The document feeder width guides
are not adjusted to fit the width of
the document.

Adjust the document feeder width
guides so that they fit against the
document.

The fax received by the recipient is
blurry.

The document is positioned
incorrectly.

Position the document correctly.

The document glass is dirty.

Clean the document glass.

The text in the document is too
light.

Adjust the resolution. Adjust the
contrast.

There is a problem with the
telephone connection.

Verify that the telephone line is
working, then send the fax again.

There is a problem with one of the
fax machines.

Make a copy to verify that the
printer can make clean copies and
prints. If the copy prints correctly,
have the recipient verify that their
fax machine is operating correctly.

The fax received by the recipient is
blank.

The document was loaded
incorrectly.

If using the document feeder, place
the original document face up.

If using the document glass, place
the original document face down.

Fax was not transmitted.

The fax number is wrong.

Verify the fax number.

The telephone line is connected
incorrectly.

Verify the telephone line
connection. If the telephone line is
disconnected, connect it.

There is a problem with the fax
machine of the recipient.

Contact the recipient.

The fax feature is not installed or is

Ensure that the fax feature is
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PROBABLE CAUSES

not enabled.

Troubleshooting

SOLUTIONS

installed and enabled.

Server fax is enabled.

Ensure that server fax is disabled.

An access number is required to
connect to an outside line.

If the printer is connected to a PBX
system, it could be necessary to
enter a number to access the
outside telephone line.

The fax number needs a pause
between the prefix for an outside
line and the telephone number.

To insert a pause, touch the Dial
Pause button. A comma ()
appears in the corresponding
location.

If the problem persists, for online support information, go to www.xerox.com/office/ALB81XXsupport.

PROBLEMS RECEIVING FAXES

SYMPTOMS

The fax received by the recipient is
blank.

‘ PROBABLE CAUSES

There is a problem with the
telephone connection or with the
fax machine of the sender.

‘ SOLUTIONS

Verify that the printer can make
clean copies. If it can, have the
sender fax the document again.

The sender loaded the pages
incorrectly.

Contact the sender.

The printer answers the call but
does not print the fax.

The memory is full.

To increase available memory,
delete stored jobs and wait for the
existing jobs to complete.

The received fax size is reduced in
size.

The paper supply in the printer does
not match the document size sent.

Confirm the original size of the
documents, then load the
appropriate paper size in the
printer.

Faxes are not received
automatically.

The printer is set to receive faxes
manually.

Set the printer to receive faxes
automatically.

The memory is full.

If the printer is out of paper, faxes
and print jobs can deplete the
printer of memory. Load paper and
print the jobs stored in the memory.

The telephone line is connected
incorrectly.

Verify the telephone line
connection. If the telephone line is
disconnected, connect it.
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SYMPTOMS PROBABLE CAUSES SOLUTIONS
There is a problem with the fax Make a copy to verify that the
machine of the sender. printer can make clean copies and

prints. If the copy prints correctly,
have the recipient verify that their
fax machine is operating correctly.

If the problem persists, for online support information, go to www.xerox.com/office/ALB81XXsupport.

PRINTING FAX REPORTS

You can print the following fax reports from the printer control panel:
e Activity Report

e Protocol Report

e Fax Address Book Report

e Options Report

e Pending Jobs Report

For instructions on how to print fax reports, refer to the System Administrator Guide at www.xerox.com/office/
ALB81XXdocs.
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Getting Help

Xerox provides several automatic diagnostic utilities to help you maintain productivity and print quality.

VIEWING ERROR AND ALERT MESSAGES ON THE CONTROL PANEL

When an error or warning condition occurs, the printer alerts you of the problem. A message appears on the control
panel and the LED status light on the control panel flashes amber or red. Alerts inform you about printer conditions,
such as low supplies or open doors that require your attention. Error messages warn you about printer conditions
that prevent the printer from printing or degrade printing performance. If more than one condition occurs, only one
appears on the control panel.

To view a complete list of active error and alert messages:
1. At the printer control panel, press the Home button.
Touch Device.

Touch Notifications.

Touch Faults & Alerts, Alerts, or Faults.

To view details, touch a fault or alert.

To exit the Notifications screen, touch X.

N o v W N

To return to the Home screen, press the Home button.

VIEWING THE ERROR HISTORY ON THE CONTROL PANEL

When errors occur on the device, they are logged into an error history file by date, time, and associated fault code.
You can use this list to identify trends and resolve problems.

To view the error history:

1. At the printer control panel, press the Home button.
Touch Device.

Touch Notifications.

Touch Fault History.

To exit, touch X.

To exit the Notifications screen, touch X.

N o v &~ W N

To return to the Home screen, press the Home button.

SUPPORT LOGS
Use the Support Logs feature only if a Xerox service representative instructs you to do so.

Log files are text files of recent device activity that are created and stored in the device in an encrypted format. A
Xerox service representative can interpret the files to troubleshoot network problems.

f Note: Support logs can include screenshots that are taken at the device control panel.
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To capture a screenshot at the control panel, press the Power button, then touch the lower-left corner of the screen.
After the screenshot is taken, the file name of the image appears on the screen. The file name includes the date,
time, and serial number of the device.

f Note: The device can capture most screens. When pop-up windows are displayed, the device sometimes
captures the underlying screen only.

The screenshot images are stored with the log files. The device can store up to three screenshots for a maximum of
7 days. After 7 days, the files are deleted. If more than three screenshots are taken, the older files are deleted.

The Enhanced Logging feature enables the device to capture additional logs for specific functions or activities. A
Xerox service representative can use the additional logs to investigate non-repeatable or intermittent device issues.

j’ Note: The device supports enhanced logging for a maximum of three features at a time.

For information about configuring support log settings, refer to the System Administrator Guide at www.xerox.com/
office/ALB81XXdocs.

THE EMBEDDED WEB SERVER

The Embedded Web Server is the administration and configuration software that is installed in the printer. It allows
System Administrators to modify network and system settings on the printer remotely using a Web browser.

You can check the status of the printer, monitor paper and supply levels, and submit and track print jobs. All these
functions can be accessed from the convenience of your computer.

The Embedded Web Server requires:

e ATCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux environments.
e TCP/IP and HTTP enabled in the printer.

e A network-connected computer with a Web browser that supports JavaScript.

ONLINE SUPPORT ASSISTANT

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to solve your
printer problems. You can find solutions for print-quality problems, paper jams, software installation issues, and
more.

To access the Online Support Assistant, go to www.xerox.com/office/ALB8 1XXsupport.

INFORMATION PAGES

Your printer has a set of information pages that you can print. These pages include configuration and font
information, getting started pages, and more.

The following Information Pages are available:
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NAME DESCRIPTION

Basic Configuration Report

The Basic Configuration Report provides printer
information, including the serial number, installed
options, network settings, port setup, tray information,
and more.

Detailed Configuration Report

The Detailed Configuration Report provides

information about all of the printer settings, including
extensible services setup, security and authentication
server configuration, connectivity settings, and more.

Billing Summary

The Billing Summary Report provides information
about the device and a detailed listing of the billing
meters and sheet counts.

Getting Started

The Getting Started guide provides an overview of the
key features of the printer.

Troubleshooting Print Quality Page

The Troubleshooting Print Quality Page provides a list
of common print-quality problems and tips to help
solve them.

Supplies Usage Page

The Supplies Usage Page provides coverage
information and part numbers for reordering supplies.

Graphics Demo Page

Print this page to check the quality of graphics.

PCL Font List

The PCL Font List provides a printout of all PCL fonts
that are available on the printer.

PostScript Font List

The PostScript Font List provides a printout of all
PostScript fonts that are available on the printer.

Printing Information Pages

1. At the printer control panel, press the Home button.

2. Touch Device > Information Pages.

3. To print an information page, touch the needed page, then touch Print.

The printer prints the selected information page.

4. To return to the Home screen, press the Home button.

MORE INFORMATION

You can obtain more information about your printer from these sources:
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RESOURCE LOCATION

Installation Guide Packaged with the printer.

Getting Started guide Print from the control panel. For details, refer to
Information Pages.

Other documentation for your printer www.xerox.com/office/ALB81XXdocs

Recommended Media List United States: www.xerox.com/rmlna

European Union: www.xerox.com/rmleu

Technical support information for your printer, www.xerox.com/office/ALB81XXsupport
including online technical support, Online Support
Assistant, and print driver downloads.

Information Pages Print from the control panel. For details, refer to
Information Pages.

Embedded Web Server information In the Embedded Web Server, click Help.
Order supplies for your printer www.xerox.com/office/supplies
A resource for tools and information, including www.xerox.com/office/businessresourcecenter

interactive tutorials, printing templates, helpful tips,
and customized features to meet your individual needs.

Local sales and Technical Customer Support www.xerox.com/office/worldcontacts
Printer registration www.xerox.com/register
Xerox® Direct online store www.direct.xerox.com/

Locating the Serial Number

When you order supplies or contact Xerox for assistance, you need the serial number of your device. You can obtain
the serial number in several ways. To locate the serial number, print a configuration report, or view the serial number
on the control panel or on the Embedded Web Server home page. The serial number is printed on a label that is
affixed to the printer. To view the label, open the left side door.

For details on how to print a configuration report, refer to Information Pages.
To view the serial number on the control panel:
1. At the printer control panel, press the Home button.
2. Touch Device > About.
The model, serial number, and software version is displayed.

3. Toreturn to the Home screen, press the Home button.
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Printer Configurations and Options

STANDARD FEATURES

The printer provides the following features:

Copy, Print, Email, Scan, and Server Fax

Scan to USB and Print from USB mass storage devices

Workflow Scanning with Scan to Mailbox, Scan to Network, and Scan to Home
1-Touch Apps for Copy, Email, Scan To, Fax, Single Touch and Scan

Searchable PDF, Single or Multiple-Page PDF or XPS, or TIFF, Encrypted or Password-Protected PDF, and
Linearized PDF or PDF/A file formats

Copy speed of up to 70 ppm for black and white printing on A4 (210 x 297 mm) or Letter (8.5 x 11 in.) paper
1200 x 1200 dpi imaging and copying quality

Copy document sizes up to A3 (297 x 420 mm) or Tabloid (11 x 17 in.)

Print document size, with short-edge feed, up to SRA3 (320 x 450 mm) or 12 x 19 in.

Automatic 2-sided printing

Duplex Automatic Document Feeder

Color touch screen control panel

Smart proximity sensor

Trays 1-2 each with 520-sheet capacities

Bypass Tray with 100-sheet capacity

High Capacity Tandem Tray (Trays 3—4) with total 2000 A4 (210 x 297 mm) or Letter (8.5 x 11 in.) sheet
capacity

4-GByte DDR3 System Memory

Internal 128-GByte solid state drive (SSD)

Ethernet 10/100/1000Base-TX

High-Speed USB 2.0 direct print

Adobe® PostScript® and PCL® fonts and support

Xerox® Global Print Driver and Xerox® Pull Print Driver support

Automated supplies replenishment and management using Xerox® MeterAssistant®, Xerox® SuppliesAssistant®,
and Maintenance Assistant

Remote driver installation

Remote Control Panel and Configuration Cloning
Bonjour device discovery

Xerox® Standard Accounting

Encrypted Secure Print, Secure Fax, Secure Scan, and Secure Email
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Trellix® Data Security
j’ Note: Trellix® Data Security formerly known as McAfee® Data Security.

Xerox® Extensible Interface Platform
Xerox® Earth Smart Driver settings
Embedded Web Server

Xerox® CentreWare © Web

Email alerts

Support for mobile printing, mobile printing connectivity, and mobile apps
Xerox® App Gallery supported

NFC printing

Support for Mopria

Support for AirPrint

Xerox® Easy Assist App supported

OPTIONS AND UPGRADES

Integrated Office Finisher

Office Finisher

Booklet Maker and Creaser for Office Finisher

Hole Punch for Office Finisher

Business Ready Finisher with a 2-3, 2—-4, or Swedish Hole Punch

Business Ready Booklet Maker Finisher with a 2—-3, 2-4, or Swedish Hole Punch
Tri-Fold Module for Business Ready Finisher or Business Ready Booklet Maker Finisher
Envelope Tray

Long Sheet Feed Kit

High Capacity Feeder (Tray 6) with up to 3000-sheet capacity

Convenience Stapler and Work Surface

One-Line and Dual-Line Fax Kits

Fax forward to Email or SMB software

Xerox Secure Access Unified ID System

CAC and PIV Card Reader Enablement Kit

Xerox® Network Accounting Enablement

Xerox® Dual Band Wireless Kit

Wi-Fi Direct with optional Wireless Network Adapter

Foreign Device Interface (FDI)
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e Hard Disk Drive with Image Overwrite Kit, AES 256-bit Encryption that is FIPS 140 compliant, SHA-256 Hash
Message Authentication

e Trellix® Integrity Control Enablement Kit

f Note: Trellix® Integrity Control Enablement Kit formerly known as McAfee® Integrity Control

Enablement Kit.

Bluetooth Kit

RFID Card Reader Kit
SIPRNet Enablement Kit

Support for AirPrint® with iBeacon

Software for Unicode print

Xerox® Scan to PC Desktop® Professional software

f Note: For AirPrint® with iBeacon, the optional Bluetooth Kit is required.

FINISHING OPTIONS

FINISHING
OUTPUT DEVICE CAPACITY SIZES WEIGHTS OPTIONS
Left Tray 100 sheets All supported sizes All supported Not Applicable
) ) weights
For information on
supported sizes, For information on
refer to Supported supported weights,
Paper. refer to Supported
Paper.
Center Trays 250 sheets All supported sizes All supported Not Applicable
) ) weights
For information on
supported sizes, For information on
refer to Supported supported weights,
Paper. refer to Supported
Paper.
Integrated Office Stacking: 89 x98-297 x 432 | 52-256 g/m? Single and dual
Finish ling:
inisher 500 sheets A4, mm stapling
Letter 3.5x3.85-11x17 50 sheets A4, Letter
250 sheets A3, th 30 sheets of 80 g/
Tabloid m? Legal, B4, A3,
Tabloid
Office Finisher Stacking: 148 x 148-297 x 52-256 g/m? Multiple-position
2omsees | S
unstapled, 58 x5.8-11x17in. ping:
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FINISHING
OUTPUT DEVICE CAPACITY SIZES WEIGHTS OPTIONS
100 sets or 1000 Hole Punch:
sheets single-stapled Optional 2-3 , 2-4,
Swedish 4-hol
75 sets or 750 or SWecis o
hole Punch
sheets dual-stapled
Office Finisher with | Stacking: 148 x 148-297 x 52-256 g/m? Multiple-position
Booklet Maker 2000 sheets 432 mm zitr;glltienar](;(;:ll:s(leets
unstapled, 58x5.8-11x17in. ping:
100 sets or 1000 HOI? Punch:
heets sinale-stapled Optional 2-3, 2-4,
Sheets singiestapie or Swedish 4-hole
75 sets or 750 hole punch
sheets dual-stapled
Stacking Tray: 50 A4 SEF (Short-Edge Saddle stapling: 2—
sets or 600 sheets Feed), Letter SEF, B4 15 sheets of 64—
SEF, Legal SEF, A3 105 g/m?
SEF, Tabloid SEF
vl Score or Crease: 1-
15 sheets unstapled
Business Ready Top Tray: 500 sheets | Top Right Tray: 98 x | 52-300 g/m? Single-position and
Finisher Stack 148-320 x 483 mm multiple-position
tacking: lina: h
3.85 x 5.8-12.6 x stapling: 50 sheets
3000 slhzets 19 in. Hole punch:
unstapled, ional 2—=3. 2—4
Stacking: 203 x OpthﬂCl. 3 24,
200 sets single- 320-320 x 483 rmm or Swedish 4-Hole
position stapled or Punch
8x12.6-12.6x19
100 sets multiple- in.
position stapled
sheets, dual-stapled | Stapling: 182 x
203-297 x 432 mm
7.2x8-11.7x17in.
Business Ready Top Tray: 500 sheets | Top Right Tray: 98 x | 52-300 g/m? Single-position and

Finisher with Booklet
Maker

Stacking:

1500 sheets
unstapled

200 sets single-
position, dual, or 4-
position stapled

100 stapled sets A3
or Tabloid

148-320 x 483 mm

3.85x 5.8-12.6 x
19 in.

Stacking: 203 x
320-320 x 483 mm

8x12.6-126x19
in.

multiple-position
stapling: 50 sheets

Hole Punch:
Optional 2-3, 2-4,
or Swedish 4-hole
punch
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FINISHING
OUTPUT DEVICE CAPACITY SIZES WEIGHTS OPTIONS
Stapling: 182 x
203-297 x 432 mm
7.2x8-11.7x 17 in.
Tri-Fold Module 40 sheets C-Fold, Z-Fold: A4, 64-105 g/m? C-Fold, Z-Fold, and
Letter SEF Z-Half Fold
Z-Half Fold: A3,
Tabloid
Convenience Stapler | NA Any supported size | Any supported 50 sheets
. ' weight
For information on
supported sizes, For information on
refer to Supported supported weights,
Paper. refer to Supported
Paper.

f Note: Sheet quantities for tray capacities and finishing options are based on 80 g/m2 Quantities are
reduced for heavier media and must be within the specified weight range.
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Physical Specifications

BASE CONFIGURATION

114.7 cm (451 in.)
117.3 cm (46.2in.)*

-

723am(285in.)
793 am (31.2in.)*

‘B8170

e Width: 66.8 cm (26.3in.)

e Depth:
— B8145/B8155:72.3 cm (28.5in.)
— B8170:79.3cm (31.21in.)

e Height:
— B8145/B8155: 114.7 cm (45.1in.)
— B8170:117.3 cm (46.2 in.)

e Weight: <153.2 Kg (338 |b.)
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CONFIGURATION WITH INTEGRATED OFFICE FINISHER

114.7 cm (45.1in)
117.3 cm (46.2in.)*

723cm(285in) ~
793cm(31.2in)"

62cm
(244 in.)x

66.8 cm
(26.3in.)

*B8170

e Width: 66.8 cm (26.3 in.)

e Depth:
— B8145/B8155:72.3 cm (28.51n.)
- *B8170:79.3cm (31.21in.)

e Height:
— B8145/B8155: 114.7 cm (45.1 in.)

*B8170: 117.3 cm (46.2 in.)
e Weight: <164.2 Kg (362.2 |b.)

CONFIGURATION WITH HIGH CAPACITY FEEDER

1147 am (451 in.)
117.3 am (46.2in.)"*

793 cm(31.2in.)'v

e Width: 109.6 cm (43.15in.)
e Depth:
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— B8145/B8155:72.3 cm (28.51in.)
- *B8170:79.3cm (31.2in.)
e Height:
—  B8145/B8155: 1147 cm (45.1in.)
*B8170: 117.3 cm (46.2 in.)
e Weight: <184.2 Kg (406.1 b.)

CONFIGURATION WITH OFFICE FINISHER

114.7 cm (45.1 in.)
117.3 cm (46.2 in.)*|*

L

793 cm (31.2in)" ~_~

e Width: 125.5 cm (49.4in.)

e Depth:
— B8145/B8155:72.3 cm (28.51in.)
- *B8170:79.3cm (31.2in.)

e Height:
—  B8145/B8155: 114.7 cm (45.1in.)
— "B8170:117.3 cm (46.2 in.)

e Weight: <180.2 Kg (397.3 bb.)

CONFIGURATION WITH OFFICE FINISHER WITH BOOKLET MAKER

114.7 cm (45.1 in.)
1173 cm (46.2 i)' |

793 em (31.2in.)* \_>/
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e Width: 125.5cm (49.4in.)

e Depth:
— B8145/B8155:72.3 cm (28.51n.)
- "B8170:79.3cm (31.21in.)

e Height:
— B8145/B8155: 114.7 cm (45.1in.)

*B8170: 117.3 cm (46.2 in.)
e Weight: <190.2 Kg (419.3 bb.)

CONFIGURATION WITH HIGH CAPACITY FEEDER AND OFFICE FINISHER WITH BOOKLET
MAKER

114.7 cm (451 in.)
117.3 cm (46.2 in.)*

A<

e Width: 168.3 cm (66.3 in.)

e Depth:
— B8145/B8155:72.3 cm (28.5in.)

*B8170: 79.3 cm (31.2in.)

e Height:
— B8145/B8155: 114.7cm (45.1in.)
—  *B8170:117.3cm (46.2 in.)

o  Weight: <221.2 Kg (487.7 |b.)
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CONFIGURATION WITH BUSINESS READY FINISHER, BOOKLET MAKER, AND TRI-FOLD MODULE

114.7 cm (45.11n) [,
117.3 am (46.2 in.)*

723cm(285in) o
793cm (31.2in)" > *B8170

e Width: 167.5 cm (65.9 in.)

e Depth:
— B8145/B8155:72.3 cm (28.51in.)
- "B8170:79.3cm (31.21in.)

e Height:
— B8145/B8155: 114.7 cm (45.1in.)
- *B8170:117.3 cm (46.2in.)

e Weight: <248.3 Kg (547.4 1b.)

CONFIGURATION WITH HIGH CAPACITY FEEDER AND BUSINESS READY FINISHER, BOOKLET
MAKER, AND TRI-FOLD MODULE

1147 cm (45.1in.)
117.3 cm (46.2in)*

148.2cm

8 (583in)
il
793em(G12in),_~ \/ 88170

e Width: 148.2 cm (58.3in.)

e Depth:
— B8145/B8155:72.3 cm (28.51in.)
— *B8170:79.3 cm (31.2in.)

e Height:
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— B8145/B8155: 114.7 cm (45.1 in.)
- "B8170:117.3 cm (46.2in.)
e Weight: <279.3 Kg (615.7 |b.)
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Clearance Requirements

BASE CONFIGURATION

154.5cm (60.8in.)
1556 cm (61.2in.)*

(39in.)

509 cm
(20in.)

168.9 cm (66.5 in.)
1759 cm (69.3 in.)* +40 cm
(157 in)

+7 cm

*B8170 (28in.)

Installation Space
e Width: 133.9cm (52.7 in.)
e Depth:
— B8145/B8155:168.9 cm (66.5 in.)
- *"B8170:175.9 cm (69.3 in.)
e Height:
— B8145/B8155: 154.5 cm (60.8 in.)
*B8170: 155.6 cm (61.2 in.)
Clearance
e Front: 40 cm (15.7 in.)
e Rear: 10cm (3.91in.)
e Left: 579 cm (22.8in.)
e Right: 10cm (3.91in.)

+10cm

@.}

1339am
(527 in.)
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CONFIGURATION WITH INTEGRATED OFFICE FINISHER

|
>

154.5cm (60.8in.)
1556 am (61.2in.)*

+21.8 cm
(86in.)

(39in)

145.7 cm

168.9 cm (66.5in.) (57.4in.)

1759cm (69.3 in)* +40 cm

*B8170 (28in.)

Installation Space
e Width: 145.7 cm (57.4in.)
e Depth:
— B8145/B8155:168.9 cm (66.5 in.)
*B8170: 175.9 cm (69.3in.)
e Height:
— B8145/B8155: 154.5 cm (60.8 in.)
*B8170: 155.6 cm (61.2in.)
Clearance
e Front: 40 cm (15.7 in.)
e Rear: 10 cm (3.91in.)
e Lleft: 57.9.cm (22.8in.)
e Right: 21.8 cm (8.6 in.)
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CONFIGURATION WITH HIGH CAPACITY FEEDER

—

154.5 cm (60.8in.)
1556 cm (61.2in)*

(39in.)
1689 cm (66.5in.)

*B8170

Installation Space
e Width: 246.6 cm (97 in.)
e Depth:
— B8145/B8155:168.9 cm (66.5in.)
*B8170: 175.9 cm (69.3 in.)
e Height:
— B8145/B8155: 154.5 cm (60.8 in.)
*B8170: 155.6 cm (61.2 in.)
Clearance
e Front: 40 cm (15.7 in.)
Rear: 10 cm (3.9 in.)
Left: 25cm (9.8 in.)
Right: 10 cm (3.9 in.)
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CONFIGURATION WITH OFFICE FINISHER WITH BOOKLET MAKER

154.5cm (60.8 in)
1556 cm (61.2in)*

168.9 cm (66.5in.)

1759 cm (69 3 in))
*B8170 \/

Installation Space

e Width: 195.7 cm (77 in.)

e Depth:

— B8145/B8155:168.9 cm (66.5in.)
*B8170: 175.9 cm (69.3 in.)

e Height:

—  B8145/B8155: 154.5 cm (60.8 in.)
*B8170: 155.6 cm (61.2 in.)

Clearance

366

579cm
(228in)

Front: 40 cm (15.7 in.)
Rear: 10 cm (3.9 in.)
Left: 57.9 cm (22.8 in.)
Right: 5cm (2in.)

+5cm
(2in.)

58.7 cm
(23.1in.)

195.7 cm
(77 in.)
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CONFIGURATION WITH HIGH CAPACITY FEEDER AND OFFICE FINISHER WITH BOOKLET

MAKER

1545cm (60.8 in)
1556 cm (61.2in)*

ol

1689 cm (66.5in.)
1759 cm (69.3in.)*

*B8170 \/

Installation Space
e Width: 198.3 cm (78 in.)
e Depth:
- B8145/B8155: 168.9 cm (66.5in.)
*B8170: 175.9 cm (69.3 in.)
e Height:
— B8145/B8155: 154.5 cm (60.8 in.)
— *B8170:155.6 cm (61.21in.)
Clearance

e Front: 40 cm (15.7 in.)

Rear: 10 cm (3.9 in.)
Left: 25 cm (9.8 in.)

Right: 5 cm (2 in.)

(23.1in.)

198.3cm
(78in.)

726cm
(28.6in.)

+5cm
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CONFIGURATION WITH BUSINESS READY FINISHER, BOOKLET MAKER, AND TRI-FOLD MODULE

154.5cm (60.8 in.)
1556 cm (61.2in.)*

(3.9in.)

244 cm
579 cm (96in)

168.9 cm (66.5 in.)

1759 am (69.3V
*B8170

Installation Space
e Width: 244 cm (96 in.)
e Depth:
— B8145/B8155:168.9 cm (66.5 in.)
*B8170: 175.9 cm (69.3 in.)
e Height:
— B8145/B8155: 154.5 cm (60.8 in.)
*B8170: 155.6 cm (61.2in.)

Clearance

Front: 40 cm (15.7 in.)

Rear: 10 cm (3.9 in.)
Left: 57.9 cm (22.8 in.)

Right: 8 cm (3.1 in.)
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CONFIGURATION WITH HIGH CAPACITY FEEDER AND BUSINESS READY FINISHER, BOOKLET
MAKER, AND TRI-FOLD MODULE

154.5cm (60.8in.)
1556 cm (61.2in)*

(9.3in)

246.6 cm
(97.1in.)

168.9 cm (66.5in)

1759 am (69.3{_);/
*B8170

Installation Space

(28.6in.)

e Width: 246.6 cm (97.1in.)
e Depth:
- B8145/B8155: 168.9 cm (66.5in.)
*B8170: 175.9 cm (69.3 in.)
e Height:
— B8145/B8155: 154.5 cm (60.8 in.)
—  "B8170:155.6 cm (61.2 in.)
Clearance
e Front: 40 cm (15.7in.)
e Rear: 10 cm (3.91in.)
e Lleft: 72.6 cm (28.61in.)
e Right: 8 cm (3.1 in.)
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Environmental Specifications

TEMPERATURE

Operating: 10-28°C (50-83°F)

RELATIVE HUMIDITY

Operating: 15% to 85% (non-condensing)

ELEVATION

For optimum performance, use the printer at elevations below 2500 m (8200 ft.).
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Electrical Specifications

POWER SUPPLY

VOLTAGE FREQUENCY CURRENT REQUIRED
45-55 prints per minute 110-127 VAC +/-10% 50 Hz +/- 3 Hz 12 A
60 Hz +/- 3 Hz
220-240 VAC +/-10% 50 Hz +/- 3 Hz 8A
60 Hz +/- 3 Hz
70 prints per minute 110-127 VAC +/-10% 50Hz +/- 3 Hz 16 A
60 Hz +/- 3 Hz
220-240 VAC +/-10% S50 Hz +/- 3 Hz 10A
60 Hz +/- 3 Hz
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Performance Specifications

PRINTING RESOLUTION

Maximum Resolution: 1200 x 1200 dpi

PRINT SPEED

Xerox reports speeds for continuous printing using long-edge feed on A4 (210 x 297 mm, 8.27 x 11.69 in.) or Letter
(216 x 279 mm, 8.5 x 11 in.) Bond 60-105 g/m? (18-28 |b.) paper from any tray except for the Bypass Tray.

Several factors affect print speed:

e Paper orientation: For faster print speeds, you can load paper long-edge feed.

e Paper size: Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print speed.
e Paper weight: Lightweight prints faster than heavier paper, such as Cardstock and Labels.
e Paper type: Plain prints faster than Glossy.

You can achieve maximum print speed when you print on Plain, Letter/A4 paper, using long-edge feed. The slowest
print speed is approximately 10 ppm when you print on envelopes or media 150 mm wide or less.
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Environmental, Health, and Safety Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, contact:
e United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)

e FEurope: EHS-Europe@xerox.com

For product safety information in the United States and Canada, go to www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/msds.
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Regulatory Information

This appendix contains:

BASIC REGUIAEIONS .. e e et e 376
COPY REGUIATIONS ... e e e e et e et et 381
FOX REGUIATIONS ..ottt ettt et e e e e e e e e e e e 384
Material Safety DAta SNEETS ..........ii i 388
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Regulatory Information

Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are designed to
mitigate interference caused or received by this printer in a typical office environment.

UNITED STATES FCC REGULATIONS

This equipment is tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 and
Part 18 of the FCC Rules. These limits are designed to provide a reasonable protection against harmful interference
when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate a
radio frequency energy. If the equipment is not installed and used in accordance with these instructions, it can
cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to
cause harmful interference. Users are required to correct the interference at their own expense.

If this equipment does cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference with one or more of the
following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit that is different from where the receiver is connected.
e Consult the dealer or an experienced radio or TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to operate
this equipment.

& Warning: To ensure compliance with Part 15 and Part 18 of the FCC rules, use shielded interface cables.

XEROX® ALTALINK® B8100 AND C8100 SERIES PRINTERS

Xerox® AltaLink® B8100 and C8100 series printers comply with Part 15 of the FCC rules. Operation is subject to the
following two conditions:

e The devices are not used to cause harmful interference.

e The devices must accept any interference received, including any interference that can cause an undesired
operation.

Responsible party: Xerox Corporation
Address: 800 Phillips Road, Webster, NY 14580

Internet contact information: www.xerox.com

CANADA
This Class A digital apparatus complies with Canadian ICES-003 and ICES-001.

Cet appareil numérique de la classe A est conforme & la norme NMB-003 et NMB-001 du Canada.
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CERTIFICATIONS IN EUROPE

c € The CE mark applied to this product symbolizes a declaration of conformity by Xerox with the
following applicable Directives of the European Union as of the date indicated:

e April 16, 2014: Radio Equipment Directive 2014/53/EU

Xerox declares that the radio equipment models Xerox® AltaLink® B8100 and C8100 are in compliance with
Directive 2014/53/EU. The full text of the EU declaration of conformity can be found at the following Internet
address for the Xerox® AltaLink® B8100 Multifunction Printer and the Xerox® AltaLink® C8100 Color Multifunction
Printer: www.xerox.com/msds

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for the
environment.

& Warning:

e Changes or modifications to this equipment not specifically approved by the Xerox Corporation can
void the user authority to operate this equipment.

e External radiation from Industrial, Scientific, and Medical (ISM) equipment can interfere with the
operation of this Xerox device. If external radiation from ISM equipment interferes with this device,
contact your Xerox representative for assistance.

e Thisis aclass A product. In a domestic environment, this product can cause radio frequency
interference, in which case the user can be required to take adequate measures.

e To ensure compliance with European Union regulations, use shielded interface cables.

European Union Lot 4 Imaging Equipment Agreement Environmental Information

European Union Lot 19 on Light Sources

According to European Commission Ecodesign Directive, the light source contained within this product or its
components is intended to be used for Image Capture or Image Projection only, and is not intended for use in
other applications.

Environmental Information Providing Environmental Solutions and Reducing Cost

The following information has been developed to assist users and has been issued in relation to the European
Union (EU) Energy-Related Products Directive, specifically the Lot 4 study on Imaging Equipment. The Lot 4 study
on Imaging Equipment requires manufacturers to improve environmental performance of in-scope products and
supports the EU action plan on energy efficiency.

In-scope products are Household and Office equipment that meet the following criteria:

e Standard monochrome format products with a maximum speed less than 66 A4 images per minute

e Standard color-format products with a maximum speed less than 51 A4 images per minute

Environmental Benefits of Duplex Printing

Most Xerox products have duplex printing capability, also known as 2-sided printing. Two-sided printing enables you
to print on both sides of the paper automatically, and therefore helps to reduce the use of valuable assets by
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reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that on models greater than
or equal to 40-ppm color or greater than or equal to 45-ppm monochrome, the duplex function has been auto-
enabled during the setup and driver installation. Some Xerox models below these speed bands can be enabled with
2-sided printing settings defaulted on at the time of installation. Continuous use of the duplex function reduces the
environmental impact of your work. However, if you require 1-sided printing, you can change the print settings in
the print driver.

Paper Types

This product can be used to print on both recycled paper and virgin paper, approved to an environmental
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper of 60 g/m?,
which contains less raw material and thus saves assets per print, can be used in certain applications. You are
encouraged to verify if lighter weight paper is suitable for your printing needs.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and
purchase of energy-efficient models, which help to reduce the environmental impact.
Details on the ENERGY STAR program and models qualified to ENERGY STAR can be found
at the following website: www.energystar.gov.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between the United
States, European Union, Japanese governments, and the office equipment industry. This
image-equipment program promotes energy-efficient copiers, printers, fax, multifunction
printers, personal computers, and monitors. Reducing product energy consumption helps to
combat smog, acid rain, and long-term changes to the climate by decreasing the emissions
that result from generating electricity.

For more information on energy or other related topics, go to www.xerox.com/environment or www.xerox.com/
environment_europe.

Power Consumption and Activation Time

The amount of electricity that a device consumes depends on the way the device is used. This device is designed
and configured to enable you to reduce your electricity usage.

To reduce energy consumption, your device is configured to use Energy Saver modes. After the last print, the device
transitions to Ready mode. In Ready mode, the device can print again immediately. If the device is not used for a
specified period, the device transitions to Sleep mode. To reduce power consumption, only essential functions
remain active in Sleep mode. The device takes longer to produce the first print after it exits Sleep Mode, than it
takes to print in Ready mode. This delay is the result of the printer that wakes up and is typical of most imaging
devices on the market.

To save power, you can configure Energy Saver modes. The following options are available:

o Job Activated: The device wakes when it detects activity. To set the delay before the device enters Sleep Mode,
enter the number of minutes.

e Sleep and wake up at scheduled times: The device wakes and sleeps according to a schedule that you
specify.
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e Auto Power Off: To allow the device to power off after a period of time in Sleep Mode, select Auto Power Off.
To set the delay before the printer powers off from the Sleep Mode setting, enter the number of hours.

To change the Energy Saver mode settings, refer to the System Administrator Guide at www.xerox.com/office/
ALB81XXdocs. For further assistance, contact your System Administrator.

To learn more about Xerox participation in sustainability initiatives, go to: www.xerox.com/environment or www.
xerox.com/environment_europe.

¢ Note:

e Energy Saver cannot be deactivated.

e Changing the default Energy Saver activation times can result in an overall higher energy consumption
of the device. Before you set a long activation time for Energy Saver modes, consider the increase in
device power consumption.

Default Energy Saver Settings

This device is ENERGY STAR®-qualified under the ENERGY STAR Program Requirements for Imaging Equipment. The
transition time from Ready mode to Sleep mode can be set from 0-60 or 0-120 minutes, depending on printer
model. The default value is set to O minutes. The maximum transition time from Ready mode to Sleep mode can
take up to 120 minutes, depending on printer model.

To change the Energy Saver settings, contact your System Administrator, or refer to the System Administrator Guide
at: www.xerox.com/office/ALB81XXdocs

EURASIAN ECONOMIC COMMUNITY CERTIFICATION

Economic Community, or EurAsEC. The Eurasian Economic Community members anticipate

[ H [ Russia, Belarus, and Kazakhstan are working to establish a common customs union, the Eurasian
sharing a common regulatory scheme and common EurAsEC certification mark, the EAC Mark.

Regulatory Information for 2.4-GHz and 5-GHz Wireless Network Adapters

This product contains a 2.4-GHz and 5-GHz Wireless LAN radio transmitter module that complies with the
requirements specified in FCC Part 15, Industry Canada RSS-210, and European Council Directive 2014/53/EU.
Radio Frequency (RF) output power of this device does not exceed 20 dBm in either frequency band.

Operation of this device is subject to the following two conditions:
1. This device may not cause harmful interference.
2. This device must accept any interference received, including interference that can cause an undesired operation.

Changes or modifications to this device not approved by the Xerox Corporation can void the user’s authority to
operate this equipment.
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GERMANY

Germany - Blue Angel

__.ég‘*""”%_ RAL, the German Institute for Quality Assurance and Labeling, has awarded this device the Blue
i N Angel Environmental Label. This label distinguishes it as a device that satisfies Blue Angel criteria
"'-%%Mﬁgf' for environmental acceptability in terms of device design, manufacture, and operation. For more

information, go to: www.blauer-engel.de.

Blendschutz

Das Gerdt ist nicht fir die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um
storende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren
Gesichtsfeld platziert werden.

Importeur

Xerox GmbH
Hellersbergstrafe 2-4
41460 Neuss

Deutschland

TURKEY ROHS REGULATION
In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”

“EEE yonetmeligine uygundur.”
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Copy Regulations

UNITED STATES

Congress, by statute, has forbidden the reproduction of the following subjects under certain circumstances. Penalties
of fine or imprisonment can be imposed on those guilty of making such reproductions.

1. Obligations or Securities of the United States Government, such as:
e Certificates of Indebtedness.
¢ National Bank Currency.
e Coupons from Bonds.
o Federal Reserve Bank Notes.
o Silver Certificates.
e (Gold Certificates.
e United States Bonds.
e Treasury Notes.
e Federal Reserve Notes.
e Fractional Notes.
e Certificates of Deposit.
e Paper Money.
e Bonds and Obligations of certain agencies of the government, such as FHA and so on.

e Bonds. United States Savings Bonds can be photographed only for publicity purposes for the campaign of
the sale of such bonds.

e Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a canceled
revenue stamp, this can be done provided the reproduction of the document is performed for lawful
purposes.

e Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps can be photographed,
provided the reproduction is in black and white and is less than 75 % or more than 150 % of the linear
dimensions of the original document.

e Postal Money Orders.
e Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.

e Stamps and other representatives of value, of whatever denomination, which have been or can be issued
under any Act of Congress.

e Adjusted Compensation Certificates for Veterans of the World Wars.
2. Obligations or Securities of any Foreign Government, Bank, or Corporation.

3. Copyrighted materials, unless permission of the copyright owner has been obtained or the reproduction falls
within the fair use or library reproduction rights provisions of the copyright law. Further information of these
provisions can be obtained from the Copyright Office, Library of Congress, Washington, D.C. 20559. Ask for
Circular R21.
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Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates can be photographed.
Passports. Foreign Passports can be photographed.
Immigration papers.

Draft Registration Cards.

© N o b

Selective Service Induction papers that bear any of the following Registrant information:
e Earnings or Income.

e Court Record.

e Physical or mental condition.

e Dependency status.

e Previous military service.

e Exception: United States military discharge certificates can be photographed.

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the various
Federal Departments, such as FBI, Treasury, and so on, unless a photograph is ordered by the head of such
department or bureau.

Reproducing the following items is prohibited in certain states:
e Automobile Licenses

e Driver Licenses

o Automobile Certificates of Title

The preceding list is not all-inclusive, and no liability is assumed for its completeness or accuracy. If there is doubt,
consult your attorney.

For more information about these provisions, contact the Copyright Office, Library of Congress, Washington, D.C.
20559. Ask for Circular R21.

CANADA

Parliament, by stature, has forbidden the reproduction of the following subjects under certain circumstances.
Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions.

e Current bank notes or current paper money
e Obligations or securities of a government or bank
e Exchequer bill paper or revenue paper

e The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of a court of
law

e Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause same to
purport to have been printed by the Queens Printer for Canada, or the equivalent printer for a province)

e Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a province,
the government of a state other than Canada or a department, board, Commission, or agency established by
the Government of Canada or of a province or of a government of a state other than Canada
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Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of a province
or by the government of a state other than Canada

Documents, registers, or records kept by public officials charged with the duty of making or issuing certified
copies thereof, where the copy falsely purports to be a certified copy thereof

Copyrighted material or trademarks of any manner or kind without the consent of the copyright or trademark
owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is assumed for its
completeness or accuracy. In case of doubt, consult your solicitor.

OTHER COUNTRIES

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be imposed on
those found guilty of making such reproductions.

Currency notes

Bank notes and checks

Bank and government bonds and securities

Passports and identification cards

Copyright material or trademarks without the consent of the owner

Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, contact
your legal counsel.
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Fax Regulations
UNITED STATES

Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other
electronic device, including a fax machine, to send any message unless such message clearly contains in a margin
at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it is sent
and an identification of the business or other entity, or other individual sending the message and the telephone
number of the sending machine or such business, other entity, or individual. The telephone number provided may
not be a 900 number or any other number for which charges exceed local or long-distance transmission charges.

For instructions on programming the Fax Send Header information, refer to the section of the System Administrator
Guide on Setting Transmission Defaults.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council
for Terminal Attachments (ACTA). On the cover of this equipment is a label that contains, among other information,
a product identifier in the format US:AAAEQ#H#TXXXX. If requested, this number must be provided to the Telephone
Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must comply with
the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular
plug are provided with this product. The product connects to a compatible modular jack that is also compliant.
Refer to installation instructions for details.

You can connect the printer safely to the following standard modular jack: USOC RJ-11C using the compliant
telephone line cord with modular plugs provided with the installation kit. Refer to the installation instructions for
details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be connected to a
telephone line. Excessive RENs on a telephone line can result in the devices not ringing in response to an incoming
call. In most but not all areas, the sum of RENs does not exceed five (5.0). To be certain of the number of devices
that can be connected to a line, as determined by the RENs, contact the local Telephone Company. For products
approved after July 23, 2001, the REN is part of the product identifier that has the format US:AAAEQ##TXXXX. The
digits represented by ## are the REN without a decimal point, for example, 03 is a REN of 0.3. For earlier products,
the REN is shown separately on the label.

To order the correct service from the local Telephone Company, you could also have to quote the codes in the
following list:

e Facility Interface Code (FIC) = 02LS2
e Service Order Code (SOC) = 9.0Y

(D Caution: Ask your local Telephone Company for the modular jack type installed on your line. Connecting
this printer to an unauthorized jack can damage the telephone company equipment. You, not Xerox,
assume all responsibility and liability for any damage caused by the connection of this printer to an
unauthorized jack.
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If this Xerox® equipment causes harm to the telephone network, the Telephone Company could discontinue the
service temporarily to the telephone line to which the printer is connected. If advance notice is not practical, the
Telephone Company notifies you of the disconnection as soon as possible. If the Telephone Company interrupts
your service, they can advise you of your right to file a complaint with the FCC if you believe that it is necessary.

The Telephone Company can change its facilities, equipment, operations, or procedures which can affect the
operation of the equipment. If the Telephone Company changes something that affects the operation of the
equipment, they should notify you so that you can make the necessary modifications to maintain uninterrupted
service.

If you experience trouble with this Xerox® equipment, contact the appropriate service center for repair or warranty
information. Contact information is contained in the Device app on the printer and in the Troubleshooting section
of the User Guide. If the equipment is causing harm to the telephone network, the Telephone Company can
request that you disconnect the equipment until the problem is resolved.

Only a Xerox Service Representative or an authorized Xerox Service provider is authorized to make repairs to the
printer. The printer repair applies at any time during or after the service warranty period. If an unauthorized repair is
performed, the remainder of the warranty period is null and void.

This equipment cannot be used on party lines. Connection to a party line service is subject to state tariffs. Contact
the state public utility commission, public service commission, or corporation commission for information.

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that the
installation of this Xerox® equipment does not disable your alarm equipment.

If you have questions about what can disable alarm equipment, consult your Telephone Company or a qualified
Xerox installer.

CANADA

This product meets the applicable Innovation, Science, and Economic Development Canada technical
specifications.

A representative designated by the supplier coordinates repairs to the certified equipment. Repairs or alterations
made by the user to this device, or device malfunctions, can cause the telecommunications company to request
that you disconnect the equipment.

For user protection, make sure that the printer is grounded properly. The electrical ground connections of the power
utility, telephone lines, and internal metallic water pipe systems, if present, must be connected together. This
precaution can be vital in rural arecs.

(D Caution: Do not attempt to make such connections yourself. Contact the appropriate electric inspection
authority, or electrician, to make the ground connection.

The Ringer Equivalence Number (REN) indicates the maximum number of devices allowed to be connected to a
telephone interface. The termination of an interface can consist of any combination of devices, subject only to the
requirement that the sum of the RENs of all the devices not exceed five. For the Canadian REN value, refer to the
label on the equipment.

Canada CS-03 Issue 9

This product has been tested to and is compliant with CS-03 issue 9.
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EUROPEAN UNION

Radio Equipment and Telecommunications Terminal Equipment Directive

This device has been designed to work with the national public switched telephone networks and compatible PBX
devices of the following countries:

PAN-EUROPEAN ANALOG PSTN AND COMPATIBLE PBX CERTIFICATIONS

Austria Greece Netherlands
Belgium Hungary Norway
Bulgaria Iceland Poland

Cyprus Ireland Portugal

Czech Republic Italy Romania
Denmark Latvia Slovakia

Estonia Liechtenstein Slovenia

Finland Lithuania Spain

France Luxembourg Sweden
Germany Malta United Kingdom

If you have problems with your product, contact your local Xerox representative. This product can be configured to
be compatible with other country networks. Before reconnecting the device to a network in another country,
contact your Xerox representative for assistance.

j’ Note:

e Although this product can use either loop disconnect (pulse) or DTMF tone signaling, Xerox recommends
that you use DTMF signaling. DTMF signaling provides reliable and faster call setup.

e Modification of this product, or connection to external control software or control apparatus not
authorized by Xerox, invalidates its certification.

NEW ZEALAND

1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has accepted that the
item complies with minimum conditions for connection to its network. The permit indicates no endorsement of
the product by Telecom, does not provide any sort of warranty, and does not imply that any Telepermitted
product is compatible with all Telecom network services. Above all, the permit provides no assurance that any
item works correctly in all respects with another item of Telepermitted equipment of a different make or model.

The equipment may not be capable of correct operation at the higher data speeds designated. Data speeds of
33.6kbps and 56kbps connections are likely to be restricted to lower bit rates when connected to some PSTN
implementations. Telecom accepts no responsibility for difficulties that arise in such circumstances.

2. Immediately disconnect this equipment if it becomes physically damaged, then arrange for its disposal or
repair.
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3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom customers.

4, This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is no
guarantee that Telecom lines shall continue to support pulse dialing.

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, can give rise to
the bell tinkle or noise and cause a false-answer condition. If you encounter such problems, do not contact the
Telecom Faults Service.

6. DTMF tones dialing is the preferred method because it is faster than pulse decadic dialing and is readily
available on almost all New Zealand telephone exchanges.

Warning: No 111 or other calls can be made from this device during a mains power failure.

7. This equipment may not provide for the effective hand-over of a call to another device connected to the same
line.

8. Some parameters required for compliance with Telecom Telepermit requirements depend on the equipment or
computer associated with this device. The associated equipment shall be set to operate within the following
limits for compliance with Telecom Specifications:

For repeat calls to the same number:

e There shall be no more than 10 call attempts to the same number within any 30minute period for any
single manual call initiation.

e The equipment can go on-hook for not less than 30 seconds between the end of one call attempt and the
beginning of the next call attempt.

For automatic calls to different numbers:

The equipment shall be set to ensure that automatic calls to different numbers are spaced such that there is no
less than 5 seconds between the end of one call attempt and the beginning of the next call attempt.

9. For correct operation, the total RNs of all devices connected to a single line at any time should not exceed five.

SOUTH AFRICA

This modem must be used in conjunction with an approved surge-protection device.
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Material Safety Data Sheets

For Material Safety Data information regarding your printer, go to:
e North America: www.xerox.com/msdsna

e FEuropean Union: www.xerox.com/msds

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.
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Recycling and Disposal

This appendix contains:
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All Countries

If you are managing the disposal of your Xerox product, note that the printer may contain lead, mercury,
perchlorate, and other materials whose disposal may be regulated due to environmental considerations. The
presence of these materials is fully consistent with global regulations applicable at the time that the product was
placed on the market. For recycling and disposal information, contact your local authorities. Perchlorate Material:
This product may contain one or more Perchlorate-containing devices, such as batteries. Special handling may
apply. For more information, go to www.dtsc.ca.gov/hazardouswaste/perchlorate.

390 Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide


http://www.dtsc.ca.gov/hazardouswaste/perchlorate

Recycling and Disposal

North America

Xerox operates an equipment take-back and reuse or recycle program. Contact your Xerox representative at 1-800-
ASK-XEROX to determine if your Xerox product is part of the program. For more information about Xerox
environmental programs, visit www.xerox.com/environment, or for recycling and disposal information, contact your

local authorities.
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European Union

Some equipment is used in both a domestic or household application and in a professional or business application.

DOMESTIC/HOUSEHOLD ENVIRONMENT

Application of this symbol on your equipment is confirmation that you should not dispose of the
equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be
segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to designated
collection facilities free of charge. Please contact your local disposal authority for information.

In some member states, when you purchase new equipment, your local retailer may be required to take back your
old equipment free of charge. Please ask your retailer for information.

PROFESSIONAL/BUSINESS ENVIRONMENT

Application of this symbol on your equipment is confirmation that you must dispose of this
equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be
managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back information.
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COLLECTION AND DISPOSAL OF EQUIPMENT AND BATTERIES

These symbols on the products and/or accompanying documents mean that used
electrical and electronic products and batteries should not be mixed with general
household waste.

[ ] For proper treatment, recovery, and recycling of old products and used batteries, please
take them to applicable collection points, in accordance with your national legislation
and the Directive 2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to save valuable
resources and prevent any potential negative effects on human health and the
environment which could otherwise arise from inappropriate waste handling.

For more information about collection and recycling of old products and batteries, please
contact your local municipality, your waste disposal service or the point of sale where
you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in accordance with
national legislation.

Business Users in the European Union

If you wish to discard electrical and electronic equipment, contact your dealer or supplier for further information.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items, contact your local
authorities or dealer and ask for the correct method of disposal.

BATTERY SYMBOL

This wheeled bin symbol may be used in combination with a chemical symbol. Use of
this symbol establishes compliance with the requirements set out by the Directive.

BATTERY REMOVAL

Batteries should only be replaced by a manufacturer-approved service facility.
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Other Countries

Contact your local waste management authority to request disposal guidance.
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This appendix contains:

PrOdUCE SYMIDOIS ... e 396

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide 395



Product Symbols

Product Symbols
SYMBOL DESCRIPTION

Warning:

Indicates a hazard that can result in serious injury or death if not avoided.

Hot Surface:

Hot surface on or in the printer. To avoid personal injury, use caution.

Warning:

Moving parts. To avoid personal injury, use caution.

Caution:

Indicates a mandatory action to take to avoid damage to the property.

Do not touch the part or area of the printer.

Do not touch this part of the printer.

Do not touch the part or area of the printer.

Do not expose the drum cartridges to direct sunlight.

Do not burn the item.

Do not burn the toner cartridges.

Do not burn the drum cartridges.

PRI SODPPP
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SYMBOL DESCRIPTION

Do not burn the toner waste cartridge.

Pinch Hazard:

To avoid personal injury, use caution in this area.

Pinch Hazard:

To avoid personal injury, use caution in this area.

Do not remove the paper forcefully.

Hot Surface:

Before handling, wait for the time indicated.

On

Off

Standby

Do not use paper attached with staples or any form of binding clip.

Do not use folded, creased, curled, or wrinkled paper.

Do not load or use inkjet paper.

Do not reload paper that is used or printed previously.

@OO@CO
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SYMBOL DESCRIPTION

@ Do not use postcards.
@ Do not use envelopes.
Do not copy money.
5-®@
\L' Add paper or media.
Paper jam
®]
(8]
9 Lock
a Unlock
mJ Paper clip
: Cooling
_E Elapsed time
Supply paper
P
A= 1-Sided original document
Hole-punched paper
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SYMBOL DESCRIPTION

Transparency

| [z

Load letterhead face up.

Load letterhead face down.

Load labels face down.

USB:

Universal Serial Bus

LAN:

Local Area Network

Telephone Line

Weight

Services Home button

HEP o d BT

This item can be recycled.

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide

399



Product Symbols

400 Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide



Apps Features

This appendix contains:

AADPDS FRALUIES. ... e

Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide

401



Apps Features

Apps Features

402 Xerox® AltaLink® B8145/B8155/B8170 Series Multifunction Printer User Guide



FEATURE

DESCRIPTION

3PING 135 13JULd UOIDUNJIINA S3UISS 0/ 189/SS188/Sh 189 oIUITONY oX0IDX

copy jobs automatically. For
example, when you are making
three 1-sided copies of a
six-page document, the copies
are printed in this order:

Output Use Output Color to control the
| 4 Color color rendering of the output
image.
2-Sided You can use the 2-sided options
Copying to set the device to scan one or
and 2- both sides of an original
Sided document. For Copy jobs, you
Scanning can specify 1-sided or 2-sided
output.
Paper Use Paper Supply to specify the
Supply size, type and color of the paper
required, or the paper tray to
use. If Auto is selected, the
printer chooses the paper tray
based on the original document
size and the selected settings.
m Collation You can collate multiple-page

€0y
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1,2,3,4,56;1,2,3,4,5,6; 1,
2,3,4,56.

Finishing

If finishing options are available,
use this option to choose the
finishing options required for
your printed output.

Reduce /
Enlarge

You can reduce the image to as
little as 25 % of the original size
or enlarge it to as much as
400 % . When you resize an
image, to maintain the original
proportions, select Proportional
% . To adjust the width and
length of the image by different
percentages, select
Independent %.

Original
Type

The printer optimizes the image
quality of the copies based on
the type of images in the
original document and how the
original document was created.

Apps Features
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FEATURE

Contrast

DESCRIPTION

You can use the Contrast feature
to adjust the variation between
light and dark areas of the
image.

SERVER

FAX

SCAN TO

ID CARD
COPY

Lighten /
Darken

Use the Lighten/Darken slider to
make the output image or print
lighter or darker.

Sharpness

Use this option to sharpen the
output image or print. For best
results, sharpen text images and
soften photos.

Saturation

Saturation allows you to adjust
the color strength and the
amount of gray in the color.

f Note: This feature is not
available when Output
Color is set to Black and
White or Grayscale.

Original
Orienta-
tion

You can use the Original
Orientation option to specify the
layout of the original images
that you scan. The printer uses
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FEATURE

DESCRIPTION

the information to determine
whether images require rotation
to produce the required output.

Image Image Shift allows you to

Shift modify the location of the
image on the page. You can
shift the printed image along
the X and Y axes of each sheet
of paper.

— Auto Use the Auto Background
=3 Back- Suppression setting to reduce
ground the sensitivity of the printer to

Suppres- variations in light background

sion colors.

Edge Erase | You can use the Edge Erase
feature to erase content from
the edges of your images. You
can specify the amount to erase
on the right, left, top, and
bottom edges.

Original To ensure that you scan the

Size correct area of the documents,

Apps Features
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SERVER ID CARD
FEATURE DESCRIPTION FAX SCAN TO COPY

specify the original document

size.
Book You can use the Book Copying .
Copying feature to copy books,
magazines, or other bound
documents.
Mirror Use Mirror Image to reverse the |
Image image and text on the page.
Negative Negative Image reverses the .
ﬁ" Image light and dark areas in your
document, and prints the image

as if it is a photo negative.
Printing a negative image is
useful for documents that have
a substantial amount of dark
background or light text and
images.

Special Special Pages is used to add .
Pages covers and inserts to your job.
You can specify exception pages

to print on different paper than
the main body of the job.
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SERVER ID CARD
FEATURE DESCRIPTION FAX SCAN TO COPY

Additionally, you can program
chapter start pages.

Annota- You can add annotations, such .
tions as page numbers and the date,
to your copies.

Booklet The Booklet Creation feature .
Creation prints two pages on each side of
the paper. The pages are
reordered so that they are in
numerical order when folded.

Page You can print the selected .
Layout number of pages on one side of
a sheet of paper. Selecting
multiple pages per sheet saves
paper and provides a way to
review the layout of a

document.
Sample Sample Job allows you to printa | e
Job test copy of a job to inspect

before you print multiple copies.
This feature is useful for
complex or high-volume jobs.
After you print and inspect the
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60%

FEATURE

DESCRIPTION

test copy, you can choose to
print or cancel the remaining
copies.

SERVER
FAX

SCAN TO

ID CARD
COPY

Transpar- Use the Transparency
ency Separators option to add blank
Separators | sheets of paper between each
printed transparency. Ensure
that the size and orientation of
the separators is the same as
the transparencies.
Auto Start | The Auto Start When Originals .
O When are Detected option allows the
Originals device to start a job
are automatically when original
Detected documents are detected in the
automatic document feeder.
Build Job Use the Build Job option for jobs . .

that include a variety of original
documents that require different
settings, or to scan multiple-
page jobs from the document
glass. The job is scanned in
segments. After all the segments
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DESCRIPTION

are scanned, the job is
processed and completed.

Save To use a particular combination

Current of copy settings for future copy

Settings jobs, you can save the settings
with a name and retrieve the
settings for later use.

Retrieve You can retrieve and use any

Current previously saved copy settings

Settings for current jobs.

Quantity Use this option to enter the
number of required ID card
copies.

Preview Use this option to view a sample
image. You can use Preview to
continue to scan and add pages
to a job.

Resolution | Resolution determines how fine

or grainy graphic images
appear. Image resolution is
measured in dots per inch (dpi).
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Remove Remove Blank Pages configures

Blank the printer to ignore blank

Pages pages.

From Use the From option to specify
the originator of the email.

f Note: The system
administrator can preset
this option to populate
automatically with your
user account details.

Reply To Use the Reply To option to

include an email address that
you want the recipient to reply
to. This option is useful if you
want the recipient to reply to
your email address, rather than
to the device.

‘fe Note: The system
administrator can preset
this option.

Ly
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Message

DESCRIPTION

Use the Message option to
enter information to accompany
the email.

SERVER
FAX

SCAN TO

ID CARD
COPY

Quality/
File Size

The Quality/File Size option lets
you choose from three settings
that balance the quality of the
image and the size of the file.
Higher-quality images result in
larger file sizes, which are not
ideal for sharing and
transmitting over the network.

I'|'|I

File Format

Use the File Format option to
specify the format of the saved
image or to define a searchable
image. You can add a password
to protect the image or choose
to combine multiple images into
a single file.

If File
Already
Exists

Use this option to define what
action the device takes when
the file name is used already.
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File and Use this option to specify a
Attach- name for the file that contains
ment the scanned images.
Update Use Update Workflows to
Workflows | refresh the list of workflows that
appear at the control panel.
Add File Use this option to choose more
Destina- destinations to file the scanned
tions images.
Book You can use the Book Faxing
Faxing feature to scan images from
books, magazines, or other
bound documents for faxing.
Reduce/ Use the Reduce/Split option to
Split specify how your faxed

document is printed on the
receiving fax machine. If the
image is too large to fit on the
paper size, you can reduce the
image to fit or split across
multiple pages.

€Ly
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Confirma-
tion Report

DESCRIPTION

You can request a report to
confirm if your fax was received.
To receive a Confirmation Report
only if an error occurred during
transmission, choose Print on
Error Only.

Starting
Rate

Select the highest starting rate
for transmitting the fax, unless
the destination for the fax you
are sending has special
requirements. Forced (4800 bps)
is the recommended setting for
lines that can have transmission
interference.

Cover
Sheet

You can use the Cover Sheet
option to add an introduction
page to the beginning of your
fax. You can add a short
comment to the cover sheet,
and To and From details.

Send
Header
Text

It is unlawful to send a message
from a fax machine without the
proper transmission header text.
Ensure that the name and

Apps Features
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Sly

SERVER ID CARD
FEATURE DESCRIPTION FAX SCAN TO COPY

telephone number of the
sender, and the date and time
of the transmission are included
on all faxes.

Delay Send | You can set a time in the future . .
G for the printer to send your fax
job. You can delay the sending

of your fax job for up to 24
hours.
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SERVER ID CARD
FEATURE DESCRIPTION FAX SCAN TO COPY

Polling Fax Polling allows you to store a .
(("))) fax document on the printer and

make the document available
for other fax machines to poll.
You can retrieve faxes stored on
other fax machines. To use this
feature, it is necessary that both
the polling printer and the
remote printer have the Polling
feature.

Mailboxes | Use the Fax Mailboxes option to .

@ store faxes that were retrieved
from a remote fax machine, or

to store faxes for retrieval by a
remote fax machine. The
mailbox number is required to
access a mailbox. You can set a
passcode to secure confidential
documents.
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